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Preface

Profile

Prerequisites

• R11i Navigating Oracle Applications

How This Course Is Organized

This course is an instructor-led course featuring lecture and hands-on exercises.
Online demonstrations and written practice sessions reinforce the concepts and
skills introduced.
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Related Publications

Oracle Publications

Additional Publications

• System release bulletins

• Installation and user’s guides

• read.me files

• Oracle Magazine
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Typographic Conventions

Typographic Conventions in Text

Convention Element Example
Bold italic Glossary term (if

there is a glossary)
The algorithm inserts the new key.

Caps and
lowercase

Buttons,
check boxes,
triggers,
windows

Click the Executable button.
Select the Can’t Delete Card check box.
Assign a When-Validate-Item trigger to the
ORD block.
Open the Master Schedule window.

Courier new,
case sensitive
(default is
lowercase)

Code output,
directory names,
filenames,
passwords,
pathnames,
URLs,
user input,
usernames

Code output: debug.set (‘I”, 300);
Directory: bin (DOS), $FMHOME (UNIX)
Filename: Locate the init.ora file.
Password: User tiger as your password.
Pathname: Open c:\my_docs\projects
URL: Go to http://www.oracle.com
User input: Enter 300
Username: Log on as scott

Initial cap Graphics labels
(unless the term is a
proper noun)

Customer address (but Oracle Payables)

Italic Emphasized words
and phrases,
titles of books and
courses,
variables

Do not save changes to the database.
For further information, see Oracle7 Server
SQL Language Reference Manual.
Enter user_id@us.oracle.com,
where user_id is the name of the user.

Quotation
marks

Interface elements
with long names
that have only
initial caps;
lesson and chapter
titles in cross-
references

Select “Include a reusable module component”
and click Finish.

This subject is covered in Unit II, Lesson 3,
“Working with Objects.”

Uppercase SQL column
names, commands,
functions, schemas,
table names

Use the SELECT command to view
information stored in the LAST_NAME
column of the EMP table.

Convention Element Example
Arrow Menu paths Select File—> Save.
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Brackets Key names Press [Enter].

Commas Key sequences Press and release keys one at a time:
[Alternate], [F], [D]

Plus signs Key combinations Press and hold these keys simultaneously:
[Ctrl]+[Alt]+[Del]

Typographic Conventions in Code

Convention Element Example
Caps and
lowercase

Oracle Forms
triggers

When-Validate-Item

Lowercase Column names,
table names

SELECT last_name
FROM s_emp;

Passwords DROP USER scott
IDENTIFIED BY tiger;

PL/SQL objects OG_ACTIVATE_LAYER
(OG_GET_LAYER

(‘prod_pie_layer’))

Lowercase
italic

Syntax variables CREATE ROLE role

Uppercase SQL commands and
functions

SELECT userid
FROM emp;

Typographic Conventions in Navigation Paths

This course uses simplified navigation paths, such as the following example, to
direct you through Oracle Applications.

(N) Invoice > Entry > Invoice Batches Summary (M) Query > Find (B) Approve

This simplified path translates to the following:

1. (N) From the Navigator window, select Invoice > Entry > Invoice Batches
Summary.

2. (M) From the menu, select Query > Find.

3. (B) Click the Approve button.

Notations :

(N) = Navigator

(M) = Menu

(T) = Tab
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(I) = Icon

(H) = Hyperlink

(B) = Button

Typographical Conventions in Help System Paths

This course uses a “navigation path” convention to represent actions you perform
to find pertinent information in the Oracle Applications Help System.

The following help navigation path, for example—

(Help) General Ledger > Journals > Enter Journals

—represents the following sequence of actions:

1. In the navigation frame of the help system window, expand the General
Ledger entry.

2. Under the General Ledger entry, expand Journals.

3. Under Journals, select Enter Journals.

4. Review the Enter Journals topic that appears in the document frame of the
help system window.

Getting Help

Oracle Applications provides you with a complete online help facility.

Whenever you need assistance, simply choose an item from the Help menu to
pinpoint the type of information you want.

To display help for a current window:

1. Choose Window Help from the Help menu, click the Help button on the
toolbar, or hold down the Control key and type 'h'.

A web browser window appears, containing search and navigation frames on
the left, and a frame that displays help documents on the right.

The document frame provides information on the window containing the
cursor. The navigation frame displays the top-level topics for your
responsibility, arranged in a tree control.

2. If the document frame contains a list of topics associated with the window,
click on a topic of interest to display more detailed information.
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3. You can navigate to other topics of interest in the help system, or choose
Close from your web browser's File menu to close help.

Searching for Help

You can perform a search to find the Oracle Applications help information you
want. Simply enter your query in the text field located in the top-left frame of the
browser window when viewing help, then click the adjacent Find button.

A list of titles, ranked by relevance and linked to the documents in question, is
returned from your search in the right-hand document frame. Click on whichever
title seems to best answer your needs to display the complete document in this
frame. If the document doesn't fully answer your questions, use your browser's
Back button to return to the list of titles and try another.
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ObjectivesObjectives

• Describe the various types of tax that Oracle
Applications support

• Describe United States Sales Tax Partner
Solutions

• Explain Tax Codes and Tax Groups in Oracle
Applications

• Describe Tax Accounting for Adjustments,
Discounts, and Finance Charges

• Describe how to manage Partial and Non-
Recoverable Taxes in Oracle Applications

• Describe the Tax Reporting Ledger

• Describe the various types of tax that Oracle
Applications support

• Describe United States Sales Tax Partner
Solutions

• Explain Tax Codes and Tax Groups in Oracle
Applications

• Describe Tax Accounting for Adjustments,
Discounts, and Finance Charges

• Describe how to manage Partial and Non-
Recoverable Taxes in Oracle Applications

• Describe the Tax Reporting Ledger

After completing this module,  you should be able to
do the following:
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• Types of Tax that Oracle Applications support
• United States Sales Tax Partner Solutions
• Tax Codes and Tax Groups In Oracle Applications
• Tax Accounting for Adjustments, Discounts, and

Finance Charges
• Managing Partial and Non-Recoverable Taxes
• Tax Reporting Ledger

• Types of Tax that Oracle Applications support
• United States Sales Tax Partner Solutions
• Tax Codes and Tax Groups In Oracle Applications
• Tax Accounting for Adjustments, Discounts, and

Finance Charges
• Managing Partial and Non-Recoverable Taxes
• Tax Reporting Ledger
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AgendaAgenda

• Types of Tax that Oracle Applications support
• United States Sales Tax Partner Solutions
• Tax Groups In Oracle Applications
• Tax Accounting for Adjustments, Discounts, and

Finance Charges
• Managing Partial and Non-Recoverable Taxes
• Tax Reporting Ledger

• Types of Tax that Oracle Applications support
• United States Sales Tax Partner Solutions
• Tax Groups In Oracle Applications
• Tax Accounting for Adjustments, Discounts, and

Finance Charges
• Managing Partial and Non-Recoverable Taxes
• Tax Reporting Ledger
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• Value Added Tax
• Recoverable and Non-Recoverable Input Taxes
• EU Acquisition and Reverse Charge Taxes
• Deferred Output Taxes
• Withholding Taxes
• US State and Local Taxes
• Goods and Service Tax
• Canadian Government, Provincial and Harmonized

Sales Tax

• Value Added Tax
• Recoverable and Non-Recoverable Input Taxes
• EU Acquisition and Reverse Charge Taxes
• Deferred Output Taxes
• Withholding Taxes
• US State and Local Taxes
• Goods and Service Tax
• Canadian Government, Provincial and Harmonized

Sales Tax

Oracle Applications support the following types of
tax:
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• Sales Equalization Taxes
• Investment Taxes
• Excise Duties
• Latin American Tax regimes (Brazilian ICMS, IPI,

Tributary Substitutions; Argentine VAT perception,
Turnover perception; Colombian VAT)

• Sales Equalization Taxes
• Investment Taxes
• Excise Duties
• Latin American Tax regimes (Brazilian ICMS, IPI,

Tributary Substitutions; Argentine VAT perception,
Turnover perception; Colombian VAT)

Oracle Applications support the following types of
tax:
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Examples of Tax Support in Oracle
Applications

• Oracle Payables and Purchasing support
automated calculation and accounting of partial
and non-recoverable tax.

• In Oracle Payables, you can capture tax detail on
expense report receipts to allow for reporting and
reclamation of tax.

• For countries such as France, Italy and Russia,
Oracle Receivables supports deferral of Output Tax
liability until payment has been collected.

• For cross border drop shipments within Europe,
Oracle Receivables/Order Management/Order
Capture support automatic defaulting of one or
more applicable taxes.

• Oracle Payables and Purchasing support
automated calculation and accounting of partial
and non-recoverable tax.

• In Oracle Payables, you can capture tax detail on
expense report receipts to allow for reporting and
reclamation of tax.

• For countries such as France, Italy and Russia,
Oracle Receivables supports deferral of Output Tax
liability until payment has been collected.

• For cross border drop shipments within Europe,
Oracle Receivables/Order Management/Order
Capture support automatic defaulting of one or
more applicable taxes.
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Examples of Tax Support in Oracle
Applications

• In Oracle Receivables, you can calculate and
account for multiple tax regimes, levying additional
taxes such as Surcharges, Excise, and Sales
Equalization taxes as required.

• The Latin Tax Engine in Oracle Receivables can
calculate and report taxes in the local tax regimes
for taxes levied in your order-to-cash cycle.

• Oracle Payables has country-specific localizations
that calculate tax and supplier withholding for
taxes levied and withheld in your procure-to-pay
cycle.

• In Oracle Receivables, you can calculate and
account for multiple tax regimes, levying additional
taxes such as Surcharges, Excise, and Sales
Equalization taxes as required.

• The Latin Tax Engine in Oracle Receivables can
calculate and report taxes in the local tax regimes
for taxes levied in your order-to-cash cycle.

• Oracle Payables has country-specific localizations
that calculate tax and supplier withholding for
taxes levied and withheld in your procure-to-pay
cycle.
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Tax Processing on TransactionsTax Processing on Transactions

With a setup, specific to your country, you can
automate both the Procure to Pay and Order to Cash
process, with the system controlling all the tax
calculations, accounting and reporting based on your
setup.
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AgendaAgenda

• Types of Tax that Oracle Applications support
• United States Sales Tax Partner Solutions
• Tax Codes and Tax Groups In Oracle Applications
• Tax Accounting for Adjustments, Discounts, and

Finance Charges
• Managing Partial and Non-Recoverable Taxes
• Tax Reporting Ledger

• Types of Tax that Oracle Applications support
• United States Sales Tax Partner Solutions
• Tax Codes and Tax Groups In Oracle Applications
• Tax Accounting for Adjustments, Discounts, and

Finance Charges
• Managing Partial and Non-Recoverable Taxes
• Tax Reporting Ledger
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United States Sales Tax Partner SolutionsUnited States Sales Tax Partner Solutions

• The US Tax Partner Solutions let you provide for
complex tax calculation needs while retaining the
full power of Receivables to create and store all
other tax data.

• The US Sales Tax Partner Solution is called
whenever a tax rate is calculated by the
Receivables Tax Engine.  When implemented, the
Tax Partner Solution will return a tax rate or
amount from the Tax Partner program.
Receivables will use this information to create the
appropriate tax line(s) and related accounting
information.

• The US Tax Partner Solutions let you provide for
complex tax calculation needs while retaining the
full power of Receivables to create and store all
other tax data.

• The US Sales Tax Partner Solution is called
whenever a tax rate is calculated by the
Receivables Tax Engine.  When implemented, the
Tax Partner Solution will return a tax rate or
amount from the Tax Partner program.
Receivables will use this information to create the
appropriate tax line(s) and related accounting
information.
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Tax PartnersTax Partners

Oracle integrates with these partner products:

• Taxware Sales Use Tax System (PLSQL)
• Vertex Quantum for US Sales & Use Tax (PLSQL)

Note:  The integration supports US Sales tax only.

Oracle integrates with these partner products:

• Taxware Sales Use Tax System (PLSQL)
• Vertex Quantum for US Sales & Use Tax (PLSQL)

Note:  The integration supports US Sales tax only.
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AgendaAgenda

• Types of Tax that Oracle Applications support
• United States Sales Tax Partner Solutions
• Tax Codes and Tax Groups In Oracle Applications
• Tax Accounting for Adjustments, Discounts, and

Finance Charges
• Managing Partial and Non-Recoverable Taxes
• Tax Reporting Ledger

• Types of Tax that Oracle Applications support
• United States Sales Tax Partner Solutions
• Tax Codes and Tax Groups In Oracle Applications
• Tax Accounting for Adjustments, Discounts, and

Finance Charges
• Managing Partial and Non-Recoverable Taxes
• Tax Reporting Ledger
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Tax Codes and Tax GroupsTax Codes and Tax Groups

• Tax Codes.  Individual taxes can be either
inclusive or exclusive on the price list.  Each of
these taxes can both raise and lower the price list
amount and be calculated using a different
Taxable Basis.

• Tax Groups.  Multiple tax codes can be grouped
together within the Order to Cash business cycle.
Multiple conditional tax codes can be grouped
together to build a schedule or group of candidate
taxes.

• Tax Codes.  Individual taxes can be either
inclusive or exclusive on the price list.  Each of
these taxes can both raise and lower the price list
amount and be calculated using a different
Taxable Basis.

• Tax Groups.  Multiple tax codes can be grouped
together within the Order to Cash business cycle.
Multiple conditional tax codes can be grouped
together to build a schedule or group of candidate
taxes.
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AgendaAgenda

• Types of Tax that Oracle Applications support
• United States Sales Tax Partner Solutions
• Tax Codes and Tax Groups In Oracle Applications
• Tax Accounting for Adjustments, Discounts, and

Finance Charges
• Managing Partial and Non-Recoverable Taxes
• Tax Reporting Ledger

• Types of Tax that Oracle Applications support
• United States Sales Tax Partner Solutions
• Tax Codes and Tax Groups In Oracle Applications
• Tax Accounting for Adjustments, Discounts, and

Finance Charges
• Managing Partial and Non-Recoverable Taxes
• Tax Reporting Ledger
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Tax Accounting for Adjustments, Discounts, and
Finance Charges
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Tax Accounting for Adjustments,
Discounts, and Finance Charges
Tax Accounting for Adjustments,
Discounts, and Finance Charges

• In Oracle Receivables, you can set up your system
to include tax accounting on adjustments,
discounts, and finance charges.

• Flexible setup options let you decide how the tax
is calculated and which tax accounts to use for
each activity.  This can reduce your tax liability in
countries where adjusting entries for tax are
allowed.

• In Oracle Payables, adjusting entries for payment
term discounts can automatically update your
Input Tax accounts as the discount is taken.

• In Oracle Receivables, you can set up your system
to include tax accounting on adjustments,
discounts, and finance charges.

• Flexible setup options let you decide how the tax
is calculated and which tax accounts to use for
each activity.  This can reduce your tax liability in
countries where adjusting entries for tax are
allowed.

• In Oracle Payables, adjusting entries for payment
term discounts can automatically update your
Input Tax accounts as the discount is taken.



Copyright © Oracle Corporation, 2000. All rights reserved.

Overview of the Tax Accounting Process
Chapter 23 - Page 18

Agenda

Copyright   Oracle Corporation,  2000. All rights reserved.
®

AgendaAgenda

• Types of Tax that Oracle Applications support
• United States Sales Tax Partner Solutions
• Tax Codes and Tax Groups In Oracle Applications
• Tax Accounting for Adjustments, Discounts, and

Finance Charges
• Managing Partial and Non-Recoverable Taxes
• Tax Reporting Ledger

• Types of Tax that Oracle Applications support
• United States Sales Tax Partner Solutions
• Tax Codes and Tax Groups In Oracle Applications
• Tax Accounting for Adjustments, Discounts, and

Finance Charges
• Managing Partial and Non-Recoverable Taxes
• Tax Reporting Ledger
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Partial and Non-Recoverable TaxesPartial and Non-Recoverable Taxes

• Tax management features in Oracle Purchasing
and Oracle Payables allow you to automatically
account for partial and non-recoverable taxes.

• Both Oracle Purchasing and Oracle Payables give
you the ability to :
– reclaim or recover tax based on a variable

recovery rate.
– automatically recognize the extent to which

you are liable for tax.
– ensure you are recovering all allowable taxes.

• Tax management features in Oracle Purchasing
and Oracle Payables allow you to automatically
account for partial and non-recoverable taxes.

• Both Oracle Purchasing and Oracle Payables give
you the ability to :
– reclaim or recover tax based on a variable

recovery rate.
– automatically recognize the extent to which

you are liable for tax.
– ensure you are recovering all allowable taxes.
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Partial and Non-Recoverable Taxes
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Partial and Non-Recoverable TaxesPartial and Non-Recoverable Taxes

• Tax amounts are automatically calculated and
recorded on your purchasing documents.

• If required by your business, you can also encumber
and accrue for the non-recoverable tax.

• Tax amounts are automatically calculated and
recorded on your purchasing documents.

• If required by your business, you can also encumber
and accrue for the non-recoverable tax.
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AgendaAgenda

• Types of Tax that Oracle Applications support
• United States Sales Tax Partner Solutions
• Tax Codes and Tax Groups In Oracle Applications
• Tax Accounting for Adjustments, Discounts, and

Finance Charges
• Managing Partial and Non-Recoverable Taxes
• Tax Reporting Ledger

• Types of Tax that Oracle Applications support
• United States Sales Tax Partner Solutions
• Tax Codes and Tax Groups In Oracle Applications
• Tax Accounting for Adjustments, Discounts, and

Finance Charges
• Managing Partial and Non-Recoverable Taxes
• Tax Reporting Ledger



Copyright © Oracle Corporation, 2000. All rights reserved.

Overview of the Tax Accounting Process
Chapter 23 - Page 22

Tax Management with the Tax Reporting Ledger

Copyright   Oracle Corporation,  2000. All rights reserved.
®

Tax Management with the Tax Reporting
Ledger

Tax Management with the Tax Reporting
Ledger

• Oracle Applications simplify global tax
management by providing a single cross-product
Tax Reporting Ledger. You can produce a single
report of all your taxable sales and purchase
documents across Oracle Receivables, Oracle
Payables and Oracle General Ledger.

• The Tax Reporting Ledger can be used in
conjunction with any reporting tool, including Rxi
and Application Desktop Integrator for Variable
Format Reports.

• Oracle Applications simplify global tax
management by providing a single cross-product
Tax Reporting Ledger. You can produce a single
report of all your taxable sales and purchase
documents across Oracle Receivables, Oracle
Payables and Oracle General Ledger.

• The Tax Reporting Ledger can be used in
conjunction with any reporting tool, including Rxi
and Application Desktop Integrator for Variable
Format Reports.
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Tax Management with the Tax Reporting
Ledger

Tax Management with the Tax Reporting
Ledger

• Single cross-product Tax Register
• Standard Input and Output Tax Registers
• Deferred Output Tax Register
• Recoverable and Non-Recoverable Tax Registers

• Single cross-product Tax Register
• Standard Input and Output Tax Registers
• Deferred Output Tax Register
• Recoverable and Non-Recoverable Tax Registers

The following tax registers are supported:
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Tax Management with the Tax Reporting Ledger
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Tax Management with the Tax Reporting
Ledger

Tax Management with the Tax Reporting
Ledger

• Receivable Invoices, Credit Memos, Debit Memos
• Receivable Line and Invoice Adjustments
• Receivable Payment Applications for Deferred Tax
• Receivable Earned and Unearned Discounts
• Receivable Miscellaneous Receipts and Payments
• Payables Invoice and Credit Memos
• Payables Prepayments
• General Ledger Manual Journal Entries

• Receivable Invoices, Credit Memos, Debit Memos
• Receivable Line and Invoice Adjustments
• Receivable Payment Applications for Deferred Tax
• Receivable Earned and Unearned Discounts
• Receivable Miscellaneous Receipts and Payments
• Payables Invoice and Credit Memos
• Payables Prepayments
• General Ledger Manual Journal Entries

The Tax Reporting Ledger reports on tax accounting
within the following sources:
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SummarySummary

In this lesson, you should have learned how to:
• Describe the types of tax that Oracle Applications

support
• Explain the United States Sales Tax Partner

Solutions
• Explain Tax Codes and Tax Groups in Oracle

Applications
• Explain Tax  Accounting for Adjustments,

Discounts, and Finance Charges
• Describe ways to manage Partial and Non-

Recoverable Taxes
• Describe the Tax Reporting Ledger

In this lesson, you should have learned how to:
• Describe the types of tax that Oracle Applications

support
• Explain the United States Sales Tax Partner

Solutions
• Explain Tax Codes and Tax Groups in Oracle

Applications
• Explain Tax  Accounting for Adjustments,

Discounts, and Finance Charges
• Describe ways to manage Partial and Non-

Recoverable Taxes
• Describe the Tax Reporting Ledger
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Using Oracle Applications with Taxware and Vertex
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Using Oracle Applications with Taxware
and Vertex

Using Oracle Applications with Taxware
and Vertex

Release 11iRelease 11i
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ObjectivesObjectives

After this module, you should be able to:
• Describe tax partners and how they work with

Oracle Applications
• Use Oracle Applications with tax partners to

process US Sales tax
• Describe the audit process and perform

reconciliation/period close steps

After this module, you should be able to:
• Describe tax partners and how they work with

Oracle Applications
• Use Oracle Applications with tax partners to

process US Sales tax
• Describe the audit process and perform

reconciliation/period close steps
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AgendaAgenda

• Describe tax partners and how they work with
Oracle Applications

• Use Oracle Applications with tax partners to process
US Sales tax

• Describe the audit process and perform
reconciliation/period close steps

• Describe tax partners and how they work with
Oracle Applications

• Use Oracle Applications with tax partners to process
US Sales tax

• Describe the audit process and perform
reconciliation/period close steps
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Tax Partners OverviewTax Partners Overview

A tax partner is a third party product that Oracle
Applications integrates with to calculate and report
state and local US Sales tax.
Oracle integrates with these partner products:
• Taxware Sales Use Tax System, Version 3.2

(PLSQL )
• Vertex Quantum for US Sales & Use Tax, Version

2.0 ( PLSQL )
Note: The integration supports US Sales tax only.

Oracle integrates with these partner products:
• Taxware Sales Use Tax System, Version 3.2

(PLSQL )
• Vertex Quantum for US Sales & Use Tax, Version

2.0 ( PLSQL )
Note: The integration supports US Sales tax only.
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Tax Partners Overview
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Tax Partners OverviewTax Partners Overview

Tax partners integrate with:
• Oracle Receivables
• Oracle Order Management
• Oracle Order Capture

– Oracle iStore
– Oracle Sales

Tax partners integrate with:
• Oracle Receivables
• Oracle Order Management
• Oracle Order Capture

– Oracle iStore
– Oracle Sales
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Integrated Oracle FeaturesIntegrated Oracle Features

• Adjustments window
• Copy Transactions window
• Credit Transactions window
• Sales Orders window
• Transactions window
• AutoInvoice
• Sales Orders Acknowledgment report
• US Sales Tax report
• CRM products that call Oracle Order Capture

– iStore orders, Oracle Sales Quotes

• Adjustments window
• Copy Transactions window
• Credit Transactions window
• Sales Orders window
• Transactions window
• AutoInvoice
• Sales Orders Acknowledgment report
• US Sales Tax report
• CRM products that call Oracle Order Capture

– iStore orders, Oracle Sales Quotes
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Tax Partners FunctionalityTax Partners Functionality

• Determine jurisdiction (if applicable, multiple
jurisdictions)

• Apply special rates and rules
– Maximum tax base amounts

• Process customer, product, and jurisdiction
exceptions

• Create reports and support tax return process

• Determine jurisdiction (if applicable, multiple
jurisdictions)

• Apply special rates and rules
– Maximum tax base amounts

• Process customer, product, and jurisdiction
exceptions

• Create reports and support tax return process
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Tax Process OverviewTax Process Overview

Oracle ReceivablesOracle Receivables
Tax Tables Tax Tables Tax PartnerTax Partner

Tax 
Information

Tax Rate
Tax Amount

AutoAccountingAutoAccounting
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Tax Process OverviewTax Process Overview

• Tax information stored in Oracle Receivables tax
tables passes to the tax partner.

• The tax partner returns tax rate and tax amount for
every invoice line.

• AutoAccounting then generates account
distribution tax lines based on the tax information
that the tax partner returned.

• Tax information stored in Oracle Receivables tax
tables passes to the tax partner.

• The tax partner returns tax rate and tax amount for
every invoice line.

• AutoAccounting then generates account
distribution tax lines based on the tax information
that the tax partner returned.

(Help) Oracle Receivables > Tax > Tax Vendor Extension
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Review QuestionReview Question

1.  True
2.  False
1.  True
2.  False

Only transactions using the tax code for location
based tax type are passed to tax partners.
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Answer to Review QuestionAnswer to Review Question

1.  True
2.  False
1.  True
2.  False

Only transactions using the tax code for location
based tax type are passed to tax partners.
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AgendaAgenda

• Describe tax partners and how they work with Oracle
Applications

• Use Oracle Applications with tax partners to
process US Sales tax

• Describe the audit process and perform
reconciliation/period close steps

• Describe tax partners and how they work with Oracle
Applications

• Use Oracle Applications with tax partners to
process US Sales tax

• Describe the audit process and perform
reconciliation/period close steps
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Creating Customer AddressesCreating Customer Addresses

• Use the zip code to automatically populate state,
county, and city.

• The address is validated against locations
imported into Oracle Receivables using:
– Taxware TMDFL or Vertex SEQMAST file
– Sales Tax Rate Interface

• Each customer site is associated with a valid
jurisdiction code. To override the default based on
the address, enter the jurisdiction code in the Geo
Override field.

• Use the zip code to automatically populate state,
county, and city.

• The address is validated against locations
imported into Oracle Receivables using:
– Taxware TMDFL or Vertex SEQMAST file
– Sales Tax Rate Interface

• Each customer site is associated with a valid
jurisdiction code. To override the default based on
the address, enter the jurisdiction code in the Geo
Override field.

(N) Customers > Standard
For more information, refer to the "Create Customer Addresses" and
"Working with Taxware Jurisdiction Codes" sections in the Integrating
Oracle Receivables with Taxware Sales/Use Tax System manual.
For more information, refer to the "Create Customer Addresses" and
"Working with Vertex GeoCodes and GeoCoder" sections in the Integrating
Oracle Receivables with Vertex Quantum manual.
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DemonstrationDemonstration

This demonstration covers how to create customer
addresses.

(N) Customers > Standard
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Creating Sales OrdersCreating Sales Orders

• Ship-to customer determines ship-to address
• Salesperson can be assigned the point of order

origin (Taxware) or point of order acceptance
(Vertex)

• Warehouse defines ship-from address if order is
shipped

• To view tax information, press the Actions button
from the Line Items region and select View Tax
Details

• The tax that tax partners calculate is an estimate

• Ship-to customer determines ship-to address
• Salesperson can be assigned the point of order

origin (Taxware) or point of order acceptance
(Vertex)

• Warehouse defines ship-from address if order is
shipped

• To view tax information, press the Actions button
from the Line Items region and select View Tax
Details

• The tax that tax partners calculate is an estimate

(N) Orders, Returns > Sales Orders
For more information, refer to the "Create a Sales Order" section in the
Integrating Oracle Receivables with Taxware Sales/Use Tax System or
Integrating Oracle Receivables with Vertex Quantum manual.
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Running the Sales Order
Acknowledgment Report
Running the Sales Order
Acknowledgment Report

Use the Sales Order Acknowledgment report to view
the sales order on a printed document.
• Tax rate
• Tax amount
• Tax total

• Tax rate
• Tax amount
• Tax total

For more information, refer to the "Run the Sales Order Acknowledgment
Report" section in the Integrating Oracle Receivables with Taxware Sales/Use
Tax System or Integrating Oracle Receivables with Vertex Quantum manual.
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Importing Sales Orders Using
AutoInvoice

Importing Sales Orders Using
AutoInvoice

• AutoInvoice creates validated invoices in Oracle
Receivables
– Accounting
– Sales credits

• Use Transaction Workbench to modify imported
invoices
– Tax partner accordingly recalculates tax
– Tax partner reports also updated

• AutoInvoice creates validated invoices in Oracle
Receivables
– Accounting
– Sales credits

• Use Transaction Workbench to modify imported
invoices
– Tax partner accordingly recalculates tax
– Tax partner reports also updated

For more information, refer to the "Import Sales Orders Using AutoInvoice"
section in the Integrating Oracle Receivables with Taxware Sales/Use Tax
System or Integrating Oracle Receivables with Vertex Quantum manual.
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Creating Manual InvoicesCreating Manual Invoices

Use the Transactions window to create invoices.
The tax amounts are:
• Calculated by the tax partner
• Reconciled to tax partner reports
• Recalculated when invoice lines are modified
• Updated in tax partner reports

Use the Transactions window to create invoices.
The tax amounts are:
• Calculated by the tax partner
• Reconciled to tax partner reports
• Recalculated when invoice lines are modified
• Updated in tax partner reports

(N) Transactions > Transactions
For more information, refer to the "Creating Manual Invoices" and "Invoice
Lines on Manual Invoices" sections in the Integrating Oracle Receivables with
Taxware Sales/Use Tax System or Integrating Oracle Receivables with Vertex
Quantum manual.
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Crediting InvoicesCrediting Invoices

Use the Credit Transactions window to create credit
memos.
Credit memo tax amounts reconcile to tax partner
reports.

(N) Transactions > Credit Transactions
For more information, refer to the "Credit the Invoice" section in the
Integrating Oracle Receivables with Taxware Sales/Use Tax System or
Integrating Oracle Receivables with Vertex Quantum manual.
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DemonstrationDemonstration

This demonstration covers how to:
• Create a manual invoice
• Credit the invoice
• View tax recalculations

(N) Transactions > Transactions > (B) Line Items
(N) Transactions > Credit Transactions

This demonstration covers how to:
• Create a manual invoice
• Credit the invoice
• View tax recalculations

(N) Transactions > Transactions > (B) Line Items
(N) Transactions > Credit Transactions
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Adjusting InvoicesAdjusting Invoices

• Create adjustments in the Adjustments window
• Adjustment tax amounts reconcile to tax partner

reports
– Posting only approved adjustments of type

Tax to tax partner reports
– If the option for posting adjustments to the tax

partner is selected in the Receivables
Activities window

• Create adjustments in the Adjustments window
• Adjustment tax amounts reconcile to tax partner

reports
– Posting only approved adjustments of type

Tax to tax partner reports
– If the option for posting adjustments to the tax

partner is selected in the Receivables
Activities window

(N) Transactions > Transactions Summary > (B) Adjust
For more information, refer to the "Adjust the Invoice" section in the
Integrating Oracle Receivables with Taxware Sales/Use Tax System or
Integrating Oracle Receivables with Vertex Quantum manual.
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Copying (Recurring) InvoicesCopying (Recurring) Invoices

Use the Copy Transactions window to copy or recur
invoices.
The tax partner calculates tax for all copied invoices.

(N) Transactions > Copy Transactions
For more information, refer to the "Copy (Recur) an Invoice" section in the
Integrating Oracle Receivables with Taxware Sales/Use Tax System or
Integrating Oracle Receivables with Vertex Quantum manual.
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Applying Exemptions to Invoice LinesApplying Exemptions to Invoice Lines

• Determining if an invoice line should be exempt
– Taxware Sales Tax Exemption Processing

System (STEP)
– Vertex Tax Decision Maker (TDM)
– Oracle exemptions

• Manually exempting an invoice line overrides the
STEP or TDM

• Determining if an invoice line should be exempt
– Taxware Sales Tax Exemption Processing

System (STEP)
– Vertex Tax Decision Maker (TDM)
– Oracle exemptions

• Manually exempting an invoice line overrides the
STEP or TDM

(N) Transactions > (B) Line Items > (T) Tax Exemption
For more information, refer to the "Apply Exemptions to Invoice Lines"
section in the Integrating Oracle Receivables with Taxware Sales/Use Tax
System or Integrating Oracle Receivables with Vertex Quantum manual.
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Running Tax Partner Reports
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Running Tax Partner ReportsRunning Tax Partner Reports

• Taxware Sales and Use Tax Report
• Vertex Sales Tax Register
• Taxware Sales and Use Tax Report
• Vertex Sales Tax Register

Use the tax partner reports to view details of
transactions, including tax information.

For more information, refer to the "Taxware Sales/Use Tax Report
(Complete)" section in the Integrating Oracle Receivables with Taxware
Sales/Use Tax System manual or the "Vendor Tax Reports (Complete)"
section in the Integrating Oracle Receivables with Vertex Quantum manual.
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AgendaAgenda

• Describe tax partners and how they work with Oracle
Applications

• Use Oracle Applications with tax partners to process
US Sales tax

• Describe the audit process and perform
reconciliation/period close steps

• Describe tax partners and how they work with Oracle
Applications

• Use Oracle Applications with tax partners to process
US Sales tax

• Describe the audit process and perform
reconciliation/period close steps
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Reconciliation/Period Close Steps
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Reconciliation/Period Close StepsReconciliation/Period Close Steps

1.  Complete or delete all open transactions in Oracle
Receivables.

2.  Post all transactions to Oracle General Ledger.
3.  Reconcile Receivables tax amounts by state in US

Sales Tax Report to General Ledger state tax
liability accounts.

4.  Reconcile total tax amounts by state to tax partner
reports.
– Tax partner ledgers are posted online as

transactions are entered.

1.  Complete or delete all open transactions in Oracle
Receivables.

2.  Post all transactions to Oracle General Ledger.
3.  Reconcile Receivables tax amounts by state in US

Sales Tax Report to General Ledger state tax
liability accounts.

4.  Reconcile total tax amounts by state to tax partner
reports.
– Tax partner ledgers are posted online as

transactions are entered.

For more information, refer to the "Sales Tax Reporting and Reconciliation
Processes" section in the Integrating Oracle Receivables with Taxware
Sales/Use Tax System or Integrating Oracle Receivables with Vertex Quantum
manual.
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Audit ProcessAudit Process

Taxable Receivables transaction lines are recorded
and updated in tax partner reports as single tax
partner report lines.
During the audit process, you may need to group a
tax partner line with others in the report before
reconciliation.

For more information, refer to the "Audit Process" section in the Integrating
Oracle Receivables with Taxware Sales/Use Tax System or Integrating Oracle
Receivables with Vertex Quantum manual.
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Review QuestionReview Question

1.  True
2.  False
1.  True
2.  False

The audit process allows for a rapid period close
because you do not have to run long posting
programs before closing the Receivables period.
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Answer to Review QuestionAnswer to Review Question

1.  True
2.  False
1.  True
2.  False

The audit process allows for a rapid period close
because you do not have to run long posting
programs before closing the Receivables period.
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Report TerminologyReport Terminology

Value

Accounting Date

Tax Calculation
Date

Taxware / Vertex

Fiscal Date /
Transaction Date

Invoice Date

Oracle Receivables

GL Date

Transaction Date

Tax partner reports use some terms that differ from
ones used in Oracle Receivables.
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SummarySummary

In this course, you should have learned how to:
• Describe tax partners and how they work with

Oracle Applications
• Use Oracle Applications with tax partners to

process US Sales tax
• Describe the audit process and perform

reconciliation/period close steps

In this course, you should have learned how to:
• Describe tax partners and how they work with

Oracle Applications
• Use Oracle Applications with tax partners to

process US Sales tax
• Describe the audit process and perform

reconciliation/period close steps
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R11i Implementing Taxware
and Vertex for US Sales Tax
Chapter 25
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Implementing Taxware and Vertex for US Sales Tax
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Implementing Taxware and Vertex for US
Sales Tax

Implementing Taxware and Vertex for US
Sales Tax

Release 11iRelease 11i
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ObjectivesObjectives

After this course, you should be able to:
• Describe tax partners
• Perform prerequisite implementation steps
• Integrate tax partners
• Perform monthly and support procedures

After this course, you should be able to:
• Describe tax partners
• Perform prerequisite implementation steps
• Integrate tax partners
• Perform monthly and support procedures
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AgendaAgenda

• Describing tax partners
• Performing prerequisite implementation steps
• Integrating tax partners
• Performing monthly and support procedures

• Describing tax partners
• Performing prerequisite implementation steps
• Integrating tax partners
• Performing monthly and support procedures
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Tax Partners OverviewTax Partners Overview

A tax partner is a third party product that Oracle
Applications integrates with to calculate and report
state and local US Sales tax.
Oracle integrates with these partner products:
• Taxware Sales Use Tax System, Version 3.2

(PLSQL )
• Vertex Quantum for US Sales & Use Tax, Version

2.0 ( PLSQL )
Note: The integration supports US Sales tax only.

Oracle integrates with these partner products:
• Taxware Sales Use Tax System, Version 3.2

(PLSQL )
• Vertex Quantum for US Sales & Use Tax, Version

2.0 ( PLSQL )
Note: The integration supports US Sales tax only.



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Implementing Taxware and Vertex for US Sales Tax
Chapter 25 - Page 6

Tax Partners Overview
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Tax Partners OverviewTax Partners Overview

Tax partners integrate with:
• Oracle Receivables
• Oracle Order Management
• Oracle Order Capture

– Oracle iStore
– Oracle Sales

Tax partners integrate with:
• Oracle Receivables
• Oracle Order Management
• Oracle Order Capture

– Oracle iStore
– Oracle Sales
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Tax Partners FunctionalityTax Partners Functionality

• Determine jurisdiction (if applicable, multiple
jurisdictions)

• Apply special rates and rules
– Maximum tax base amounts

• Process customer, product, and jurisdiction
exceptions

• Create reports and support tax return process

• Determine jurisdiction (if applicable, multiple
jurisdictions)

• Apply special rates and rules
– Maximum tax base amounts

• Process customer, product, and jurisdiction
exceptions

• Create reports and support tax return process

For more information, refer to the "Working with Taxware STEP" section
in the Integrating Oracle Receivables with Taxware Sales/Use Tax System or
the "Working with Vertex Tax Decision Maker" section in the Integrating
Oracle Receivables with Vertex Quantum manual.
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Tax Process OverviewTax Process Overview

• Tax information stored in Oracle Receivables tax
tables passes to the tax partner.

• The tax partner returns tax rate and tax amount for
every invoice line.

• AutoAccounting then generates account
distribution tax lines based on the tax information
that the tax partner returned.

• Tax information stored in Oracle Receivables tax
tables passes to the tax partner.

• The tax partner returns tax rate and tax amount for
every invoice line.

• AutoAccounting then generates account
distribution tax lines based on the tax information
that the tax partner returned.

(Help) Oracle Receivables > Tax > Tax Vendor Extension
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Review QuestionReview Question

1.  True
2.  False
1.  True
2.  False

The tax partner integration affects every feature in
Oracle Applications, such as the windows and
reports.
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Answer to Review QuestionAnswer to Review Question

1.  True
2.  False
1.  True
2.  False

The tax partner integration affects every feature in
Oracle Applications, such as the windows and
reports.
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AgendaAgenda

• Describing tax partners
• Performing prerequisite implementation steps
• Integrating tax partners
• Performing monthly and support procedures

• Describing tax partners
• Performing prerequisite implementation steps
• Integrating tax partners
• Performing monthly and support procedures
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Prerequisite StepsPrerequisite Steps

1.  Test database
2.  Obtain Oracle SQL *Plus

access to the APPS
schema

3.  Obtain permission to
relink Oracle
Executables

4.  Attend tax partner
software training

5.  Install tax partner
software

1.  Test database
2.  Obtain Oracle SQL *Plus

access to the APPS
schema

3.  Obtain permission to
relink Oracle
Executables

4.  Attend tax partner
software training

5.  Install tax partner
software

6.  Apply latest Oracle
Receivables patchset
and latest cumulative tax
patch

7.  Implement US Sales tax
(including uploading
Taxware TMDFL or
Vertex SEQMAST data
files)

8.  Validate customer
addresses

6.  Apply latest Oracle
Receivables patchset
and latest cumulative tax
patch

7.  Implement US Sales tax
(including uploading
Taxware TMDFL or
Vertex SEQMAST data
files)

8.  Validate customer
addresses
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Implementing US Sales Tax
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Implementing US Sales TaxImplementing US Sales Tax

1.  Choose a Sales Tax Location Flexfield Structure
2.  Set up tax engine controls
3.  Define tax lookups
4.  Determine states in which you are not required to

collect tax
5.  Define Sales tax location and rates
6.  Assign tax accounts and define AutoAccounting
7.  Define tax exemptions
8.  Define item tax rate exceptions
9.  Define tax profile options

1.  Choose a Sales Tax Location Flexfield Structure
2.  Set up tax engine controls
3.  Define tax lookups
4.  Determine states in which you are not required to

collect tax
5.  Define Sales tax location and rates
6.  Assign tax accounts and define AutoAccounting
7.  Define tax exemptions
8.  Define item tax rate exceptions
9.  Define tax profile options
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Choose a Sales Tax Location Flexfield Structure
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Choose a Sales Tax Location Flexfield
Structure

Choose a Sales Tax Location Flexfield
Structure

The Sales Tax Location Flexfield Structure must be
State.County.City.

(N) Setup > System > System Options > (T) Tax
(Help) Oracle Receivables > Tax > Implementing US Sales Tax > Setup Steps
for US Sales Tax
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Setting Up Tax Engine Controls
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Setting Up Tax Engine ControlsSetting Up Tax Engine Controls

• If storing exemptions in Oracle:
– Select Use Customer Exemptions and Use Item

Exemptions options
– Exempt items are exempt for all jurisdictions

• Do not select the Use Item Tax Rate Exceptions
option. Item tax rate exceptions must be stored in
Taxware STEP or Vertex TDM.

• If storing exemptions in Oracle:
– Select Use Customer Exemptions and Use Item

Exemptions options
– Exempt items are exempt for all jurisdictions

• Do not select the Use Item Tax Rate Exceptions
option. Item tax rate exceptions must be stored in
Taxware STEP or Vertex TDM.

Customer and item exemptions may be stored in
Oracle, Taxware Sales Tax Exemption Processing
System (STEP), or Vertex Tax Decision Maker (TDM).

(N) Setup > System > System Options > (T) Tax Defaults and Rates
(Help) Oracle Receivables > Tax > Implementing US Sales Tax > Setup Steps
for US Sales Tax
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Defining Tax LookupsDefining Tax Lookups

• Define lookups for tax exemption reasons.
– Query TAX_REASON in the Type field
– Used for exemptions stored in Oracle
– Oracle passes the first two characters of

lookup code to Taxware
– Oracle passes the first character of lookup

code to Vertex
• Do not define lookups for item tax rate exception

reasons. Item exceptions must be stored in
Taxware STEP or Vertex TDM.

• Define lookups for tax exemption reasons.
– Query TAX_REASON in the Type field
– Used for exemptions stored in Oracle
– Oracle passes the first two characters of

lookup code to Taxware
– Oracle passes the first character of lookup

code to Vertex
• Do not define lookups for item tax rate exception

reasons. Item exceptions must be stored in
Taxware STEP or Vertex TDM.

(N) Setup > System > QuickCodes > Receivables
(Help) Oracle Receivables > Tax > Implementing US Sales Tax > Setup Steps
for US Sales Tax
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Demonstration
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DemonstrationDemonstration

This demonstration covers how to define lookups for
tax exemption reasons.

(N) Setup > System > QuickCodes > Receivables
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Determining States in Which You Are Not Required to
Collect Tax
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Determining States in Which You Are Not
Required to Collect Tax

Determining States in Which You Are Not
Required to Collect Tax

1.  Set up Taxware STEP or Vertex TDM based on this
determination.

2.  Also determine local jurisdictions in which you are
required to collect tax.

3.  Review tax partner calculation logic and see if
additional setup is required in Taxware STEP or
Vertex TDM.

1.  Set up Taxware STEP or Vertex TDM based on this
determination.

2.  Also determine local jurisdictions in which you are
required to collect tax.

3.  Review tax partner calculation logic and see if
additional setup is required in Taxware STEP or
Vertex TDM.

(Help) Oracle Receivables > Tax > Implementing US Sales Tax > Setup Steps
for US Sales Tax
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Defining Sales Tax Locations and RatesDefining Sales Tax Locations and Rates

1.  Use the Sales Tax Rate Interface to upload the
Taxware TMDFL or Vertex SEQMAST file into
Oracle tables.
– Address validation
– Assignment of ship-to jurisdiction codes or

GeoCodes
2.  Also load to tax partner tables.

– Tax calculation

1.  Use the Sales Tax Rate Interface to upload the
Taxware TMDFL or Vertex SEQMAST file into
Oracle tables.
– Address validation
– Assignment of ship-to jurisdiction codes or

GeoCodes
2.  Also load to tax partner tables.

– Tax calculation

(Help) Oracle Receivables > Tax > Implementing US Sales Tax > Setup Steps
for US Sales Tax
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Assigning Tax Accounts and Defining
AutoAccounting

Assigning Tax Accounts and Defining
AutoAccounting

• Setting different sales tax liability accounts lets
you reconcile total tax amounts for each state to
the Oracle and tax partner reports.

• The entire portion of tax is recorded on the
account assigned to the ship-to state for
transactions that are subject to origin and
destination-based taxes.

• Setting different sales tax liability accounts lets
you reconcile total tax amounts for each state to
the Oracle and tax partner reports.

• The entire portion of tax is recorded on the
account assigned to the ship-to state for
transactions that are subject to origin and
destination-based taxes.

(Help) Oracle Receivables > Tax > Implementing US Sales Tax > Setup Steps
for US Sales Tax
For more information, refer to the "Accounting for State and Local Taxes"
section in the Integrating Oracle Receivables with Taxware Sales/Use Tax
System or Integrating Oracle Receivables with Vertex Quantum manual.
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Defining Tax Exemptions
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Defining Tax ExemptionsDefining Tax Exemptions

• Customer and item exemptions may be stored in
Oracle, Taxware STEP, or Vertex TDM.

• If exemptions are stored in Oracle:
– Exempt items are exempt for all jurisdictions
– You can use the Optional % Exempt field in the

Tax Exemptions window to specify the
exemption percentage for state, county, city,
and district (Vertex) or secondary jurisdiction
(Taxware)

• Customer and item exemptions may be stored in
Oracle, Taxware STEP, or Vertex TDM.

• If exemptions are stored in Oracle:
– Exempt items are exempt for all jurisdictions
– You can use the Optional % Exempt field in the

Tax Exemptions window to specify the
exemption percentage for state, county, city,
and district (Vertex) or secondary jurisdiction
(Taxware)

(N) Setup > Tax > Exemptions
(Help) Oracle Receivables > Tax > Implementing US Sales Tax > Setup Steps
for US Sales Tax
For more information, refer to the "Integration with Oracle Exemption
Handling" section in the Integrating Oracle Receivables with Taxware
Sales/Use Tax System or Integrating Oracle Receivables with Vertex Quantum
manual.
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Defining Item Tax Rate Exceptions
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Defining Item Tax Rate ExceptionsDefining Item Tax Rate Exceptions

• Item tax rate exceptions are not passed from
Oracle to tax partners.

• Item exceptions must be defined in Taxware STEP
or Vertex TDM.

• Item tax rate exceptions are not passed from
Oracle to tax partners.

• Item exceptions must be defined in Taxware STEP
or Vertex TDM.

(Help) Oracle Receivables > Tax > Implementing US Sales Tax > Setup Steps
for US Sales Tax
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Defining Tax Profile Options
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Defining Tax Profile OptionsDefining Tax Profile Options

Use the System Profile Values window in the System
Administrator responsibility to:
• Set Tax: Calculate Tax on Credit Memos profile

option to YES to post credit memos to a tax
partner

• Set Tax: Allow Override of Customer Exemptions
profile option
– Yes or No if storing exemptions in Oracle
– No if using only tax partner exemptions

• Set Tax: Calculate Tax on Credit Memos profile
option to YES to post credit memos to a tax
partner

• Set Tax: Allow Override of Customer Exemptions
profile option
– Yes or No if storing exemptions in Oracle
– No if using only tax partner exemptions

(N) Profile > System
(Help) Oracle Receivables > Tax > Implementing US Sales Tax > Setup Steps
for US Sales Tax
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Validating Customer Addresses
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Validating Customer AddressesValidating Customer Addresses

New Implementations of
Oracle Applications

Existing
Implementations of
Oracle Applications

Load customer addresses
after completing previous

steps

Clean up addresses if invalid
ones exist
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AgendaAgenda

• Describing tax partners
• Performing prerequisite implementation steps
• Integrating tax partners
• Performing monthly and support procedures

• Describing tax partners
• Performing prerequisite implementation steps
• Integrating tax partners
• Performing monthly and support procedures
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Integration Steps
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Integration StepsIntegration Steps

1.   Provide grants to the
APPS schema

2.   Remove C tax vendor
(optional)

3.   Re-create synonyms
4.   Set profile options
5.   Set up lookup code

ARTAXVDR: Location
Qualifier

6.   Set up tax exemption
reason lookup codes

1.   Provide grants to the
APPS schema

2.   Remove C tax vendor
(optional)

3.   Re-create synonyms
4.   Set profile options
5.   Set up lookup code

ARTAXVDR: Location
Qualifier

6.   Set up tax exemption
reason lookup codes

7.  Set up vendor-specific
tax codes (optional)

8.  Set up system options
9.  Create index on Vertex

audit table (Vertex only)
10. Verify tax vendor

implementation
11. Set up jurisdiction

codes (optional)
12. Set up optional fields

(optional)

7.  Set up vendor-specific
tax codes (optional)

8.  Set up system options
9.  Create index on Vertex

audit table (Vertex only)
10. Verify tax vendor

implementation
11. Set up jurisdiction

codes (optional)
12. Set up optional fields

(optional)
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Providing Grants to the APPS SchemaProviding Grants to the APPS Schema

• Enter at SQL prompt
• Connect as <Taxware schema>/<Taxware

Password> or <Vertex schema>/<Vertex
Password>

• Enter at SQL prompt
• Connect as <Taxware schema>/<Taxware

Password> or <Vertex schema>/<Vertex
Password>

Give grants to the APPS schema so that the tax
partner packages can be executed.

For more information, refer to the "Step 1 - Provide Grants to the APPS
Schema" section in the Integrating Oracle Receivables with Taxware Sales/Use
Tax System or Integrating Oracle Receivables with Vertex Quantum manual.
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Removing C Tax Vendor (Optional)
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Removing C Tax Vendor (Optional)Removing C Tax Vendor (Optional)

1.  Remove vendor-specific object files from the
$FND_TOP/usrxit/devenv files VNDARSL and
VNDARPL.

2.  Relink aiap, AutoInvoice, recurring invoices, OE
Transaction Manager, and the report executables.

1.  Remove vendor-specific object files from the
$FND_TOP/usrxit/devenv files VNDARSL and
VNDARPL.

2.  Relink aiap, AutoInvoice, recurring invoices, OE
Transaction Manager, and the report executables.

Removing the C tax vendor extension from all Oracle
executables is only required if you are upgrading
from the DMS integration (Release 10.4.2 to Release
10.7).

For more information, refer to the "Step 2 - Remove the C Tax Vendor
(optional)" section in the Integrating Oracle Receivables with Taxware
Sales/Use Tax System or Integrating Oracle Receivables with Vertex Quantum
manual.
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Re-creating Synonyms
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Re-creating SynonymsRe-creating Synonyms

• Enter at SQL prompt
• Re-create Synonyms to point to a tax partner
• Enter at SQL prompt
• Re-create Synonyms to point to a tax partner

Re-create certain synonyms to point to correct
vendor packages.

For more information, refer to the "Step 3 - Re-create Synonyms" section in
the Integrating Oracle Receivables with Taxware Sales/Use Tax System or
Integrating Oracle Receivables with Vertex Quantum manual.
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APPSAPPS TaxwareTaxware

SYNONYMS:
ARP_TAX_TAXWARE_010
ARP_TAX_TAXWARE_GEN
ARP_TAX_TAXWARE_AUDIT_HEADER
ARP_TAX_TAXWARE_AUDIT_DETAIL
ARP_TAX_TAXWARE_AUDIT_JURIS
ARP_TAX_TAXWARE_AUDIT_TAX

PACKAGES:
ARP_TAX_TAXWARE_010_STUB
ARP_TAX_TAXWARE_GEN_STUB

X
X
X
X
X
X

PACKAGES:
TAXPKG_010
TAXPKG_GEN

TABLES:
TAXAUDIT_HEADER
TAXAUDIT_DETAIL
TAXAUDIT_JURIS
TAXAUDIT_TAX

Re-creating Synonyms - TaxwareRe-creating Synonyms - Taxware

For more information, refer to the "Step 3 - Re-create Synonyms" section in
the Integrating Oracle Receivables with Taxware Sales/Use Tax System
manual.
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Re-creating Synonyms - Vertex
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Re-creating Synonyms - VertexRe-creating Synonyms - Vertex

APPSAPPS VertexVertex

SYNONYMS:
ARP_TAX_VERTEX_QSU
ARP_TAX_VERTEX_GEO
ARP_TAX_VERTEX_AUDIT

PACKAGES:
ARP_TAX_VERTEX_QSU_STUB
ARP_TAX_VERTEX_GEO_STUB

X
X
X

PACKAGES:
QSU
GEO

TABLE:
REGPRERETURNSTBL

For more information, refer to the "Step 3 - Re-create Synonyms" section in
the Integrating Oracle Receivables with Vertex Quantum manual.
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Setting Profile OptionsSetting Profile Options

Set the profile options used with tax partners:
• Tax: Use Tax Vendor
• Tax: Use PL/SQL Vendor
• Tax: Calculate Tax on Credit Memos
• Tax Taxware: Use Nexpro
• Tax Taxware: Tax Selection Parameter
• Tax Taxware: Tax Type
• Tax Taxware: Service Indicator
• Tax Vertex: Use Secondary Taxes
• Tax Vertex: Case Sensitive

Set the profile options used with tax partners:
• Tax: Use Tax Vendor
• Tax: Use PL/SQL Vendor
• Tax: Calculate Tax on Credit Memos
• Tax Taxware: Use Nexpro
• Tax Taxware: Tax Selection Parameter
• Tax Taxware: Tax Type
• Tax Taxware: Service Indicator
• Tax Vertex: Use Secondary Taxes
• Tax Vertex: Case Sensitive

For more information, refer to the "Step 4 - Set Up Profile Options" section
in the Integrating Oracle Receivables with Taxware Sales/Use Tax System or
Integrating Oracle Receivables with Vertex Quantum manual.
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Setting Up Lookup Code ARTAXVDR:
Location Qualifier

Setting Up Lookup Code ARTAXVDR:
Location Qualifier

• Enter ARTAXVDR_LOC_QUALIFIER in the Type
field

• Required selection:
– Enable ALL
– Disable STATE, COUNTY, CITY

• Enter ARTAXVDR_LOC_QUALIFIER in the Type
field

• Required selection:
– Enable ALL
– Disable STATE, COUNTY, CITY

Use the Oracle Receivables Lookups window to set
up the ARTAXVDR: Location Qualifier lookup code.

(N) Setup > System > QuickCodes > Receivables
For more information, refer to the "Step 5 - Set Up Lookup Code
ARTAXVDR: Location Qualifier" section in the Integrating Oracle
Receivables with Taxware Sales/Use Tax System or Integrating Oracle
Receivables with Vertex Quantum manual.
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DemonstrationDemonstration

This demonstration covers how to set up lookup code
ARTAXVDR: Location Qualifier.

(N) Setup > System > QuickCodes > Receivables
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Setting Up Tax Exemption Reason
Lookup Codes

Setting Up Tax Exemption Reason
Lookup Codes

This step is the same as the defining tax exemptions
step for implementing US Sales tax.

(N) Setup > System > QuickCodes > Receivables
For more information, refer to the "Step 6 - Set Up Lookup Code Tax
Exemption Reason" section in the Integrating Oracle Receivables with
Taxware Sales/Use Tax System or Integrating Oracle Receivables with Vertex
Quantum manual.
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Setting Up Vendor-Specific Tax Codes
(Optional)

Setting Up Vendor-Specific Tax Codes
(Optional)

Use the Tax Codes and Rates window to create State,
County, and City tax codes with Sales tax type.

This step is only needed:
• For customers upgrading from character mode
• If lookup code ARTAXVDR: Location Qualifier is

set to STATE, COUNTY, CITY

This step is only needed:
• For customers upgrading from character mode
• If lookup code ARTAXVDR: Location Qualifier is

set to STATE, COUNTY, CITY

(N) Setup > Tax > Codes
For more information, refer to the "Step 7 - Set Up Vendor-Specific Tax
Codes" section in the Integrating Oracle Receivables with Taxware Sales/Use
Tax System or Integrating Oracle Receivables with Vertex Quantum manual.
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Setting Up System OptionsSetting Up System Options

In the System Options window, enter Taxware or
Vertex in the Tax Vendor Views field.

(N) Setup > System > System Options > (T) Tax
For more information, refer to the "Step 8 - Set Up System Options" section
in the Integrating Oracle Receivables with Taxware Sales/Use Tax System or
Integrating Oracle Receivables with Vertex Quantum manual.
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Creating Index on Vertex Audit Table
(Vertex Only)

Creating Index on Vertex Audit Table
(Vertex Only)

• Create an index for the column TRANSUSERAREA
in the Vertex table REGPRERETURNSTBL so that
Oracle can identify invalid invoices to delete from
the AutoInvoice interface tables.

• SQL> Create Index <Any Index Name> on
Regprereturnstbl (Transuserarea);

• Create an index for the column TRANSUSERAREA
in the Vertex table REGPRERETURNSTBL so that
Oracle can identify invalid invoices to delete from
the AutoInvoice interface tables.

• SQL> Create Index <Any Index Name> on
Regprereturnstbl (Transuserarea);

For more information, refer to the "Step 9 - Create Index on Vertex Audit
Table" section in the Integrating Oracle Receivables with Vertex Quantum
manual.
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Verifying Tax Vendor ImplementationVerifying Tax Vendor Implementation

1.   Create customer
addresses

2.   Create sales orders and
run the Sales Order
Acknowledgment Report

3.   Import using
AutoInvoice

4.   Maintain (update/delete)
imported invoices using
the Transactions
Workbench

5.   Create credits memos

1.   Create customer
addresses

2.   Create sales orders and
run the Sales Order
Acknowledgment Report

3.   Import using
AutoInvoice

4.   Maintain (update/delete)
imported invoices using
the Transactions
Workbench

5.   Create credits memos

6.   Create adjustments
7.   Copy (recur) invoices
8.   Create invoices in the

Transactions
Workbench

9.   Create exempt orders
10. Create orders with part

exceptions
11. Create credit memos on

exempt/excepted orders
12. TEST, TEST, TEST

6.   Create adjustments
7.   Copy (recur) invoices
8.   Create invoices in the

Transactions
Workbench

9.   Create exempt orders
10. Create orders with part

exceptions
11. Create credit memos on

exempt/excepted orders
12. TEST, TEST, TEST

For more information, refer to the "Step 9 - Verify Tax Vendor
Implementation" and "Tutorial" sections in the Integrating Oracle
Receivables with Taxware Sales/Use Tax System manual.
For more information, refer to the "Step 10 - Verify Tax Vendor
Implementation" and "Tutorial" sections in the Integrating Oracle
Receivables with Vertex Quantum manual.
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Setting Up Jurisdiction Codes (Optional)Setting Up Jurisdiction Codes (Optional)

Use fields in Oracle Receivables windows to:
• Extend the basic functionality of the integration
• Support tax calculations using ship-from and ship-

to addresses, point of order acceptance, and point
of order origin with jurisdiction codes and
GeoCodes.

Use fields in Oracle Receivables windows to:
• Extend the basic functionality of the integration
• Support tax calculations using ship-from and ship-

to addresses, point of order acceptance, and point
of order origin with jurisdiction codes and
GeoCodes.

For more information, refer to the "Step 10 - Set Up Jurisdiction Codes
(optional)" and "Working with Taxware Jurisdiction Codes" sections in the
Integrating Oracle Receivables with Taxware Sales/Use Tax System manual.
For more information, refer to the "Step 11 - Set Up Jurisdiction Codes
(optional)" and "Working with Vertex GeoCodes and GeoCoder" sections in
the Integrating Oracle Receivables with Vertex Quantum manual.
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Setting Up Jurisdiction Codes (Optional)Setting Up Jurisdiction Codes (Optional)

Window

Location Address
Salesforce
Customer Address
System Options

Jurisdiction Code /
GeoCode

Warehouse
Salesperson
Customer Address
Organization

Field

Sales Tax Override
Geo Override
Geo Override
Sales Tax Geo
Override

For more information, refer to the "Step 10 - Set Up Jurisdiction Codes
(optional)" and "Working with Taxware Jurisdiction Codes" sections in the
Integrating Oracle Receivables with Taxware Sales/Use Tax System manual.
For more information, refer to the "Step 11 - Set Up Jurisdiction Codes
(optional)" and "Working with Vertex GeoCodes and GeoCoder" sections in
the Integrating Oracle Receivables with Vertex Quantum manual.



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Implementing Taxware and Vertex for US Sales Tax
Chapter 25 - Page 42

Setting Up Optional Fields (Optional)

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Setting Up Optional Fields (Optional)Setting Up Optional Fields (Optional)

• Implement descriptive flexfields and use fields in
Oracle Receivables windows to extend the basic
functionality of the integration.

• Create flexfields and fields in:
– Receivables Activities window
– Transaction Types window

• Implement descriptive flexfields and use fields in
Oracle Receivables windows to extend the basic
functionality of the integration.

• Create flexfields and fields in:
– Receivables Activities window
– Transaction Types window

For more information, refer to the "Storing Tax Information in Oracle
Receivables" section in the Integrating Oracle Receivables with Taxware
Sales/Use Tax System or Integrating Oracle Receivables with Vertex Quantum
manual.
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Setting Up Optional Fields (Optional)Setting Up Optional Fields (Optional)

Window
Tax Exemptions
Receivables Activities
Transaction Types

Field
Optional Exempt %
Post Adjustments to Audit File
Job Number (Taxware only)

For more information, refer to the "Storing Tax Information in Oracle
Receivables" section in the Integrating Oracle Receivables with Taxware
Sales/Use Tax System or Integrating Oracle Receivables with Vertex Quantum
manual.
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Review QuestionReview Question

1.  Re-create synonyms
2.  Set profile options
3.  Set up lookup code tax exemption reason

1.  Re-create synonyms
2.  Set profile options
3.  Set up lookup code tax exemption reason

Which integration step does not correspond in any
way to a basic step for implementing US Sales tax?
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Answer to Review QuestionAnswer to Review Question

1.  Re-create synonyms
2.  Set profile options
3.  Set up lookup code tax exemption reason

1.  Re-create synonyms
2.  Set profile options
3.  Set up lookup code tax exemption reason

Which integration step does not correspond in any
way to a basic step for implementing US Sales tax?
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Setting Up Taxware STEPSetting Up Taxware STEP

The Taxware Sales Tax Exemption Processing (STEP)
controls taxability of transactions based on item, bill-
to customer, or ship-to jurisdiction.

STEP Field
Company
Division Code

Customer
Address
Product Code
Product Category

Oracle Value
01

01

Bill-to customer number of invoice/order
Ship-to address (state, county, city)
Segment 1 of Item Flexfield
(Not used)

For more information, refer to the "Working with Taxware STEP" section
in the Integrating Oracle Receivables with Taxware Sales/Use Tax System
manual.
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Setting Up Vertex TDMSetting Up Vertex TDM

The Vertex Tax Decision maker (TDM) controls
taxability of transactions based on item, bill-to
customer, or ship-to jurisdiction.

TDM Field
Company Code
Division Code

Customer Code
Customer Class
Address
Product Code

Oracle Value
01

01

Bill-to customer number of invoice/order
(not used)
GeoCode associated with ship-to address
Segment 1 of Item Key Flexfield

For more information, refer to the "Working with Vertex Tax Decision
Maker" section in the Integrating Oracle Receivables with Vertex Quantum
manual.
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CustomizationsCustomizations

• Reapply any modifications to standard tax view
functions when you apply a patch.

• Make sure that numeric values are returned when
required.

• Reapply any modifications to standard tax view
functions when you apply a patch.

• Make sure that numeric values are returned when
required.
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AgendaAgenda

• Describing tax partners
• Performing prerequisite implementation steps
• Integrating tax partners
• Performing monthly and support procedures

• Describing tax partners
• Performing prerequisite implementation steps
• Integrating tax partners
• Performing monthly and support procedures
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Monthly Procedures - Database Storage
Requirements

Monthly Procedures - Database Storage
Requirements

• Taxware schema: 1500 bytes per transaction line,
3000 bytes per change

• Vertex: 800 bytes per transaction line, 1600 bytes
per change

• Taxware schema: 1500 bytes per transaction line,
3000 bytes per change

• Vertex: 800 bytes per transaction line, 1600 bytes
per change

Size the AR_LOCATION_VALUES and
AR_LOCATION_RATES tables to allow full upload of
the Taxware TMDFL or Vertex SEQMAST data file
(~75MB plus 100MB to initialize Taxware or Vertex
tables).

For more information, refer to the "Database Storage Requirements" section
in the Integrating Oracle Receivables with Taxware Sales/Use Tax System or
Integrating Oracle Receivables with Vertex Quantum manual.
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Monthly Procedures - Address Validation
Data

Monthly Procedures - Address Validation
Data

• Address Validation
– Use the Sales Tax Rate Interface to upload the

Taxware TMDFL or Vertex SEQMAST file into
Oracle tables

– Also load to tax partner tables
• Load to Oracle is a two-step process

– SQL*Loader
– Sales Tax Rate Interface Program

• Address Validation
– Use the Sales Tax Rate Interface to upload the

Taxware TMDFL or Vertex SEQMAST file into
Oracle tables

– Also load to tax partner tables
• Load to Oracle is a two-step process

– SQL*Loader
– Sales Tax Rate Interface Program

For more information, refer to the "Address Validation Data - Taxware
TMDFL Data File" section in the Integrating Oracle Receivables with
Taxware Sales/Use Tax System manual or the "Address Validation Data -
Vertex SEQMAST File" section in the Integrating Oracle Receivables with
Vertex Quantum manual.
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Monthly Procedures DiagramMonthly Procedures Diagram

Sales Tax
Feeder System

AR_LOCATION_VALUES AR_LOCATION_RATES

SQL*Loader Program

AR_TAX_INTERFACE

Sales Tax Rate Interface Concurrent Program

Unix Script
aravp.ctl

or
arvertex.ctl

Parameters
• Review or Upload
• Print Format
• State

For more information, refer to the "Monthly Procedures" section in the
Integrating Oracle Receivables with Taxware Sales/Use Tax System or the
Integrating Oracle Receivables with Vertex Quantum manual.
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Support ProceduresSupport Procedures

• If using AutoInvoice or Copy Transaction
programs, enter 3 in the Message Level field of the
System Options window.

• Set profile options:
– Tax: Debug File Directory
– Tax: Debug Flag

• If using AutoInvoice or Copy Transaction
programs, enter 3 in the Message Level field of the
System Options window.

• Set profile options:
– Tax: Debug File Directory
– Tax: Debug Flag

For more information, refer to the "Support Procedures" section in the
Integrating Oracle Receivables with Taxware Sales/Use Tax System or the
Integrating Oracle Receivables with Vertex Quantum manual.
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Requesting SupportRequesting Support

• Contact Oracle if you have questions concerning
the integration of the tax partner.

• Contact the tax partner if you have questions
concerning the partner product.

• Use log files that document tax calculation steps
for support request if you have specific questions
or questions concerning how tax amounts are
calculated.

• Contact Oracle if you have questions concerning
the integration of the tax partner.

• Contact the tax partner if you have questions
concerning the partner product.

• Use log files that document tax calculation steps
for support request if you have specific questions
or questions concerning how tax amounts are
calculated.
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SummarySummary

In this course, you should have learned how to:
• Describe tax partners
• Perform prerequisite implementation steps
• Integrate tax partners
• Perform monthly and support procedures

In this course, you should have learned how to:
• Describe tax partners
• Perform prerequisite implementation steps
• Integrate tax partners
• Perform monthly and support procedures
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R11i Processing U.S. Sales
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Chapter 26
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Processing US Sales and Use Taxes
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Processing US Sales and Use TaxesProcessing US Sales and Use Taxes

Release 11iRelease 11i
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ObjectivesObjectives

After completing this course you should be able to do
the following:
• Describe how Oracle’s e-Business Suite handles

the processing of US Sales and Use taxes
• Demonstrate how to process US Sales tax in

Oracle Receivables, Oracle Order Management,
and other products

• Demonstrate how to process US Sales and Use
taxes in Oracle Payables and Oracle Purchasing

After completing this course you should be able to do
the following:
• Describe how Oracle’s e-Business Suite handles

the processing of US Sales and Use taxes
• Demonstrate how to process US Sales tax in

Oracle Receivables, Oracle Order Management,
and other products

• Demonstrate how to process US Sales and Use
taxes in Oracle Payables and Oracle Purchasing
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AgendaAgenda

• Using Oracle’s e-Business Suite to process US
Sales and Use taxes

• Overview of US Sales and Use taxes
• Processing US Sales tax in Oracle Receivables,

Oracle Order Management, and other products
• Processing US Sales and Use taxes in Oracle

Payables and Oracle Purchasing

• Using Oracle’s e-Business Suite to process US
Sales and Use taxes

• Overview of US Sales and Use taxes
• Processing US Sales tax in Oracle Receivables,

Oracle Order Management, and other products
• Processing US Sales and Use taxes in Oracle

Payables and Oracle Purchasing
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AgendaAgenda

• Using Oracle’s e-Business Suite to process US
Sales and Use taxes

• Overview of US Sales and Use taxes
• Processing US Sales tax in Oracle Receivables,

Oracle Order Management, and other products
• Processing US Sales and Use taxes in Oracle

Payables and Oracle Purchasing

• Using Oracle’s e-Business Suite to process US
Sales and Use taxes

• Overview of US Sales and Use taxes
• Processing US Sales tax in Oracle Receivables,

Oracle Order Management, and other products
• Processing US Sales and Use taxes in Oracle

Payables and Oracle Purchasing
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Oracle e-Business Suite Applications that Process US
Sales and Use Taxes
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Oracle e-Business Suite Applications that
Process US Sales and Use Taxes

Oracle e-Business Suite Applications that
Process US Sales and Use Taxes

Sales Tax

X

X

X

X

Application

Receivables

Order Management

Payables

Purchasing

Use Tax

N/A

N/A

X

X
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Partner SolutionsPartner Solutions

• Oracle Receivables (and all other Order to Cash
products that use the Oracle Receivables tax
setup) provides US Sales tax partner solutions
with Vertex Quantum™ and the Taxware Sales/Use
Tax System™.

• These partner solutions calculate and report
complex taxes, while Oracle’s e-Business suite
creates and stores all other tax data.

• Oracle Receivables (and all other Order to Cash
products that use the Oracle Receivables tax
setup) provides US Sales tax partner solutions
with Vertex Quantum™ and the Taxware Sales/Use
Tax System™.

• These partner solutions calculate and report
complex taxes, while Oracle’s e-Business suite
creates and stores all other tax data.
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Agenda
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AgendaAgenda

• Using Oracle’s e-Business Suite to process US Sales
and Use taxes

• Overview of US Sales and Use taxes
• Processing US Sales tax in Oracle Receivables,

Oracle Order Management, and other products
• Processing US Sales and Use taxes in Oracle

Payables and Oracle Purchasing

• Using Oracle’s e-Business Suite to process US Sales
and Use taxes

• Overview of US Sales and Use taxes
• Processing US Sales tax in Oracle Receivables,

Oracle Order Management, and other products
• Processing US Sales and Use taxes in Oracle

Payables and Oracle Purchasing
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Overview of US Sales TaxOverview of US Sales Tax

• US Sales tax is:
– Tax on the retail sale, transfer, lease, rental, or

exchange of tangible personal property (TPP)
– Typically charged to the customer
– Collected from the customer and remitted to

the state by the supplier
• The tax base encompasses various services in

many states.

• US Sales tax is:
– Tax on the retail sale, transfer, lease, rental, or

exchange of tangible personal property (TPP)
– Typically charged to the customer
– Collected from the customer and remitted to

the state by the supplier
• The tax base encompasses various services in

many states.
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US Sales TaxUS Sales Tax

Supplier remitsSupplier remits
sales tax to statesales tax to state

tax authoritytax authority

State collectsState collects
sales taxsales tax

Customer paysCustomer pays
supplier cost of itemsupplier cost of item

plus sales taxplus sales tax

$100 item +$100 item +
$10 sales tax$10 sales tax

$10 sales$10 sales
taxtax
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Overview of US Use TaxOverview of US Use Tax

US Use tax is:
• Tax on the storage, use, or consumption of a

taxable item (TPP or service) to which sales tax
does not apply or was applied at a lower rate.

• Enacted primarily for states to tax interstate sales
when sales tax does not apply.

• Typically self-accrued by the customer/purchaser.

US Use tax is:
• Tax on the storage, use, or consumption of a

taxable item (TPP or service) to which sales tax
does not apply or was applied at a lower rate.

• Enacted primarily for states to tax interstate sales
when sales tax does not apply.

• Typically self-accrued by the customer/purchaser.
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US Use Tax
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US Use TaxUS Use Tax

Tax authority receivesTax authority receives
payment directly frompayment directly from

customercustomer

Customer pays supplier forCustomer pays supplier for
TPP or service and pays taxTPP or service and pays tax

owed to tax authorityowed to tax authority

Supplier charges and only receivesSupplier charges and only receives
payment for tangible personalpayment for tangible personal

property (TPP) or serviceproperty (TPP) or service

$100 item$100 item

$10 use tax$10 use tax
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Application of Sales and Use TaxesApplication of Sales and Use Taxes

State and Local laws, rules, and regulations affect:
• The application of sales and use taxes
• The availability and types of exemptions
• Filing requirements and types of exemptions
• Whether you should report sales and use taxes on

an accrual or cash basis
• Acceptable accounting methods

State and Local laws, rules, and regulations affect:
• The application of sales and use taxes
• The availability and types of exemptions
• Filing requirements and types of exemptions
• Whether you should report sales and use taxes on

an accrual or cash basis
• Acceptable accounting methods

(Help) Oracle Financial Applications > Oracle Receivables Tax
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AgendaAgenda

• Using Oracle’s e-Business Suite to process US Sales
and Use Taxes

• Overview of US Sales and Use Taxes
• Processing US Sales tax in Oracle Receivables,

Oracle Order Management, and other products
• Processing US Sales and Use taxes in Oracle

Payables and Oracle Purchasing

• Using Oracle’s e-Business Suite to process US Sales
and Use Taxes

• Overview of US Sales and Use Taxes
• Processing US Sales tax in Oracle Receivables,

Oracle Order Management, and other products
• Processing US Sales and Use taxes in Oracle

Payables and Oracle Purchasing
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Oracle Receivables Tax OverviewOracle Receivables Tax Overview

State.County.City + Zip CodeState.County.City + Zip Code

Tax RatesTax Rates

LocationsLocations IL.Cook.Chicago + 60601IL.Cook.Chicago + 60601

3%     2%    1.5%         =   6.5%3%     2%    1.5%         =   6.5%

StructureStructure

Based on customer’s ship-to address:

(Help) Oracle Financial Applications > Oracle Receivables > Tax >
Calculating Tax >  Calculating Tax



Copyright © Oracle Corporation, 2001. All rights reserved.

R11i Processing U.S. Sales and Use Taxes
Chapter 26 - Page 16

Calculating US Sales Tax in Oracle Receivables

Copyright   Oracle Corporat ion,  2000. All rights reserved.
®

Calculating US Sales Tax in Oracle
Receivables

Calculating US Sales Tax in Oracle
Receivables

• Oracle Receivables calculates sales tax on
invoices, debit memos, credit memos, and
adjustments

• Sales tax is not calculated on guarantees,
deposits, or cash receipts

• To calculate sales tax on freight, you must set up
the freight inventory item

• Oracle Receivables calculates sales tax on
invoices, debit memos, credit memos, and
adjustments

• Sales tax is not calculated on guarantees,
deposits, or cash receipts

• To calculate sales tax on freight, you must set up
the freight inventory item
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Processing US Sales Tax in Oracle
Receivables

Processing US Sales Tax in Oracle
Receivables

Prerequisite:
• Implement US Sales tax
Prerequisite:
• Implement US Sales tax

You can enter and review sales tax information for
your transaction lines in the Tax window.
You can enter and review sales tax information for
your transaction lines in the Tax window.

(Help) Oracle Financial Applications > Oracle Receivables > Tax >
Transactions > Entering Tax Information
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Processing US Sales Tax in Oracle Receivables
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Processing US Sales Tax in Oracle
Receivables

Processing US Sales Tax in Oracle
Receivables

1. Enter a transaction from the Transaction window.
a. Enter header information (e.g., customer)
b. Enter line items
c. Enter exemption information, if applicable

2. Review Tax details
a. Select a line to view
b. Choose the Tax button
c. Select View Tax for All Lines to view tax

details for all lines

1. Enter a transaction from the Transaction window.
a. Enter header information (e.g., customer)
b. Enter line items
c. Enter exemption information, if applicable

2. Review Tax details
a. Select a line to view
b. Choose the Tax button
c. Select View Tax for All Lines to view tax

details for all lines
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Querying and Changing Transactions in Oracle
Receivables
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Querying and Changing Transactions in
Oracle Receivables

Querying and Changing Transactions in
Oracle Receivables

1. Query or change a current transaction from the
Transaction or Transaction Summary window.

2. Change an automatically generated Tax code,
(depending on your profile options).

3. Oracle Receivables displays the new tax rate and
amount.

4. If you use AutoAccounting, rerun Review
Accounting to update your tax account for this
invoice line.

1. Query or change a current transaction from the
Transaction or Transaction Summary window.

2. Change an automatically generated Tax code,
(depending on your profile options).

3. Oracle Receivables displays the new tax rate and
amount.

4. If you use AutoAccounting, rerun Review
Accounting to update your tax account for this
invoice line.
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Adjusting Sales Tax when Copying
Invoices

Adjusting Sales Tax when Copying
Invoices

• Use the Copy Transactions window to
automatically duplicate the basic information that
appears on recurring invoices

• The tax invoice will calculate tax for the
transaction date of the new invoice

• Use the Copy Transactions window to
automatically duplicate the basic information that
appears on recurring invoices

• The tax invoice will calculate tax for the
transaction date of the new invoice

(Help) Oracle Financial Applications > Oracle Receivables > Tax >
Transactions > Copying Invoices
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DemonstrationDemonstration

This demonstration shows you how to:
• Enter and review sales tax information for an

invoice in Oracle Receivables
(N) Transaction—>Transactions—>Tax (B) Tax

This demonstration shows you how to:
• Enter and review sales tax information for an

invoice in Oracle Receivables
(N) Transaction—>Transactions—>Tax (B) Tax
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Entering and Changing Sales Tax Credit
Memo Information in Oracle Receivables
Entering and Changing Sales Tax Credit
Memo Information in Oracle Receivables

You can enter and change tax information for your
credit memos in the Tax window.
You can enter and change tax information for your
credit memos in the Tax window.
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Entering Sales Tax Credit Memo Information in Oracle
Receivables
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Entering Sales Tax Credit Memo
Information in Oracle Receivables
Entering Sales Tax Credit Memo

Information in Oracle Receivables

1. Enter a credit memo from the Credit
Transactions or Transaction Summary window
OR select Credit Lines and enter individual credit
lines.

2. Enter an amount or tax percentage to credit in
the Credit Transactions form.

3. Query is used to review a transaction and
changes can only be made if the period has not
closed.

1. Enter a credit memo from the Credit
Transactions or Transaction Summary window
OR select Credit Lines and enter individual credit
lines.

2. Enter an amount or tax percentage to credit in
the Credit Transactions form.

3. Query is used to review a transaction and
changes can only be made if the period has not
closed.
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DemonstrationDemonstration

This demonstration shows you how to:
• Enter or query tax information on credit memos

lines in Oracle Receivables
(N) Transactions—>Credit Transactions
(N) Transactions—>Transactions Summary—>Query
      Transaction—>Credit
(N) Transactions—>Query Transaction—>Tools

 —>Credit

This demonstration shows you how to:
• Enter or query tax information on credit memos

lines in Oracle Receivables
(N) Transactions—>Credit Transactions
(N) Transactions—>Transactions Summary—>Query
      Transaction—>Credit
(N) Transactions—>Query Transaction—>Tools

 —>Credit
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Tax Exemptions in Oracle ReceivablesTax Exemptions in Oracle Receivables

When you define your tax exemptions, you have the
option of creating exemptions for:
• Customers

– Tax authority location
– Specific customer sites
– No specific location

• Items
• Ranges of items

When you define your tax exemptions, you have the
option of creating exemptions for:
• Customers

– Tax authority location
– Specific customer sites
– No specific location

• Items
• Ranges of items

(Help) Oracle Financial Applications > Oracle Receivables > Tax >
Setting Up > Tax Exemptions
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Tax Exceptions in Oracle ReceivablesTax Exceptions in Oracle Receivables

When you define your tax exceptions, you have the
option of creating exceptions for:
• Items
• Ranges of items

When you define your tax exceptions, you have the
option of creating exceptions for:
• Items
• Ranges of items

(Help) Oracle Financial Applications > Oracle Receivables > Tax >
Setting Up > Tax Rate Exceptions
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Printing Tax InformationPrinting Tax Information

• When you submit your invoices and debit memos
through the Print Invoices window, Oracle
Receivables prints tax information on your forms

• You can specify the tax printing option for each
site or customer.  Alternatively, Oracle Receivables
will use the tax printing option you chose in the
System Options window

• When you submit your invoices and debit memos
through the Print Invoices window, Oracle
Receivables prints tax information on your forms

• You can specify the tax printing option for each
site or customer.  Alternatively, Oracle Receivables
will use the tax printing option you chose in the
System Options window

(Help) Oracle Financial Applications > Oracle Receivables > Reports
> Invoice Print Reports
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US Sales Tax Adjustments in Oracle
Receivables

US Sales Tax Adjustments in Oracle
Receivables

You can apply manual adjustments to your invoice
and the tax amounts will reconcile to your tax reports.
1. Query your transaction, select tools, and then

select either Adjust or Transaction Summary.
2. Enter a Tax Adjustment in the Adjustment window.
3. Approved adjustments of type ‘Tax’ will be applied

and appear on tax reports.
(N) Transactions—>Transactions Summary—>Query
      Transaction—>Adjust
(N) Transactions—>Query Transaction—>Tools

 —>Adjust

You can apply manual adjustments to your invoice
and the tax amounts will reconcile to your tax reports.
1. Query your transaction, select tools, and then

select either Adjust or Transaction Summary.
2. Enter a Tax Adjustment in the Adjustment window.
3. Approved adjustments of type ‘Tax’ will be applied

and appear on tax reports.
(N) Transactions—>Transactions Summary—>Query
      Transaction—>Adjust
(N) Transactions—>Query Transaction—>Tools

 —>Adjust

(Help) Oracle Financial Applications > Oracle Receivables >
Transactions > Maintaining Transactions Field Reference >
Adjustments
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Reconciling Sales Tax Returns to the
General Ledger

Reconciling Sales Tax Returns to the
General Ledger

You should run the following reports during each
accounting period to verify that your Sales Tax
Returns for each state balance to the sales tax
liability accounts in your general ledger:

You should run the following reports during each
accounting period to verify that your Sales Tax
Returns for each state balance to the sales tax
liability accounts in your general ledger:

• US Sales Tax Report
• General Ledger Account Analysis Report
• Sales Journal by General Ledger Account
• Adjustments Register

• US Sales Tax Report
• General Ledger Account Analysis Report
• Sales Journal by General Ledger Account
• Adjustments Register

(Help) Oracle Financial Applications > Oracle Receivables > Tax >
Implementing US Sales Tax > US Sales Tax Reconciliation
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US Sales Tax ReportUS Sales Tax Report

The US Sales Tax report enables you to identify and
review your sales tax liability to the various tax
authorities around the United States.

The US Sales Tax report enables you to identify and
review your sales tax liability to the various tax
authorities around the United States.

(Help) Oracle Financial Applications > Oracle Receivables > Reports
> Tax Reports
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General Ledger Account Analysis ReportGeneral Ledger Account Analysis Report

You can use the General Ledger Account Analysis
report, along with the US Sales Tax report, to reconcile
tax amounts and identify any tax transactions not
posted to the appropriate sales tax liability account.

You can use the General Ledger Account Analysis
report, along with the US Sales Tax report, to reconcile
tax amounts and identify any tax transactions not
posted to the appropriate sales tax liability account.

(Help) Oracle Financial Applications > Oracle Receivables > Reports
> Tax Reports
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Sales Journal by General Ledger Account
Report

Sales Journal by General Ledger Account
Report

The Sales Journal by General Ledger Account report
verifies that only authorized sales tax activity has
been posted to valid sales tax liability accounts.

The Sales Journal by General Ledger Account report
verifies that only authorized sales tax activity has
been posted to valid sales tax liability accounts.

(Help) Oracle Financial Applications > Oracle Receivables > Reports
> Tax Reports
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Adjustments RegisterAdjustments Register

Oracle Receivables allows you to increase or
decrease the amount due of your invoice or debit
memo.

Oracle Receivables allows you to increase or
decrease the amount due of your invoice or debit
memo.

(Help) Oracle Financial Applications > Oracle Receivables > Reports
> Tax Reports
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Review QuestionsReview Questions

In this practice, you will mark these statements true
or false to test your knowledge of processing sales
tax in Oracle Receivables.

In this practice, you will mark these statements true
or false to test your knowledge of processing sales
tax in Oracle Receivables.

1.  ______  US Sales tax in Oracle Receivables is
based on the customer’s billing address.

2.  ______ You can create exemptions for customers,
items, and a range of items.

3.  ______ Sales tax is calculated on deposits.
4. ______  You can use the US Sales Tax report and

General Ledger Account Analysis report to
identify any tax transactions not posted to the
appropriate sales tax liability account.

1.  ______  US Sales tax in Oracle Receivables is
based on the customer’s billing address.

2.  ______ You can create exemptions for customers,
items, and a range of items.

3.  ______ Sales tax is calculated on deposits.
4. ______  You can use the US Sales Tax report and

General Ledger Account Analysis report to
identify any tax transactions not posted to the
appropriate sales tax liability account.
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Solutions to Review QuestionsSolutions to Review Questions

In this practice, you will mark these statements true
or false to test your knowledge of processing sales
tax in Oracle Receivables.

In this practice, you will mark these statements true
or false to test your knowledge of processing sales
tax in Oracle Receivables.
1.  False   US Sales tax in Oracle Receivables is

based on the customer’s billing address.
2.  True  You can create exemptions for customers,

items, and a range of items.
3.  False  Sales tax is calculated on deposits.
4. True  You can use the US Sales Tax report and

General Ledger Account Analysis report to
identify any tax transactions not posted to the
appropriate sales tax liability account.

1.  False   US Sales tax in Oracle Receivables is
based on the customer’s billing address.

2.  True  You can create exemptions for customers,
items, and a range of items.

3.  False  Sales tax is calculated on deposits.
4. True  You can use the US Sales Tax report and

General Ledger Account Analysis report to
identify any tax transactions not posted to the
appropriate sales tax liability account.
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Processing Sales Tax in Oracle Order
Management

Processing Sales Tax in Oracle Order
Management

Order Management allows you to quote an estimated
sales tax for orders at the time of order entry.  Actual
tax is calculated in Oracle Receivables during
invoicing and may differ from the estimated amount if
dates/rates change.  As with Oracle Receivables,
sales tax is based on different components of the
customer’s shipping address.

Order Management allows you to quote an estimated
sales tax for orders at the time of order entry.  Actual
tax is calculated in Oracle Receivables during
invoicing and may differ from the estimated amount if
dates/rates change.  As with Oracle Receivables,
sales tax is based on different components of the
customer’s shipping address.
Prerequisites:
• Implement US Sales tax
Prerequisites:
• Implement US Sales tax

(Help) Oracle Manufacturing Applications > Oracle Order
Management > Setting  Up > Taxation
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Processing Sales Tax in Oracle Order
Management

Processing Sales Tax in Oracle Order
Management

Sales tax is automatically calculated when you enter
and update sales orders using the Sales Orders
window:

Sales tax is automatically calculated when you enter
and update sales orders using the Sales Orders
window:

• Entering the ship-to information determines the
sales tax calculation

• Entering tax exemption information has the same
functionality as described previously for Oracle
Receivables.

• Entering the ship-to information determines the
sales tax calculation

• Entering tax exemption information has the same
functionality as described previously for Oracle
Receivables.
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DemonstrationDemonstration

This demonstration shows you how to:
• Enter and review sales tax information for a sales

order in Order Management
(N) Orders, Returns—>Sales Orders
(N) Orders, Returns—>Order Organizer—>
[Find Orders]—>Order Information Tab

This demonstration shows you how to:
• Enter and review sales tax information for a sales

order in Order Management
(N) Orders, Returns—>Sales Orders
(N) Orders, Returns—>Order Organizer—>
[Find Orders]—>Order Information Tab
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Review QuestionReview Question

In Order Management, sales tax is based on different
components of the  ______________.
In Order Management, sales tax is based on different
components of the  ______________.

1. Customer’s sales order slip
2. Customer’s billing address
3. Customer’s zip code
4. Customer’s shipping address
5. Customer’s place of residence

1. Customer’s sales order slip
2. Customer’s billing address
3. Customer’s zip code
4. Customer’s shipping address
5. Customer’s place of residence
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Solution to Review QuestionSolution to Review Question

In Order Management, sales tax is based on different
components of the  ______________.
In Order Management, sales tax is based on different
components of the  ______________.

1. Customer’s sales order slip
2. Customer’s billing address
3. Customer’s zip code
4. Customer’s shipping address
5. Customer’s place of residence

1. Customer’s sales order slip
2. Customer’s billing address
3. Customer’s zip code
4. Customer’s shipping address
5. Customer’s place of residence
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AgendaAgenda

• Using Oracle’s e-Business Suite to process US Sales
and Use tax

• Overview of US Sales and Use tax
• Processing US Sales tax in Oracle Receivables,

Oracle Order Management, and other products
• Processing US Sales and Use taxes in Oracle

Payables and Oracle Purchasing

• Using Oracle’s e-Business Suite to process US Sales
and Use tax

• Overview of US Sales and Use tax
• Processing US Sales tax in Oracle Receivables,

Oracle Order Management, and other products
• Processing US Sales and Use taxes in Oracle

Payables and Oracle Purchasing



Copyright © Oracle Corporation, 2001. All rights reserved.

R11i Processing U.S. Sales and Use Taxes
Chapter 26 - Page 42

Oracle Payables Tax Overview

Copyright   Oracle Corporat ion,  2000. All rights reserved.
®

Oracle Payables Tax OverviewOracle Payables Tax Overview

Tax Code

Tax Type Tax Rate

PayablesPayables
InvoiceInvoice

Options, Controls,Options, Controls,
and Defaultsand Defaults

(Help) Oracle Financial Applications > Oracle Payables > Invoices >
Taxes on Invoices > Payables and Financials Options
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Processing Taxes in Oracle PayablesProcessing Taxes in Oracle Payables

• You can record taxes by manually entering tax
distributions, or by having Payables automatically
create tax distributions based on a tax code you
enter

• You can set up your Payables system to default
tax codes based on your business needs

• You can record taxes by manually entering tax
distributions, or by having Payables automatically
create tax distributions based on a tax code you
enter

• You can set up your Payables system to default
tax codes based on your business needs

(Help) Oracle Financial Applications > Oracle Payables > Invoices >
Taxes on Invoices > Entering Taxes on Invoices
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Setting Up US Sales Tax in Oracle
Payables

Setting Up US Sales Tax in Oracle
Payables

You can use this method to set up Sales tax:You can use this method to set up Sales tax:

Invoice
Item          $1000
Sales Tax     $85
Total         $1085

$1085$1085

Sales Tax Code 8.5%Sales Tax Code 8.5%
100% Nonrecoverable100% Nonrecoverable

TaxTax
ReportingReporting

LedgerLedger

$1085$1085

Asset / ExpenseAsset / Expense
AccountAccount
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Setting Up US Use Tax in Oracle PayablesSetting Up US Use Tax in Oracle Payables

You can choose one of these methods to set up Use
tax:
You can choose one of these methods to set up Use
tax:

Invoice
Item       $1000
Use Tax     $85
Total      $1000

$85$85

1.  Use Tax Code 8.5%1.  Use Tax Code 8.5%
100% Nonrecoverable100% Nonrecoverable

Use TaxUse Tax
LiabilityLiability
ReportReport

2.  Sales Tax Code 8.5%2.  Sales Tax Code 8.5%
100% Nonrecoverable 100% Nonrecoverable 
Offset Tax Code - 8.5%Offset Tax Code - 8.5%

100% Recoverable100% Recoverable

Invoice
Item   $1000
Sales Tax    $85
Offset Tax  -$85
Total   $1000

$1085$1085

Asset / ExpenseAsset / Expense
AccountAccount

Tax ReportingTax Reporting
LedgerLedger

$85$85

- $85- $85
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Prerequisites for Processing Taxes in
Oracle Payables

Prerequisites for Processing Taxes in
Oracle Payables

Prerequisites:
• Implement US Sales and Use taxes
Prerequisites:
• Implement US Sales and Use taxes

US Sales and Use taxes are assigned to the invoice
distributions that are taxable.  Payables records the
tax you owe the state or tax authority based on the
Sales or Use tax codes’ tax rate and account.

US Sales and Use taxes are assigned to the invoice
distributions that are taxable.  Payables records the
tax you owe the state or tax authority based on the
Sales or Use tax codes’ tax rate and account.
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Entering Sales or Use Taxes in the
Invoice Workbench

Entering Sales or Use Taxes in the
Invoice Workbench

1. Enter all basic invoice information from the
Invoices window.

2. Enter a Sales or Use type tax code (or US Sales tax
with an Offset tax code), or accept the tax code
default, if applicable.

3. Navigate to the Distributions window.  For each
item you enter with an Item, Freight, or
Miscellaneous type, accept or change the default
tax code.

4. Do not create a tax distribution for a use tax.

1. Enter all basic invoice information from the
Invoices window.

2. Enter a Sales or Use type tax code (or US Sales tax
with an Offset tax code), or accept the tax code
default, if applicable.

3. Navigate to the Distributions window.  For each
item you enter with an Item, Freight, or
Miscellaneous type, accept or change the default
tax code.

4. Do not create a tax distribution for a use tax.

(Help) Oracle Financial Applications > Oracle Payables > Invoices >
Entering Invoices in the Invoice Workbench > Entering Basic
Invoices in the Invoice Workbench
(Help) Oracle Financial Applications > Oracle Payables > Invoices >
Entering Invoices in the Invoice Workbench > Entering Invoice
Distributions in the Invoice Workbench
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Entering Sales or Use Taxes in the Invoice Workbench
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Entering Sales or Use Taxes in the
Invoice Workbench

Entering Sales or Use Taxes in the
Invoice Workbench

5. For tax-exempt distributions, enter an exempt
zero-percent Sales tax code or clear the Use Tax
Code field.

6. After Approval, you can view the completed tax
allocations in the Allocations window.

7. Run the Tax Audit Trail report, Tax Reporting
Ledger, or the Use Tax Liability report to review
your work.

5. For tax-exempt distributions, enter an exempt
zero-percent Sales tax code or clear the Use Tax
Code field.

6. After Approval, you can view the completed tax
allocations in the Allocations window.

7. Run the Tax Audit Trail report, Tax Reporting
Ledger, or the Use Tax Liability report to review
your work.

(Help) Oracle Financial Applications > Oracle Payables > Reports and
Programs > Invoice Tax Reports > Invoice Tax Reports
(Help) Oracle Financial Applications > Oracle Payables > Reports and
Programs > Invoice Tax Reports > Use Tax Liability Report
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Demonstration
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DemonstrationDemonstration

This demonstration shows you how to:
• Enter sales taxes in the Invoice Workbench and

review tax details
• Enter use taxes in the Invoice Workbench

– Using use tax codes
– Using offset tax codes

• Review tax details
(N) Invoices—>Invoices

This demonstration shows you how to:
• Enter sales taxes in the Invoice Workbench and

review tax details
• Enter use taxes in the Invoice Workbench

– Using use tax codes
– Using offset tax codes

• Review tax details
(N) Invoices—>Invoices



Copyright © Oracle Corporation, 2001. All rights reserved.

R11i Processing U.S. Sales and Use Taxes
Chapter 26 - Page 50

Entering Taxes in the Invoice Gateway
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Entering Taxes in the Invoice GatewayEntering Taxes in the Invoice Gateway

To enter sales or use taxes from the Invoice Gateway:
1. Enter the invoice record.
2. For each Item, Freight, or Miscellaneous line that

includes a sales or use tax, enter the appropriate
tax type in the Tax Code field.  Do not enable the
Includes Tax check box.

3. Complete invoice entry and import the invoice
record.

4. Run the Tax Reporting Ledger, Tax Audit Trail
report or the Use Tax Liability report to review
your work.

To enter sales or use taxes from the Invoice Gateway:
1. Enter the invoice record.
2. For each Item, Freight, or Miscellaneous line that

includes a sales or use tax, enter the appropriate
tax type in the Tax Code field.  Do not enable the
Includes Tax check box.

3. Complete invoice entry and import the invoice
record.

4. Run the Tax Reporting Ledger, Tax Audit Trail
report or the Use Tax Liability report to review
your work.
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Invoice Tax Restrictions
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Invoice Tax RestrictionsInvoice Tax Restrictions

• If the Require Tax Entry at Header Option is
enabled, you cannot enter use tax codes for some
invoices, either manually or through a supplier site
default.

• You should not enable this option if you want to
use the Allocate window to prorate tax.  If you
enter a default tax and amount and then prorate,
you may overstate your taxes.

• If the Require Tax Entry at Header Option is
enabled, you cannot enter use tax codes for some
invoices, either manually or through a supplier site
default.

• You should not enable this option if you want to
use the Allocate window to prorate tax.  If you
enter a default tax and amount and then prorate,
you may overstate your taxes.
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Demonstration
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DemonstrationDemonstration

This demonstration shows you how to:
• Enter and review sales tax through the Invoice

Gateway
(N) Invoices—>Invoice Gateway

This demonstration shows you how to:
• Enter and review sales tax through the Invoice

Gateway
(N) Invoices—>Invoice Gateway
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Review QuestionsReview Questions

In this practice, you will mark these statements true
or false to test your knowledge of processing sales
and use taxes in Oracle Payables.

In this practice, you will mark these statements true
or false to test your knowledge of processing sales
and use taxes in Oracle Payables.

1.  ______  You can calculate tax for distributions
when the distribution amount includes tax.

2.  ______  You need to set up distributions for a use
Tax.

3.  ______  You should view your completed tax
allocations in the Allocations window, prior to
Approval.

4. ______  You can enter sales tax through the
Invoice Gateway.

1.  ______  You can calculate tax for distributions
when the distribution amount includes tax.

2.  ______  You need to set up distributions for a use
Tax.

3.  ______  You should view your completed tax
allocations in the Allocations window, prior to
Approval.

4. ______  You can enter sales tax through the
Invoice Gateway.
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Solutions to Review QuestionsSolutions to Review Questions

In this practice, you will mark these statements true
or false to test your knowledge of processing sales
and use taxes in Oracle Payables.

In this practice, you will mark these statements true
or false to test your knowledge of processing sales
and use taxes in Oracle Payables.

1.  True  You can calculate tax for distributions when
the distribution amount includes tax.

2.  False  You need to set up distributions for a use
Tax.

3.  False  You should view your completed tax
allocations in the Allocations window, prior to
Approval.

4. True  You can enter sales tax through the Invoice
Gateway.

1.  True  You can calculate tax for distributions when
the distribution amount includes tax.

2.  False  You need to set up distributions for a use
Tax.

3.  False  You should view your completed tax
allocations in the Allocations window, prior to
Approval.

4. True  You can enter sales tax through the Invoice
Gateway.
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Processing US Sales and Use Tax in Oracle
Purchasing
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Processing US Sales and Use Tax in
Oracle Purchasing

Processing US Sales and Use Tax in
Oracle Purchasing

Oracle Purchasing allows you to enter tax information
on your Purchasing documents using the Tax Code
and Recovery Rate fields.
Each tax code has an associated tax rate in Payables
that determines the tax amount for an item.  You also
associate a recovery rate with each tax code.

Oracle Purchasing allows you to enter tax information
on your Purchasing documents using the Tax Code
and Recovery Rate fields.
Each tax code has an associated tax rate in Payables
that determines the tax amount for an item.  You also
associate a recovery rate with each tax code.
Prerequisites:
• Implement US Sales and Use taxes
Prerequisites:
• Implement US Sales and Use taxes
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Entering Sales or Use Taxes in Purchase Order
Shipments
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Entering Sales or Use Taxes in Purchase
Order Shipments

Entering Sales or Use Taxes in Purchase
Order Shipments

1. Enter all basic purchase order information from
the Shipments window.

2. Use the default Tax Code for taxable items or
select another.

3. You can view tax information by:
a. Choosing Tax Code Summary from the Tool

menu to see the total recoverable tax for each
tax code in your document.

b. Choosing Tax Details from the Tools menu to
see recoverable and nonrecoverable tax details
for each line, shipment, and distribution.

1. Enter all basic purchase order information from
the Shipments window.

2. Use the default Tax Code for taxable items or
select another.

3. You can view tax information by:
a. Choosing Tax Code Summary from the Tool

menu to see the total recoverable tax for each
tax code in your document.

b. Choosing Tax Details from the Tools menu to
see recoverable and nonrecoverable tax details
for each line, shipment, and distribution.
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Demonstration
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DemonstrationDemonstration

This demonstration shows you how to:
• Enter and review US Sales and Use taxes for a

purchase order
(N) Purchase Orders—>Distributions

This demonstration shows you how to:
• Enter and review US Sales and Use taxes for a

purchase order
(N) Purchase Orders—>Distributions
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US Use Tax Reports
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US Use Tax ReportsUS Use Tax Reports

• Use Tax Liability Report
• Tax Reporting Ledger
• Use Tax Liability Report
• Tax Reporting Ledger

(Help) Oracle Financial Applications > Oracle Payables > Reports and
Programs > Invoice Tax Reports > Use Tax Liability Report
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Review QuestionReview Question

In Oracle Purchasing, each tax code has an
associated rate in Payables that determines the
_________ for an item.

In Oracle Purchasing, each tax code has an
associated rate in Payables that determines the
_________ for an item.

1. Recovery rate
2. Tax amount
3. Total amount
3. PO number
4. Tax details

1. Recovery rate
2. Tax amount
3. Total amount
3. PO number
4. Tax details
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Solution to Review QuestionSolution to Review Question

In Oracle Purchasing, each tax code has an
associated rate in Payables that determines the
_________ for an item.

In Oracle Purchasing, each tax code has an
associated rate in Payables that determines the
_________ for an item.

1. Recovery rate
2. Tax amount
3. Total amount
3. PO number
4. Tax details

1. Recovery rate
2. Tax amount
3. Total amount
3. PO number
4. Tax details
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SummarySummary

In this module, you should have learned to:
• Explain how Oracle’s e-Business Suite handles the

processing of US Sales and Use taxes
• Process US Sales tax in Oracle Receivables,

Oracle Order Management, and other products
• Process US Sales and Use taxes in Oracle

Payables and Oracle Purchasing

In this module, you should have learned to:
• Explain how Oracle’s e-Business Suite handles the

processing of US Sales and Use taxes
• Process US Sales tax in Oracle Receivables,

Oracle Order Management, and other products
• Process US Sales and Use taxes in Oracle

Payables and Oracle Purchasing
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R11i Implementing US Sales
and Use Taxes
Chapter 27
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Implementing US Sales and Use Taxes
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Implementing US Sales and Use TaxesImplementing US Sales and Use Taxes

Release 11iRelease 11i
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ObjectivesObjectives

After this module, you should be able to:
• Describe US Sales and Use taxes
• Set up Oracle Receivables and Oracle Order

Management for US Sales tax
• Set up Oracle Payables and Oracle Purchasing for

US Sales and Use taxes

After this module, you should be able to:
• Describe US Sales and Use taxes
• Set up Oracle Receivables and Oracle Order

Management for US Sales tax
• Set up Oracle Payables and Oracle Purchasing for

US Sales and Use taxes
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Agenda
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AgendaAgenda

• Describing US Sales and Use taxes
• Setting up Oracle Receivables and Oracle Order

Management for US Sales tax
• Setting up Oracle Payables and Oracle Purchasing for

US Sales and Use taxes

• Describing US Sales and Use taxes
• Setting up Oracle Receivables and Oracle Order

Management for US Sales tax
• Setting up Oracle Payables and Oracle Purchasing for

US Sales and Use taxes
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US Sales Tax Overview
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US Sales Tax OverviewUS Sales Tax Overview

• US Sales tax is:
– Tax on the retail sale, transfer, lease, rental, or

exchange of tangible personal property (TPP)
– Typically charged to the customer
– Collected from the customer and remitted to

the state by the supplier
• Tax base encompasses various services in many

states

• US Sales tax is:
– Tax on the retail sale, transfer, lease, rental, or

exchange of tangible personal property (TPP)
– Typically charged to the customer
– Collected from the customer and remitted to

the state by the supplier
• Tax base encompasses various services in many

states
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US Use Tax Overview
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US Use Tax OverviewUS Use Tax Overview

US Use tax is:
• Tax on the storage, use, or consumption of a

taxable item (TPP or service) that sales tax does
not apply or was applied at a lower rate to

• Enacted primarily for states to tax interstate sales
when sales tax does not apply

• Typically self-accrued by the customer/purchaser

US Use tax is:
• Tax on the storage, use, or consumption of a

taxable item (TPP or service) that sales tax does
not apply or was applied at a lower rate to

• Enacted primarily for states to tax interstate sales
when sales tax does not apply

• Typically self-accrued by the customer/purchaser
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Agenda
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AgendaAgenda

• Describing US Sales and Use taxes
• Setting up Oracle Receivables and Oracle Order

Management for US Sales tax
• Setting up Oracle Payables and Oracle Purchasing for

US Sales and Use taxes

• Describing US Sales and Use taxes
• Setting up Oracle Receivables and Oracle Order

Management for US Sales tax
• Setting up Oracle Payables and Oracle Purchasing for

US Sales and Use taxes



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Implementing US Sales and Use Taxes
Chapter 27 - Page 8

Oracle Receivables Tax Overview
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Oracle Receivables Tax OverviewOracle Receivables Tax Overview

State.County.City + Zip CodeState.County.City + Zip Code

Tax RatesTax Rates

LocationsLocations IL.Cook.Chicago + 60601IL.Cook.Chicago + 60601

3%     2%    1.5%         =   6.5%3%     2%    1.5%         =   6.5%

StructureStructure

Based on customer’s ship-to address:
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Setting Up Tax in the System Options Window
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Setting Up Tax in the System Options
Window

Setting Up Tax in the System Options
Window

1.  Define Sales Tax as tax method.
2.  Select a Sales Tax Location Flexfield Structure to

determine tax rates and to validate your customer
addresses. The recommended structure for US
Sales tax is State.County.City.

3.  Define tax preferences.
4.  Set up tax engine controls.
5.  Save system options.

1.  Define Sales Tax as tax method.
2.  Select a Sales Tax Location Flexfield Structure to

determine tax rates and to validate your customer
addresses. The recommended structure for US
Sales tax is State.County.City.

3.  Define tax preferences.
4.  Set up tax engine controls.
5.  Save system options.

(N) Setup > System > System Options
(Help) Oracle Receivables > Tax > Implementing US Sales Tax > Setup Steps
for US Sales Tax



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Implementing US Sales and Use Taxes
Chapter 27 - Page 10

Demonstration
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DemonstrationDemonstration

This demonstration covers how to:
• Define Sales Tax as the Tax Method
• Select State.County.City as the Location Flexfield

Structure
• Define tax preferences and set up tax engine

controls

(N) Setup > System > System Options > (T) Tax > (T)
Tax Defaults and Rules

This demonstration covers how to:
• Define Sales Tax as the Tax Method
• Select State.County.City as the Location Flexfield

Structure
• Define tax preferences and set up tax engine

controls

(N) Setup > System > System Options > (T) Tax > (T)
Tax Defaults and Rules

(Help) Oracle Receivables > Tax > Implementing US Sales Tax > Setup Steps
for US Sales Tax
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Defining Location Tax Code
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Defining Location Tax CodeDefining Location Tax Code

The location tax code:
• Identifies the calculated tax amount on every

invoice
• Should have an appropriate name, such as Sales

Tax
• Can be used to create sales tax exemptions and

exceptions
• Is defined in the Tax Codes and Rates window

The location tax code:
• Identifies the calculated tax amount on every

invoice
• Should have an appropriate name, such as Sales

Tax
• Can be used to create sales tax exemptions and

exceptions
• Is defined in the Tax Codes and Rates window

(N) Setup > Tax > Codes
(Help) Oracle Receivables > Tax > Implementing US Sales Tax > Setup Steps
for US Sales Tax
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Defining Tax Lookups
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Defining Tax LookupsDefining Tax Lookups

• Tax Exemptions window
• Item Tax Rate Exceptions window
• Tax Exemptions window
• Item Tax Rate Exceptions window

Use the Oracle Receivables Lookups window to
define lookups for exemption and exception reasons.
These lookups are used by the Reason field in the:

(N) Setup > System > QuickCodes > Receivables
(Help) Oracle Receivables > Tax > Implementing US Sales Tax > Setup Steps
for US Sales Tax
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Defining Sales Tax Locations and Rates
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Defining Sales Tax Locations and RatesDefining Sales Tax Locations and Rates

• Manually enter in the Tax Locations and Rates
window

• Import using Sales Tax Rate Interface
– Set to zero all sales tax rates for each state

that you are not legally required to collect
sales tax in

• Manually enter in the Tax Locations and Rates
window

• Import using Sales Tax Rate Interface
– Set to zero all sales tax rates for each state

that you are not legally required to collect
sales tax in

Determine the states that you must collect tax in and
states that you are not required to collect tax in.
For locations that you must collect sales tax in, you
can define sales tax locations and rates in two ways:

(N) Setup > Tax > Locations
(Help) Oracle Receivables > Tax > Implementing US Sales Tax > Setup Steps
for US Sales Tax
(Help) Oracle Receivables > Tax > Setting Up > Tax Locations and Rates
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Using the Sales Tax Rate Interface to Import Sales Tax
Information
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Using the Sales Tax Rate Interface to
Import Sales Tax Information

Using the Sales Tax Rate Interface to
Import Sales Tax Information

Sales tax feeder system

SQL*Loader program

AR_TAX_INTERFACE

Sales Tax Interface concurrent program

AR_LOCATION_VALUES
(Locations)

AR_LOCATION_RATES
(Tax rates)

Zero out rates

(Help) Oracle Receivables > Tax > Sales Tax Rate Interface
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Review Question
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Review QuestionReview Question

Which step involves an automated process?
1.  Defining tax lookups
2.  Determining states that you are not required to

collect tax in
3.  Setting sales tax rates to zero for all states that

you are not required to collect tax in

Which step involves an automated process?
1.  Defining tax lookups
2.  Determining states that you are not required to

collect tax in
3.  Setting sales tax rates to zero for all states that

you are not required to collect tax in
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Answer to Review Question
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Answer to Review QuestionAnswer to Review Question

Which step involves an automated process?
1.  Defining tax lookups
2.  Determining states in which you are not required to

collect tax
3.  Setting sales tax rates to zero for all states that

you are not required to collect tax in

Which step involves an automated process?
1.  Defining tax lookups
2.  Determining states in which you are not required to

collect tax
3.  Setting sales tax rates to zero for all states that

you are not required to collect tax in
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Assigning Tax Accounts and Defining AutoAccounting
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Assigning Tax Accounts and Defining
AutoAccounting

Assigning Tax Accounts and Defining
AutoAccounting

• Tax accounts
– Define unique General Ledger accounts for the

sales tax liability of each state
– Use the Tax Locations and Rates window to

assign a different General Ledger account to
the segments of your Location Flexfield
Structure that you enabled the Tax Account
qualifier for

• AutoAccounting
– Define how you want Oracle Receivables to

determine the General Ledger account for
sales tax lines

• Tax accounts
– Define unique General Ledger accounts for the

sales tax liability of each state
– Use the Tax Locations and Rates window to

assign a different General Ledger account to
the segments of your Location Flexfield
Structure that you enabled the Tax Account
qualifier for

• AutoAccounting
– Define how you want Oracle Receivables to

determine the General Ledger account for
sales tax lines

(Help) Oracle Receivables > Tax > Implementing US Sales Tax > Setup Steps
for US Sales Tax



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Implementing US Sales and Use Taxes
Chapter 27 - Page 18

Defining Tax Exemptions and Item Tax Rate
Exceptions
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Defining Tax Exemptions and Item Tax
Rate Exceptions

Defining Tax Exemptions and Item Tax
Rate Exceptions

• Use the Tax Exemptions window and the Sales Tax
location tax code to enter exemptions for items
and customers that are exempt from US Sales tax.

• Use the Item Tax Rate Exceptions window to
assign exception rates to specific states that you
ship items to.

• Use the Tax Exemptions window and the Sales Tax
location tax code to enter exemptions for items
and customers that are exempt from US Sales tax.

• Use the Item Tax Rate Exceptions window to
assign exception rates to specific states that you
ship items to.

(N) Setup > Tax > Exemptions
(N) Setup > Tax > Exceptions
(Help) Oracle Receivables > Tax > Implementing US Sales Tax > Setup Steps
for US Sales Tax
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Enabling Calculation of Sales Tax on Freight
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Enabling Calculation of Sales Tax on
Freight

Enabling Calculation of Sales Tax on
Freight

• Create freight amounts as regular invoice lines.
• Use an inventory item to define freight services

and enable AutoAccounting to distinguish
between freight and regular line items.

• Create freight amounts as regular invoice lines.
• Use an inventory item to define freight services

and enable AutoAccounting to distinguish
between freight and regular line items.

(Help) Oracle Receivables > Tax > Implementing US Sales Tax > Setup Steps
for US Sales Tax
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Defining Tax Profile Options

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Defining Tax Profile OptionsDefining Tax Profile Options

• Tax: Allow Manual Tax Lines
• Tax: Allow Ad Hoc Tax Changes
• Tax: Allow Override of Customer Exemptions
• Tax: Allow Override of Tax Code
• Tax: Calculate Tax on Credit Memos
• Tax: Invoice Freight as Revenue (if also

implementing Oracle Order Management)

• Tax: Allow Manual Tax Lines
• Tax: Allow Ad Hoc Tax Changes
• Tax: Allow Override of Customer Exemptions
• Tax: Allow Override of Tax Code
• Tax: Calculate Tax on Credit Memos
• Tax: Invoice Freight as Revenue (if also

implementing Oracle Order Management)

Use the System Profile Values window in the System
Administrator responsibility to set tax profile options:

(N) Profile > System
(Help) Oracle Receivables > Tax > Implementing US Sales Tax > Setup Steps
for US Sales Tax
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Creating International Customers and Sites
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Creating International Customers and
Sites

Creating International Customers and
Sites

1.  Define a zero-rate tax code called International.
2.  Assign this tax code to every customer or

customer site that has an address outside of the
US.

1.  Define a zero-rate tax code called International.
2.  Assign this tax code to every customer or

customer site that has an address outside of the
US.

(Help) Oracle Receivables > Tax > Implementing US Sales Tax > Setup Steps
for US Sales Tax
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Review Question
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Review QuestionReview Question

1.  True
2.  False
1.  True
2.  False

You can assign the International tax code at the
customer level only if every site for that customer is
outside of the US.
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Answer to Review QuestionAnswer to Review Question

1.  True
2.  False
1.  True
2.  False

You can assign the International tax code at the
customer level only if every site for that customer is
outside of the US.



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Implementing US Sales and Use Taxes
Chapter 27 - Page 24

(Optional) Entering Tax Authorities
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(Optional) Entering Tax Authorities(Optional) Entering Tax Authorities

Authorities are:
• Unique combinations of locations used to expedite

the calculation of sales tax
• Automatically created when customer addresses

are entered
• Created only for the home country specified in the

Country field of the System Options window

Authorities are:
• Unique combinations of locations used to expedite

the calculation of sales tax
• Automatically created when customer addresses

are entered
• Created only for the home country specified in the

Country field of the System Options window
If locations already exist, you can manually enter
authorities in the Tax Authority window.
Use the Review Sales Tax Rates window to review
sales tax rates assigned to each authority.

(Help) Oracle Receivables > Tax > Calculating Tax > Calculating Tax
(Help) Oracle Receivables > Tax > Setting Up > Tax Authorities
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(Optional) Implementing Tax Partners
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(Optional) Implementing Tax Partners(Optional) Implementing Tax Partners

• Integration links to third-party tax calculation
programs.

• Oracle Receivables checks for third-party tax
calculation programs and data before calculating
taxes.

• If a tax calculation program is installed, tax
information stored in Oracle Receivables tax
tables passes to the tax partner.

• The tax partner returns tax rate and tax amount for
every invoice line.

• AutoAccounting then generates account
distribution tax lines based on the tax information
that the tax partner returned.

• Integration links to third-party tax calculation
programs.

• Oracle Receivables checks for third-party tax
calculation programs and data before calculating
taxes.

• If a tax calculation program is installed, tax
information stored in Oracle Receivables tax
tables passes to the tax partner.

• The tax partner returns tax rate and tax amount for
every invoice line.

• AutoAccounting then generates account
distribution tax lines based on the tax information
that the tax partner returned.

(Help) Oracle Receivables > Tax > Tax Vendor Extension
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Oracle Order Management Tax Overview
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Oracle Order Management Tax OverviewOracle Order Management Tax Overview

• Quotes estimated tax for orders at the time of
order entry

• US Sales tax calculation based on customer ship-
to address

• Uses setup in Oracle Receivables

• Quotes estimated tax for orders at the time of
order entry

• US Sales tax calculation based on customer ship-
to address

• Uses setup in Oracle Receivables

(Help) Oracle Order Management> Setting Up > Taxation
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Defining Profile Options
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Defining Profile OptionsDefining Profile Options

Use the System Profile Values window in the System
Administrator responsibility to set tax profile options:

Profile Option

Tax: Invoice
Freight as
Revenue

Tax: Inventory
Item for
Freight

Reason

Enables freight amounts entered in
Oracle Order Management to be
passed to Oracle Receivables as
taxable line items.

Lets Oracle Order Management
identify an inventory item on a
transaction line imported into
Oracle Receivables via the
Receivables Interface program.

Setting

Yes

Freight
(Inventory
Item)

(N) Profile > System
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Other Products
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Other ProductsOther Products

• Certain CRM products use Oracle Order Capture to
call the Tax Engine and interface into Oracle Order
Management.

• AutoInvoice involves other products, for example,
when importing information from Oracle Order
Management or Oracle Projects to create invoices.

• Certain CRM products use Oracle Order Capture to
call the Tax Engine and interface into Oracle Order
Management.

• AutoInvoice involves other products, for example,
when importing information from Oracle Order
Management or Oracle Projects to create invoices.
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Review Question
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Review QuestionReview Question

1.  Payables
2.  Order Management
3.  General Ledger
4.  Receivables
5.  None of the above (separate setup steps are

needed)

1.  Payables
2.  Order Management
3.  General Ledger
4.  Receivables
5.  None of the above (separate setup steps are

needed)

Products such as Oracle Projects and Oracle Order
Capture use the tax setup from Oracle                     .
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Answer to Review Question
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Answer to Review QuestionAnswer to Review Question

1.  Payables
2.  Order Management
3.  General Ledger
4.  Receivables
5.  None of the above; separate setup steps are needed

1.  Payables
2.  Order Management
3.  General Ledger
4.  Receivables
5.  None of the above; separate setup steps are needed

Products such as Oracle Projects and Oracle Order
Capture use the tax setup from Oracle Receivables.
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AgendaAgenda

• Describing US Sales and Use taxes
• Setting up Oracle Receivables and Oracle Order

Management for US Sales tax
• Setting up Oracle Payables and Oracle Purchasing

for US Sales and Use taxes

• Describing US Sales and Use taxes
• Setting up Oracle Receivables and Oracle Order

Management for US Sales tax
• Setting up Oracle Payables and Oracle Purchasing

for US Sales and Use taxes
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Oracle Payables Tax Overview
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Oracle Payables Tax OverviewOracle Payables Tax Overview

Tax Code

Tax Type Tax Rate
PayablesPayables
InvoiceInvoiceOptions, Controls,Options, Controls,

and Defaultsand Defaults
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Oracle Payables Tax Overview
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Oracle Payables Tax OverviewOracle Payables Tax Overview

• The tax code determines the tax rate, which
determines the tax amount for the item.

• If you use Automatic Tax Calculation, Oracle
Payables can create tax invoice distributions
based on the tax codes that you enter.

• The tax code determines the tax rate, which
determines the tax amount for the item.

• If you use Automatic Tax Calculation, Oracle
Payables can create tax invoice distributions
based on the tax codes that you enter.
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Tax Recovery
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Tax RecoveryTax Recovery

US Sales and Use taxes are 100% nonrecoverable.
Nonrecoverable tax is included in:
• Project cost
• Asset cost
• Cost of goods if using Periodic Costing

US Sales and Use taxes are 100% nonrecoverable.
Nonrecoverable tax is included in:
• Project cost
• Asset cost
• Cost of goods if using Periodic Costing

(Help) Oracle Payables > Invoices > Taxes on Invoices > Recoverable Tax >
Setting Up Payables for Recoverable Tax
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Tax CodesTax Codes

For each Sales or Use tax code, you can enter:
• Tax type
• Tax rate
• Effective dates
• Recovery rate (0%)

For each Sales or Use tax code, you can enter:
• Tax type
• Tax rate
• Effective dates
• Recovery rate (0%)

Use the Tax Codes window to define the tax codes
that you use to record tax information in Payables
documents.

(N) Setup > Tax > Codes
(Help) Oracle Payables > Setup > Tax Codes > Tax Codes
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Setting Up for Use Tax
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Setting Up for Use TaxSetting Up for Use Tax

You can set up one of these methods for Use tax:You can set up one of these methods for Use tax:

Invoice
Item       $1000
Use Tax     $85
Total      $1000

$85$85

Use Tax Code 8.5%Use Tax Code 8.5%
100%100% Nonrecoverable Nonrecoverable

Use Tax Liability Use Tax Liability 
ReportReport

Sales Tax Code 8.5%Sales Tax Code 8.5%
100%100% Nonrecoverable Nonrecoverable  
Offset Tax Code -8.5%Offset Tax Code -8.5%

100% Recoverable100% Recoverable

Invoice
Item   $1000
Sales Tax    $85
Offset Tax  -$85
Total   $1000

$1085$1085

Asset / ExpenseAsset / Expense
AccountAccount
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Practice with SolutionPractice with Solution

Define a Sales tax code with 7.5 % tax rate, effective
from January 1 of the current year to December 31 of
next year.

(N) Setup > Tax > Codes

Practice Solution
1. Navigate to the Tax Codes window.
2. Enter a tax code in the Tax Code field.
3. Select Sales from the list of values in the Tax Type field.
4. Enter 7.5 in the Tax Rate field.
5. Enter 01/01/<current year> in the Effective From field.
6. Enter 12/31/<next year> in the Effective To field.
6. Navigate to the Other region.
7. Enter a tax code description in the Description field.
8. Save your work.
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Tax Financials Options
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Tax Financials OptionsTax Financials Options

• Default tax code
• Tax recovery

– Default recovery rate
– Define cash basis encumbrance

• Calculation rules
– Define rounding rule
– Define precision
– Define minimum accountable unit

• Default tax code
• Tax recovery

– Default recovery rate
– Define cash basis encumbrance

• Calculation rules
– Define rounding rule
– Define precision
– Define minimum accountable unit

(N) Setup > Options > Financials > (T) Tax
(Help) Oracle Payables > Setup > Financials Options > Financials Options
Window Reference > Tax Financials Options
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Defaulting Tax
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Defaulting TaxDefaulting Tax

• Which sources Payables documents use to default
tax codes

• The order in which Oracle Payables searches the
sources to find a valid tax code value

• Which sources Payables documents use to default
tax codes

• The order in which Oracle Payables searches the
sources to find a valid tax code value

Use the Tax Defaults and Rules region of the
Payables Options window to define:

(N) Setup > Options > Payables > (T) Tax Defaults and Rates
(Help) Oracle Payables > Invoices > Taxes on Invoices > Defaulting Tax in
Payables
(Help) Oracle Payables > Setup > Payables Options > Payables Options
Window Reference > Tax Defaults and Rules Payables Options
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Automatic Tax Calculation OverviewAutomatic Tax Calculation Overview

Calculation levels:
• Header
• Line
• Tax Code

Calculation levels:
• Header
• Line
• Tax Code

Automatic Tax Calculation automatically calculates
invoice sales tax and creates tax distributions.

(Help) Oracle Payables > Other Topics > Automatic Tax Calculation >
Automatic Tax Calculation Overview
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Setting Up Options for Automatic Tax Calculation
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Setting Up Options for Automatic Tax
Calculation

Setting Up Options for Automatic Tax
Calculation

• Payables Options window
– Enable Automatic Tax Calculation
– Select calculation level
– Select optional controls

• Financials Options window
– Default tax code
– Define rounding rule

• Payables Options window
– Enable Automatic Tax Calculation
– Select calculation level
– Select optional controls

• Financials Options window
– Default tax code
– Define rounding rule

(Help) Oracle Payables > Setup > Payables Options > Payables Options
Window Reference > Invoice Tax Payables Options
(Help) Oracle Payables > Setup > Financials Options > Financials Options
Window Reference > Tax Financials Options
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Setting Up Suppliers and Supplier Sites for Automatic
Tax Calculation
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Setting Up Suppliers and Supplier Sites
for Automatic Tax Calculation

Setting Up Suppliers and Supplier Sites
for Automatic Tax Calculation

SupplierSupplier Supplier SitesSupplier Sites InvoiceInvoice

• Calculation Level
• Allow Calculation Level Override
• Rounding Rule
• Distribution Amounts Include Tax

• Calculation Level
• Allow Calculation Level Override
• Rounding Rule
• Distribution Amounts Include Tax

Payables andPayables and
Financials OptionsFinancials Options

(Help) Oracle Payables > Suppliers > Suppliers and Supplier Sites Window
Reference > Suppliers and Supplier Sites Header Field Reference > Invoice
Tax Region
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DemonstrationDemonstration

This demonstration covers how to:
• Set up options for Automatic Tax Calculation
• Set up suppliers and supplier sites for Automatic

Tax Calculation

(N) Setup > Options > Payables > (T) Invoice Tax
(N) Setup > Options > Financials > (T) Tax
(N) Suppliers > Entry
(N) Suppliers > Entry > (B) Sites

This demonstration covers how to:
• Set up options for Automatic Tax Calculation
• Set up suppliers and supplier sites for Automatic

Tax Calculation

(N) Setup > Options > Payables > (T) Invoice Tax
(N) Setup > Options > Financials > (T) Tax
(N) Suppliers > Entry
(N) Suppliers > Entry > (B) Sites
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Oracle Purchasing Tax Overview
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Oracle Purchasing Tax OverviewOracle Purchasing Tax Overview

• The tax code with an associated tax rate in Oracle
Payables determines the tax amount for the item.

• Tax information defaults into Purchasing
documents when a tax code is entered or
defaulted.
– Associate a tax code with each item, supplier,

or supplier site.

• The tax code with an associated tax rate in Oracle
Payables determines the tax amount for the item.

• Tax information defaults into Purchasing
documents when a tax code is entered or
defaulted.
– Associate a tax code with each item, supplier,

or supplier site.
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Defaulting Tax

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Defaulting TaxDefaulting Tax

Use the Purchasing Options window to define:
• Which sources Purchasing documents use to

default tax codes
• The order that Oracle Purchasing searches the

sources in to find a valid tax code value

Use the Purchasing Options window to define:
• Which sources Purchasing documents use to

default tax codes
• The order that Oracle Purchasing searches the

sources in to find a valid tax code value

(Help) Oracle Purchasing > Setting Up > Purchasing Options > Defining Tax
Default Options
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Copyright  Oracle Corporation, 2000. All rights reserved.
®

SummarySummary

In this module, you should have learned how to:
• Describe US Sales and Use taxes
• Set up Oracle Payables and Oracle Purchasing for

US Sales and Use taxes
• Set up Oracle Receivables and Oracle Order

Management for US Sales tax

In this module, you should have learned how to:
• Describe US Sales and Use taxes
• Set up Oracle Payables and Oracle Purchasing for

US Sales and Use taxes
• Set up Oracle Receivables and Oracle Order

Management for US Sales tax
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R11i Implementing Global
Taxes (Order to Cash)
Chapter 28
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Implementing Global Taxes (Order to Cash)
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Implementing Global Taxes (Order to
Cash)

Implementing Global Taxes (Order to
Cash)

Release 11iRelease 11i
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ObjectivesObjectives

After this module, you should be able to:
• Describe global taxes and the way Oracle Order

Management and Oracle Receivables support
them

• Implement global taxes in Oracle Order
Management and Oracle Receivables

• Set up tax accounting

After this module, you should be able to:
• Describe global taxes and the way Oracle Order

Management and Oracle Receivables support
them

• Implement global taxes in Oracle Order
Management and Oracle Receivables

• Set up tax accounting
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Agenda
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AgendaAgenda

• Describing global taxes and the way Oracle Order
Management and Oracle Receivables support
them

• Implementing global taxes in Oracle Order
Management and Oracle Receivables

• Setting up tax accounting

• Describing global taxes and the way Oracle Order
Management and Oracle Receivables support
them

• Implementing global taxes in Oracle Order
Management and Oracle Receivables

• Setting up tax accounting
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Global Taxes Overview
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Global Taxes OverviewGlobal Taxes Overview

• Value Added Tax (VAT) - Imposed on the value
added to goods or services at each stage of their
supply

• Goods and Services Tax (GST) - Sales tax levied
on many consumer products and professional
services

• Value Added Tax (VAT) - Imposed on the value
added to goods or services at each stage of their
supply

• Goods and Services Tax (GST) - Sales tax levied
on many consumer products and professional
services

Tax regimes around the world differ in their
requirements. For example:
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Tax/VAT Overview
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Tax/VAT OverviewTax/VAT Overview

Input TaxInput Tax Output TaxOutput Tax

Tax paid out onTax paid out on
supplier invoicessupplier invoices

Tax collected onTax collected on
customer invoicescustomer invoices

Amount Due to Tax Authority = Output Tax -
Recoverable Input Tax

(Help) Oracle Receivables > Tax > Implementing Value Added Tax
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Oracle Order Management Global Taxes Overview
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Oracle Order Management Global Taxes
Overview

Oracle Order Management Global Taxes
Overview

Sales Order with TaxSales Order with Tax
EstimateEstimate

Options, Controls,Options, Controls,
and Defaultsand Defaults

ItemsItems CustomersCustomers SitesSites
Tax Code

Tax Group

(Help) Oracle Order Management > Setting Up > Taxation



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Implementing Global Taxes (Order to Cash)
Chapter 28 - Page 8

Oracle Receivables Global Taxes Overview
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Oracle Receivables Global Taxes
Overview

Oracle Receivables Global Taxes
Overview

Options, Controls,Options, Controls,
and Defaultsand Defaults

ItemsItems CustomersCustomers SitesSites

Transaction withTransaction with
Tax DistributionsTax Distributions

RevenueRevenue
AccountAccount

Tax Code

Tax Group

(Help) Oracle Receivables > Tax > Calculating Tax
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Review QuestionReview Question

1.  True
2.  False
1.  True
2.  False

If you use the Oracle Applications Multiple
Organization Support feature, you need to implement
global taxes for each operating unit.
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Answer to Review Question
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Answer to Review QuestionAnswer to Review Question

1.  True
2.  False
1.  True
2.  False

If you use the Oracle Applications Multiple
Organization Support feature, you need to implement
global taxes for each operating unit.
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Agenda
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AgendaAgenda

• Describing global taxes and the way Oracle Order
Management and Oracle Receivables support them

• Implementing global taxes in Oracle Order
Management and Oracle Receivables

• Setting up tax accounting

• Describing global taxes and the way Oracle Order
Management and Oracle Receivables support them

• Implementing global taxes in Oracle Order
Management and Oracle Receivables

• Setting up tax accounting
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Setup Steps
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Setup StepsSetup Steps

1.   Choose a tax method
2.   Define tax codes and

rates
3.   Set up inclusive and

exclusive tax (optional)
4.   Set up tax groups

(optional)
5.   Set up Account Method

(optional)
6.   Set up Item Method
7.   Choose a Sales Tax

Location Flexfield
Structure

1.   Choose a tax method
2.   Define tax codes and

rates
3.   Set up inclusive and

exclusive tax (optional)
4.   Set up tax groups

(optional)
5.   Set up Account Method

(optional)
6.   Set up Item Method
7.   Choose a Sales Tax

Location Flexfield
Structure

8.   Define tax preferences,
defaults, and rules

9.   Define tax exemptions
10. Define transaction types
11. Define AutoAccounting

for tax
12. Enable calculation of tax

on freight
13. Define tax profile

options

8.   Define tax preferences,
defaults, and rules

9.   Define tax exemptions
10. Define transaction types
11. Define AutoAccounting

for tax
12. Enable calculation of tax

on freight
13. Define tax profile

options
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Choosing Tax Method - Item Method
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Choosing Tax Method - Item MethodChoosing Tax Method - Item Method

• Derives tax code from combination of inventory
item and ship-to country

• Can be used for multiple, conditional,
compounded taxes

• Supports integration between Oracle Receivables
and:
– Oracle Order Management
– Oracle Order Capture
– Legacy systems

• Derives tax code from combination of inventory
item and ship-to country

• Can be used for multiple, conditional,
compounded taxes

• Supports integration between Oracle Receivables
and:
– Oracle Order Management
– Oracle Order Capture
– Legacy systems

With the Item Method, the tax code is derived using
rules associated with line item and destination (point
of supply). The Item Method:

(Help) Oracle Receivables > Tax > Implementing Value Added Tax > Setup
Steps for Value Added Tax
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Choosing Tax Method - Account Method
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Choosing Tax Method - Account MethodChoosing Tax Method - Account Method

Use the Account Method if your chart of accounts is
constructed around tax compliance.
With the Account Method:
• One or more revenue accounts are assigned to a

tax code
• Tax is recorded on the tax account assigned to the

revenue account
• Tax code for invoice distributions can be validated

against tax code assigned to revenue account

• One or more revenue accounts are assigned to a
tax code

• Tax is recorded on the tax account assigned to the
revenue account

• Tax code for invoice distributions can be validated
against tax code assigned to revenue account

(Help) Oracle Receivables > Tax > Implementing Value Added Tax > Setup
Steps for Value Added Tax
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Defining Tax Codes and Rates
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Defining Tax Codes and RatesDefining Tax Codes and Rates

For each tax code, you can enter:
• Tax type
• Tax rate
• Taxable basis
• Effective dates
• Tax controls
• Tax accounting information

For each tax code, you can enter:
• Tax type
• Tax rate
• Taxable basis
• Effective dates
• Tax controls
• Tax accounting information

Use the Tax Codes and Rates window to define the
tax codes that you will use to record tax information
in Order Management and Receivables documents.

(N) Setup > Tax > Codes
(Help) Oracle Receivables > Tax > Implementing Value Added Tax > Setup
Steps for Value Added Tax
(Help) Oracle Receivables > Tax > Setting Up > Tax Codes and Rates
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Setting Up Inclusive and Exclusive Tax
(Optional)

Setting Up Inclusive and Exclusive Tax
(Optional)

• Inclusive tax - Line amount for an item includes
the tax for the item

• Exclusive tax - Tax not included in the line amount
for the item

• Check Inclusive Tax checkbox in Tax Codes and
Rates window for inclusive tax codes

• Check Allow Inclusive Override checkbox if you
want to allow changing tax code from inclusive to
exclusive (or vice versa) when entering invoices

• Inclusive tax - Line amount for an item includes
the tax for the item

• Exclusive tax - Tax not included in the line amount
for the item

• Check Inclusive Tax checkbox in Tax Codes and
Rates window for inclusive tax codes

• Check Allow Inclusive Override checkbox if you
want to allow changing tax code from inclusive to
exclusive (or vice versa) when entering invoices

(N) Setup > Tax > Codes > (T) Control
(Help) Oracle Receivables > Tax > Calculating Tax > Tax Inclusive
(Help) Oracle Receivables > Tax > Setting Up > Tax Codes and Rates
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Setting Up Tax Groups (Optional)
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Setting Up Tax Groups (Optional)Setting Up Tax Groups (Optional)

• Tax on cross-border transactions
• iStore and CRM applications
You can use tax groups to calculate:
• Multiple taxes
• Compound taxes

• Tax on cross-border transactions
• iStore and CRM applications
You can use tax groups to calculate:
• Multiple taxes
• Compound taxes

Use the Tax Groups window to group tax codes into
tax groups. Tax groups provide complex rules and
defaults for selecting single tax codes in Oracle Order
Management and Oracle Receivables.
In particular, tax groups also support:

(Help) Oracle Receivables > Tax > Setting Up > Tax Groups
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Tax Groups Overview
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Tax Groups OverviewTax Groups Overview

Tax Code

Tax Code

Tax Code

Tax Group

Default sources:Default sources:
System Options,System Options,
Bill-To Customer,Bill-To Customer,
Ship-ToShip-To
Customer Site,Customer Site,
Item, Memo LineItem, Memo Line

Order orOrder or
Invoice LineInvoice Line

Enter Order orEnter Order or
Invoice with TaxInvoice with Tax

GroupGroup

Tax Codes

Tax Rates

AccountingAccounting

(Help) Oracle Receivables > Tax > Setting Up > Tax Groups
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Multiple Taxes
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Multiple TaxesMultiple Taxes

Use tax groups to calculate:
• Multiple taxes for a transaction (line)
• Compound taxes for a transaction

– Assign a precedence number to each tax code
in the Compounding Precedence field

– The highest precedence number calculates tax
on all tax lines with a lower precedence
number (except when the taxable basis is prior
tax)

– Tax groups can also contain multiple
independent branches of compounded tax

Use tax groups to calculate:
• Multiple taxes for a transaction (line)
• Compound taxes for a transaction

– Assign a precedence number to each tax code
in the Compounding Precedence field

– The highest precedence number calculates tax
on all tax lines with a lower precedence
number (except when the taxable basis is prior
tax)

– Tax groups can also contain multiple
independent branches of compounded tax

(N) Setup > Tax > Groups
(Help) Oracle Receivables > Tax > Setting Up > Tax Groups
(Help) Oracle Receivables > Tax > Calculating Tax > Compounding Tax
Codes in a Tax Group
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Compound Tax Example
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Compound Tax ExampleCompound Tax Example

Line Number

1

2

Tax Amount

7.00

10.70

17.70

Tax Rate

7%

10%

Total:

Precedence
Number

1

2

Tax Code

GST

PST

Line Amount = 100Line Amount = 100
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Review Question
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Review QuestionReview Question

1.  You get an error message when you try to enter a
transaction with the tax group

2.  The tax codes with duplicated numbers both
calculate tax based on the amount compounded
by the tax code with the preceding number

3.  Only the first tax code with the duplicated
precedence number is used

1.  You get an error message when you try to enter a
transaction with the tax group

2.  The tax codes with duplicated numbers both
calculate tax based on the amount compounded
by the tax code with the preceding number

3.  Only the first tax code with the duplicated
precedence number is used

If a tax group contains tax codes with the same
precedence number:
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Answer to Review Question
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Answer to Review QuestionAnswer to Review Question

1.  You get an error message when you try to enter a
transaction with the tax group

2.  The tax codes with duplicated numbers both
calculate tax based on the amount compounded
by the tax code with the preceding number

3.  Only the first tax code with the duplicated precedence
number is used

1.  You get an error message when you try to enter a
transaction with the tax group

2.  The tax codes with duplicated numbers both
calculate tax based on the amount compounded
by the tax code with the preceding number

3.  Only the first tax code with the duplicated precedence
number is used

If a tax group contains tax codes with the same
precedence number:
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Defining Condition Sets
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Defining Condition SetsDefining Condition Sets

• Use condition sets to specify one or more
conditions for each tax code

• Optionally define actions for each condition set
• Example: If ship-to country is Canada and ship-to

province is Ontario, use this tax code

• Use condition sets to specify one or more
conditions for each tax code

• Optionally define actions for each condition set
• Example: If ship-to country is Canada and ship-to

province is Ontario, use this tax code

(N) Setup > Tax > Groups > (B) Conditions > (T) Lines > (T) Actions
(Help) Oracle Payables > Setup > Tax Groups
(Help) Oracle Receivables > Tax > Implementing Value Added Tax > Setup
Steps for Value Added Tax
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Setting Up Tax Groups for Distance Sales
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Setting Up Tax Groups for Distance SalesSetting Up Tax Groups for Distance Sales

• Use tax groups to calculate tax based on inventory
item and ship-to country

• Assign tax group to inventory items
• Use condition sets for each tax code in the tax

group, such as: If ship-to country is Argentina, use
this (Argentina) tax code

• Use tax groups to calculate tax based on inventory
item and ship-to country

• Assign tax group to inventory items
• Use condition sets for each tax code in the tax

group, such as: If ship-to country is Argentina, use
this (Argentina) tax code

(N) Setup > Tax > Groups > (B) Conditions > (T) Lines > (T) Actions
(Help) Oracle Receivables > Tax > Implementing Value Added Tax > Setup
Steps for Value Added Tax
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Defining Group Constraints
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Defining Group ConstraintsDefining Group Constraints

• Use group constraints to ensure that specific
conditions are met before using a particular tax
group

• Example: If ship-to province is not found, display
system error message

• Use group constraints to ensure that specific
conditions are met before using a particular tax
group

• Example: If ship-to province is not found, display
system error message

(N) Setup > Tax > Groups > (B) Group Constraints > (T) Lines > (T) Actions
(Help) Oracle Payables > Setup > Tax Groups
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Demonstration
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DemonstrationDemonstration

This demonstration covers how to define a tax group:
• With compound tax branches
• With condition sets

(N) Setup > Tax > Groups > (B) Conditions > (T) Lines
> (T) Actions

This demonstration covers how to define a tax group:
• With compound tax branches
• With condition sets

(N) Setup > Tax > Groups > (B) Conditions > (T) Lines
> (T) Actions
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Setting Up Account Method (Optional)
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Setting Up Account Method (Optional)Setting Up Account Method (Optional)

To set up the Account Method:
1.  In General Ledger Tax Options window, assign a

tax code to the natural account segment of your
revenue account.

2.  Set up validation by deriving tax code from
revenue account (Optional).
– In System Options window, check Enforce Tax

from Revenue Account and Revenue Accounts
checkboxes and set Revenue Accounts tax
code defaulting hierarchy to 1.

– In Tax Options window, make sure Allow Tax
Code Override checkbox is not checked for
accounts that you want to validate.

To set up the Account Method:
1.  In General Ledger Tax Options window, assign a

tax code to the natural account segment of your
revenue account.

2.  Set up validation by deriving tax code from
revenue account (Optional).
– In System Options window, check Enforce Tax

from Revenue Account and Revenue Accounts
checkboxes and set Revenue Accounts tax
code defaulting hierarchy to 1.

– In Tax Options window, make sure Allow Tax
Code Override checkbox is not checked for
accounts that you want to validate.

(N) Oracle General Ledger: Setup > Tax > Tax Options > (T) Account Level
(N) Oracle Receivables: Setup > System > System Options > (T) Tax Defaults
and Rules
(Help) Oracle Receivables > Tax > Implementing Value Added Tax > Setup
Steps for Value Added Tax
(Help) Oracle Receivables > Tax > Calculating Tax > Controlling Tax from
your Revenue Account
(Help) Oracle General Ledger > Setting Up General Ledger > Setting Up
Automatic Tax Calculation > Setting Up Automatic Tax Calculation



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Implementing Global Taxes (Order to Cash)
Chapter 28 - Page 28

Setting Up Item Method
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Setting Up Item MethodSetting Up Item Method

Use the Tax Code field in the Invoicing region of the
Master Item window to assign tax codes or tax groups
to inventory items.

(N) Setup > Transactions > Items > Define Items > (T) Invoicing
(Help) Oracle Receivables > Tax > Implementing Value Added Tax > Setup
Steps for Value Added Tax
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Choosing a Sales Tax Location Flexfield Structure
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Choosing a Sales Tax Location Flexfield
Structure

Choosing a Sales Tax Location Flexfield
Structure

• Sales Tax Location Flexfield Structure determines
tax rates

• Use the Location Flexfield Structure field in the
Tax region of the System Options window

• Suggested settings
– Most countries: No Validation - Country
– Countries with provincial taxes: Province

• Sales Tax Location Flexfield Structure determines
tax rates

• Use the Location Flexfield Structure field in the
Tax region of the System Options window

• Suggested settings
– Most countries: No Validation - Country
– Countries with provincial taxes: Province

(N) Setup > System > System Options > (T) Tax
(Help) Oracle Receivables > Tax > Implementing Value Added Tax > Setup
Steps for Value Added Tax
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Defining Tax Preferences, Defaults, and Rules
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Defining Tax Preferences, Defaults, and
Rules

Defining Tax Preferences, Defaults, and
Rules

• Use the Tax region of the System Options window
to define tax preferences

• Use the Tax Defaults and Rules region of the
System Options window to set up tax defaults and
rules
– Recommended settings for tax code defaults

depend on tax control method (Item or
Account)

– Item tax rate exceptions are not used when the
Tax Method preference is VAT

• Save system options

• Use the Tax region of the System Options window
to define tax preferences

• Use the Tax Defaults and Rules region of the
System Options window to set up tax defaults and
rules
– Recommended settings for tax code defaults

depend on tax control method (Item or
Account)

– Item tax rate exceptions are not used when the
Tax Method preference is VAT

• Save system options

(N) Setup > System > System Options > (T) Tax > (T) Tax Defaults and Rules
(Help) Oracle Receivables > Tax > Implementing Value Added Tax > Setup
Steps for Value Added Tax



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Implementing Global Taxes (Order to Cash)
Chapter 28 - Page 31

Review Question

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Review QuestionReview Question

1.  Compound Taxes
2.  Inclusive Tax Used
3.  Allow Override
4.  Enforce Tax from Revenue Account
5.  Use Item Exemptions

1.  Compound Taxes
2.  Inclusive Tax Used
3.  Allow Override
4.  Enforce Tax from Revenue Account
5.  Use Item Exemptions

If you are using both the Item and Account Method, it
is recommended that the                            checkbox is
not checked.
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Answer to Review Question
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Answer to Review QuestionAnswer to Review Question

1.  Compound Taxes
2.  Inclusive Tax Used
3.  Allow Override
4.  Enforce Tax from Revenue Account
5.  Use Item Exemptions

1.  Compound Taxes
2.  Inclusive Tax Used
3.  Allow Override
4.  Enforce Tax from Revenue Account
5.  Use Item Exemptions

If you are using both the Item and Account Method, it
is recommended that the Enforce Tax from Revenue
Account checkbox is not checked.
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Defining Tax Exemptions
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Defining Tax ExemptionsDefining Tax Exemptions

To define tax exemptions:
1.  Create exempt tax codes, such as Exempt VAT, for

exemptions.
2.  For customer exemptions, assign tax code to

customers at either the customer or site level.
3.  For product exemptions, assign tax code to

products in the Master Item window.

To define tax exemptions:
1.  Create exempt tax codes, such as Exempt VAT, for

exemptions.
2.  For customer exemptions, assign tax code to

customers at either the customer or site level.
3.  For product exemptions, assign tax code to

products in the Master Item window.

(N) Setup > Tax > Codes
(N) Customers > Standard > (T) Classification
(N) Customers > Standard > (T) Addresses > (B) Open > (T) Business
Purposes > (B) Open
(N) Setup > Transactions > Items > Define Items > (T) Invoicing
(Help) Oracle Receivables > Tax > Implementing Value Added Tax > Setup
Steps for Value Added Tax
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Demonstration
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DemonstrationDemonstration

This demonstration covers how to:
• Define an exempt tax code
• Assign the exempt tax code to a customer site

(N) Setup > Tax > Codes
(N) Customers > Standard > (T) Addresses > (B) Open

> (T) Business Purposes > (B) Open

This demonstration covers how to:
• Define an exempt tax code
• Assign the exempt tax code to a customer site

(N) Setup > Tax > Codes
(N) Customers > Standard > (T) Addresses > (B) Open

> (T) Business Purposes > (B) Open
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Defining Transaction Types
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Defining Transaction TypesDefining Transaction Types

• Check the Tax Calculation checkbox in the
Transaction Types window for each transaction
type to ensure calculation of tax for all invoices

• Customers and customer sites not subject to tax
should also be assigned an exempt tax code

• Check the Tax Calculation checkbox in the
Transaction Types window for each transaction
type to ensure calculation of tax for all invoices

• Customers and customer sites not subject to tax
should also be assigned an exempt tax code

(N) Oracle Receivables: Setup > Transactions > Transaction Types
(N) Oracle Order Management: Setup > Transaction Types > Define
(Help) Oracle Receivables > Tax > Implementing Value Added Tax > Setup
Steps for Value Added Tax
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Defining AutoAccounting for Tax
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Defining AutoAccounting for TaxDefining AutoAccounting for Tax

1.  Enter Tax in the Type field.
2.  Query all the segments of your Tax Account

Flexfield.
3.  For each segment, assign the value that you want

to use to derive the account.

1.  Enter Tax in the Type field.
2.  Query all the segments of your Tax Account

Flexfield.
3.  For each segment, assign the value that you want

to use to derive the account.

Use the AutoAccounting window to specify how
Oracle Receivables determines the General Ledger
account for tax.

(N) Setup > Transactions > AutoAccounting
(Help) Oracle Receivables > Tax > Implementing Value Added Tax > Setup
Steps for Value Added Tax
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Enabling Calculation of Tax on Freight
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Enabling Calculation of Tax on FreightEnabling Calculation of Tax on Freight

• Create freight amounts as regular invoice lines
• Use an inventory item to define freight services

and enable AutoAccounting to distinguish
between freight and regular line items

• Create freight amounts as regular invoice lines
• Use an inventory item to define freight services

and enable AutoAccounting to distinguish
between freight and regular line items

(Help) Oracle Receivables > Tax > Implementing Value Added Tax > Setup
Steps for Value Added Tax
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Defining Tax Profile Options
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Defining Tax Profile OptionsDefining Tax Profile Options

• Tax: Allow Manual Tax Lines
• Tax: Allow Ad Hoc Tax Changes
• Tax: Allow Override of Customer Exemptions
• Tax: Allow Override of Tax Code
• Tax: Invoice Freight as Revenue (Oracle Order

Management only)
• Tax: Inventory Item for Freight

• Tax: Allow Manual Tax Lines
• Tax: Allow Ad Hoc Tax Changes
• Tax: Allow Override of Customer Exemptions
• Tax: Allow Override of Tax Code
• Tax: Invoice Freight as Revenue (Oracle Order

Management only)
• Tax: Inventory Item for Freight

Use the System Profile Values window in the System
Administrator responsibility to set tax profile options:

(N) Profile > System
(Help) Oracle Receivables > Tax > Implementing Value Added Tax > Setup
Steps for Value Added Tax
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Agenda
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AgendaAgenda

• Describing global taxes and the way Oracle Order
Management and Oracle Receivables support them

• Implementing global taxes in Oracle Order
Management and Oracle Receivables

• Setting up tax accounting

• Describing global taxes and the way Oracle Order
Management and Oracle Receivables support them

• Implementing global taxes in Oracle Order
Management and Oracle Receivables

• Setting up tax accounting
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Tax Accounting Overview
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Tax Accounting OverviewTax Accounting Overview

To set up for tax accounting, define:
• Tax accounting information for tax codes
• Accounting rules for Receivables Activities
You can set up tax accounting for:
• Deferred tax
• Miscellaneous transactions
• Discounts
• Adjustments
• Finance charges

To set up for tax accounting, define:
• Tax accounting information for tax codes
• Accounting rules for Receivables Activities
You can set up tax accounting for:
• Deferred tax
• Miscellaneous transactions
• Discounts
• Adjustments
• Finance charges

(Help) Oracle Receivables > Tax > Tax Accounting
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Setting Up Tax Accounting for Deferred Tax
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Setting Up Tax Accounting for Deferred
Tax

Setting Up Tax Accounting for Deferred
Tax

Deferred tax is an accounting method that defers the
liability of tax to the time that the cash is collected,
rather than when the invoice is created.
1.  Define deferred tax codes in the Tax Codes and

Rates window.
2.  Check the Deferred checkbox in the Tax

Accounting window.
3.  Enter accounts in the Tax Account and Interim Tax

Account fields of the Tax Accounting window.

1.  Define deferred tax codes in the Tax Codes and
Rates window.

2.  Check the Deferred checkbox in the Tax
Accounting window.

3.  Enter accounts in the Tax Account and Interim Tax
Account fields of the Tax Accounting window.

(N) Setup > Tax > Codes > (B) Tax Accounting
(Help) Oracle Receivables > Tax > Tax Accounting > Deferred Tax
Accounting
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Defining Receivables Activities
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Defining Receivables ActivitiesDefining Receivables Activities

1.  Define the GL account and tax code sources.
2.  Check the Recoverable or Non-Recoverable

checkbox if the tax code source is Invoice.
3.  Enter a tax code if the tax code source is Activity.

Use the Receivables Activities window to define
Receivables Activities.

(N) Setup > Receipts > Receivable Activities
(Help) Oracle Receivables > Setting Up > Receivables Activities
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Setting Up Tax Accounting for Miscellaneous
Transactions
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Setting Up Tax Accounting for
Miscellaneous Transactions

Setting Up Tax Accounting for
Miscellaneous Transactions

Miscellaneous transactions are receipts and
payments that are not related to a specific invoice.
1.  Define output and input tax codes in the Tax

Codes and Rates window.
2.  Define Receivables Activities of type

Miscellaneous Cash in the Receivables Activities
window.
– GL Account Source
– Tax Code Source (Activity only)
– Asset Tax Code
– Liability Tax Code

1.  Define output and input tax codes in the Tax
Codes and Rates window.

2.  Define Receivables Activities of type
Miscellaneous Cash in the Receivables Activities
window.
– GL Account Source
– Tax Code Source (Activity only)
– Asset Tax Code
– Liability Tax Code

(N) Setup > Tax > Codes > (T) Control
(N) Setup > Receipts > Receivable Activities
(Help) Oracle Receivables > Tax > Tax Accounting > Tax Accounting for
Miscellaneous Transactions
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Setting Up Tax Accounting for Discounts

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Setting Up Tax Accounting for DiscountsSetting Up Tax Accounting for Discounts

Account for the tax included whenever you apply a
receipt that has an earned or unearned discount.
1.  Define tax, expense/revenue, and nonrecoverable

accounts in the Tax Accounting window.
2.  Define accounting rules in the Receivables

Activities window to account for earned and
unearned discounts.

3.  Assign earned and unearned discount Receivables
Activities to bank accounts and payment methods.
– Bank Accounts window
– Remittance Banks window

1.  Define tax, expense/revenue, and nonrecoverable
accounts in the Tax Accounting window.

2.  Define accounting rules in the Receivables
Activities window to account for earned and
unearned discounts.

3.  Assign earned and unearned discount Receivables
Activities to bank accounts and payment methods.
– Bank Accounts window
– Remittance Banks window

(N) Setup > Tax > Codes > (B) Tax Accounting
(N) Setup > Receipts > Receivable Activities
(N) Setup > Receipts > Banks > (B) Bank Accounts > (T) More Receivables
Options
(N) Setup > Receipts > Receipt Classes > (B) Bank Accounts > (T) GL
Discounts
(Help) Oracle Receivables > Tax > Tax Accounting > Tax Accounting for
Discounts
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Setting Up Tax Accounting for Adjustments and
Finance Charges
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Setting Up Tax Accounting for
Adjustments and Finance Charges

Setting Up Tax Accounting for
Adjustments and Finance Charges

1.  Define expense/revenue and nonrecoverable tax
accounts in the Tax Accounting window.

2.  Define accounting rules in the Receivables
Activities window to account for adjustments or
finance charges.

1.  Define expense/revenue and nonrecoverable tax
accounts in the Tax Accounting window.

2.  Define accounting rules in the Receivables
Activities window to account for adjustments or
finance charges.

Account for expense, revenue, and tax amounts
generated whenever you create adjustments or
calculate finance charges on outstanding customer
balances.

(N) Setup > Tax > Codes > (B) Tax Accounting
(N) Setup > Receipts > Receivable Activities
(Help) Oracle Receivables > Tax > Tax Accounting > Tax Accounting for
Adjustments and Finance Charges
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Specifying Default Receivables Activity for Finance
Charges (Optional)
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Specifying Default Receivables Activity
for Finance Charges (Optional)

Specifying Default Receivables Activity
for Finance Charges (Optional)

• Define default Receivables Activities for finance
charges in:
– Charges Activity field in Business Purpose

window
– Finance Charge Activity field in System

Options window
• Receivables Activity default hierarchy:

– Customer ship-to site
– Customer bill-to site
– System options

• Define default Receivables Activities for finance
charges in:
– Charges Activity field in Business Purpose

window
– Finance Charge Activity field in System

Options window
• Receivables Activity default hierarchy:

– Customer ship-to site
– Customer bill-to site
– System options

(N) Customers > Standard > (T) Addresses > (B) Open > (T) Business
Purposes > (B) Open > (T) Details
(N) Setup > System > System Options > (T) Accounting
(Help) Oracle Receivables > Tax > Tax Accounting > Tax Accounting for
Adjustments and Finance Charges



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Implementing Global Taxes (Order to Cash)
Chapter 28 - Page 47

Demonstration
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DemonstrationDemonstration

This demonstration covers how to define a
Receivables Activity for adjustments.

(N) Setup >Receipts > Receivable Activities
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Summary
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SummarySummary

In this module, you should have learned how to:
• Describe global taxes and the way Oracle Order

Management and Oracle Receivables support
them

• Implement global taxes in Oracle Order
Management and Oracle Receivables

• Set up tax accounting

In this module, you should have learned how to:
• Describe global taxes and the way Oracle Order

Management and Oracle Receivables support
them

• Implement global taxes in Oracle Order
Management and Oracle Receivables

• Set up tax accounting
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R11i Processing Global
Taxes
Chapter 29
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Processing Global Taxes
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Processing Global TaxesProcessing Global Taxes

Release 11iRelease 11i
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ObjectivesObjectives

After this module, you should be able to:
• Describe global taxes
• Process global taxes in Oracle Purchasing
• Process global taxes in Oracle Payables
• Process global taxes in Oracle Order Management
• Process global taxes in Oracle Receivables

After this module, you should be able to:
• Describe global taxes
• Process global taxes in Oracle Purchasing
• Process global taxes in Oracle Payables
• Process global taxes in Oracle Order Management
• Process global taxes in Oracle Receivables
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Agenda
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AgendaAgenda

• Describing global taxes
• Processing global taxes in Oracle Purchasing
• Processing global taxes in Oracle Payables
• Processing global taxes in Oracle Order Management
• Processing global taxes in Oracle Receivables

• Describing global taxes
• Processing global taxes in Oracle Purchasing
• Processing global taxes in Oracle Payables
• Processing global taxes in Oracle Order Management
• Processing global taxes in Oracle Receivables
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Global Taxes Overview
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Global Taxes OverviewGlobal Taxes Overview

• Value Added Tax (VAT) - Imposed on the value
added to goods or services at each stage of their
supply

• Goods and Services Tax (GST) - Sales tax levied
on many consumer products and professional
services

• Value Added Tax (VAT) - Imposed on the value
added to goods or services at each stage of their
supply

• Goods and Services Tax (GST) - Sales tax levied
on many consumer products and professional
services

Tax regimes around the world differ in their
requirements. For example:
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Tax/VAT Overview
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Tax/VAT OverviewTax/VAT Overview

Input TaxInput Tax Output TaxOutput Tax

Tax paid out onTax paid out on
supplier invoicessupplier invoices

Tax collected onTax collected on
customer invoicescustomer invoices

Amount Due to Tax Authority = Output Tax -
Recoverable Input Tax

 (Help) Oracle Receivables > Tax > Implementing Value Added Tax
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Tax Codes Overview
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Tax Codes OverviewTax Codes Overview

• Tax type
• Tax rate
• Effective dates
• Recovery rate or recovery rule
• Tax accounting information

• Tax type
• Tax rate
• Effective dates
• Recovery rate or recovery rule
• Tax accounting information

Tax codes carry tax information to documents,
including:

(Help) Oracle Payables > Setup > Tax Codes > Tax Codes
(Help) Oracle Receivables > Tax > Setting Up > Tax Codes and Rates
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Tax Recovery
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Tax RecoveryTax Recovery

• Global input taxes can be:
– Recoverable
– Partially recoverable
– Nonrecoverable

• Recovery rate is the percentage of tax that you can
reclaim for credit

• Tax recovery rate or rule is assigned to tax code
• Oracle Payables creates separate distributions for

recoverable and nonrecoverable portions of tax

• Global input taxes can be:
– Recoverable
– Partially recoverable
– Nonrecoverable

• Recovery rate is the percentage of tax that you can
reclaim for credit

• Tax recovery rate or rule is assigned to tax code
• Oracle Payables creates separate distributions for

recoverable and nonrecoverable portions of tax

(Help) Oracle Payables > Invoices > Taxes on Invoices > Recoverable Tax >
Setting Up Payables for Recoverable Tax
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Tax Groups OverviewTax Groups Overview

Tax Code

Tax Code

Tax Code

Tax Group

Defaulting SourcesDefaulting Sources

DistributionDistribution
LineLine

Enter DocumentEnter Document
with Tax Groupwith Tax Group

Tax Codes

Tax Rates

AccountingAccounting

(Help) Oracle Payables > Setup > Tax Groups
(Help) Oracle Receivables > Tax > Setting Up > Tax Groups
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AgendaAgenda

• Describing global taxes
• Processing global taxes in Oracle Purchasing
• Processing global taxes in Oracle Payables
• Processing global taxes in Oracle Order Management
• Processing global taxes in Oracle Receivables

• Describing global taxes
• Processing global taxes in Oracle Purchasing
• Processing global taxes in Oracle Payables
• Processing global taxes in Oracle Order Management
• Processing global taxes in Oracle Receivables
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Oracle Purchasing Global Taxes
Overview

Oracle Purchasing Global Taxes
Overview

Tax Code

Tax Rate Recovery Rate
PurchasePurchase

Order,Order,
BlanketBlanket
Release,Release,

RequisitionRequisition

Options, Controls,Options, Controls,
and Defaultsand Defaults

Tax Group

(Help) Oracle Purchasing > Purchase Orders > Tax Defaults in Purchasing
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Entering Tax Information for Purchase
Orders

Entering Tax Information for Purchase
Orders

1.  Enter purchase order header and line information
in the Purchase Orders window.

2.  Enter shipment information in the Shipments
window.
– Taxable check box is checked if a tax code/tax

group is associated with the item
– Accept or override the tax code/tax group

default in the Tax Code field
3.  Accept or override the recovery rate defaulted

from the tax code in the Distributions window.

1.  Enter purchase order header and line information
in the Purchase Orders window.

2.  Enter shipment information in the Shipments
window.
– Taxable check box is checked if a tax code/tax

group is associated with the item
– Accept or override the tax code/tax group

default in the Tax Code field
3.  Accept or override the recovery rate defaulted

from the tax code in the Distributions window.

(N) Purchase Orders > Purchase Orders > (B) Shipments > (B) Distributions
(Help) Oracle Purchasing > Purchase Orders > Creating Purchase Orders >
Entering Headers
(Help) Oracle Purchasing > Purchase Orders > Creating Purchase Orders >
Entering Lines
(Help) Oracle Purchasing > Purchase Orders > Creating Purchase Orders >
Entering Shipments
(Help) Oracle Purchasing > Purchase Orders > Creating Purchase Orders >
Entering Distributions
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Entering Tax Information for ReleasesEntering Tax Information for Releases

1.  Enter release header information in the Releases
window.

2.  Enter shipment information in Shipments region;
accept or override tax code/tax group default in
the Tax Code field. The tax code/tax group defaults
in this order from the:
– Setup in the Purchase Order Preferences

window
– Planned purchase order shipment
– Setup in the Purchasing Options window

3.  Accept or override the recovery rate defaulted
from the tax code in the Distributions window.

1.  Enter release header information in the Releases
window.

2.  Enter shipment information in Shipments region;
accept or override tax code/tax group default in
the Tax Code field. The tax code/tax group defaults
in this order from the:
– Setup in the Purchase Order Preferences

window
– Planned purchase order shipment
– Setup in the Purchasing Options window

3.  Accept or override the recovery rate defaulted
from the tax code in the Distributions window.

(N) Purchase Orders > Releases > (T) Shipments > (B) Distributions
(Help) Oracle Purchasing > Purchase Orders > Creating Releases > Entering
Release Headers
(Help) Oracle Purchasing > Purchase Orders > Creating Releases > Entering
Release Shipments
(Help) Oracle Purchasing > Purchase Orders > Creating Releases > Entering
Release Distributions
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Entering Tax Information for RequisitionsEntering Tax Information for Requisitions

1.  Enter requisition header information in the
Requisitions window.

2.  In the Items region, accept or override tax code/tax
group default in the Tax Code field.

3.  Accept or override the recovery rate defaulted
from the tax code in the Distributions window.

1.  Enter requisition header information in the
Requisitions window.

2.  In the Items region, accept or override tax code/tax
group default in the Tax Code field.

3.  Accept or override the recovery rate defaulted
from the tax code in the Distributions window.

(N) Requisitions > Requisitions > (T) Items > (B) Distributions
(Help) Oracle Purchasing > Requisitions > Entering Requisition Headers
(Help) Oracle Purchasing > Requisitions > Entering Requisition Lines
(Help) Oracle Purchasing > Requisitions > Entering Requisition
Distributions
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Viewing Tax informationViewing Tax information

For purchase orders, releases, and requisitions, use:
• The Tax Code Summary window to view tax lines

totaled and grouped by tax code
• The Tax Details window to view all tax information

for each line, shipment, and distribution

For purchase orders, releases, and requisitions, use:
• The Tax Code Summary window to view tax lines

totaled and grouped by tax code
• The Tax Details window to view all tax information

for each line, shipment, and distribution
These windows are only for viewing, not changing,
tax information which includes recovery rates and
recoverable amounts.

(N) Purchase Orders > Purchase Orders > (M) Tools > Tax Code Summary
(N) Purchase Orders > Purchase Orders > (M) Tools > Tax Details
(N) Purchase Orders > Releases > (M) Tools > Tax Code Summary
(N) Purchase Orders > Releases > (M) Tools > Tax Details
(N) Requisitions > Requisitions > (M) Tools > Tax Code Summary
(N) Requisitions > Requisitions > (M) Tools > Tax Details
(Help) Oracle Purchasing > Purchase Orders > Viewing Tax Code Summary
Information
(Help) Oracle Purchasing > Purchase Orders > Viewing Tax Details
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Practice with SolutionPractice with Solution

Query a purchase order and view its tax information
using the Tax Code Summary and Tax Details
windows.

(N) Purchase Orders > Purchase Orders > (M) Tools >
Tax Code Summary
(N) Purchase Orders > Purchase Orders > (M) Tools >
Tax Details

Practice Solution
1. Navigate to the Purchase Orders window.
2. From the View menu, query the purchase order that the instructor

specifies.
3. From the Tools menu, select Tax Code Summary.
4. From the Tools menu, select Tax Details.
5. View the tax information in both windows.
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AgendaAgenda

• Describing global taxes
• Processing global taxes in Oracle Purchasing
• Processing global taxes in Oracle Payables
• Processing global taxes in Oracle Order Management
• Processing global taxes in Oracle Receivables

• Describing global taxes
• Processing global taxes in Oracle Purchasing
• Processing global taxes in Oracle Payables
• Processing global taxes in Oracle Order Management
• Processing global taxes in Oracle Receivables
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Oracle Payables Global Taxes OverviewOracle Payables Global Taxes Overview

Tax Code

Tax Rate Recovery Rate
SupplierSupplier

SiteSite

Enter InvoiceEnter Invoice
Invoice with TaxInvoice with Tax

DistributionsDistributions

AccountAccount
MethodMethod

ItemItem
MethodMethod

Tax Group

(Help) Oracle Payables > Invoices > Taxes on Invoices > Entering Taxes on
Invoices
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Oracle Payables Tax Defaulting OverviewOracle Payables Tax Defaulting Overview

Financials OptionsFinancials Options SupplierSupplier Supplier SiteSupplier Site

InvoiceInvoice
HeaderHeader AccountAccount PurchasePurchase

OrderOrder TemplateTemplate

DistributionsDistributions

(Help) Oracle Payables > Invoices > Taxes on Invoices > Defaulting Tax in
Payables
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Entering Invoices with Tax GroupsEntering Invoices with Tax Groups

• Use tax groups to calculate multiple taxes on
single taxable items

• You can assign the same tax group to multiple
taxable items on an invoice, but use only one tax
group within a single invoice

• You can use tax groups to apply multiple tax
recovery rules per taxable invoice item

• Use tax groups to calculate multiple taxes on
single taxable items

• You can assign the same tax group to multiple
taxable items on an invoice, but use only one tax
group within a single invoice

• You can use tax groups to apply multiple tax
recovery rules per taxable invoice item

(Help) Oracle Payables > Setup > Tax Groups



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Processing Global Taxes
Chapter 29 - Page 21

Manually Entering Tax Distributions in the Invoice
Workbench

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Manually Entering Tax Distributions in
the Invoice Workbench

Manually Entering Tax Distributions in
the Invoice Workbench

You can enter tax manually at either the header or the
distribution level.
• For header level, accept or change the default tax

code on the invoice header and manually enter the
tax amount.  Oracle Payables creates a single tax
distribution.
– Ensure that the corresponding Item, Freight, or

Miscellaneous distributions have the
corresponding tax code.

• For distribution level, accept or change the default
tax code(s)/tax group on the distribution(s).
Manually enter one or more tax distributions with
the corresponding tax code(s).

• For header level, accept or change the default tax
code on the invoice header and manually enter the
tax amount.  Oracle Payables creates a single tax
distribution.
– Ensure that the corresponding Item, Freight, or

Miscellaneous distributions have the
corresponding tax code.

• For distribution level, accept or change the default
tax code(s)/tax group on the distribution(s).
Manually enter one or more tax distributions with
the corresponding tax code(s).

(N) Invoices > Entry > Invoices > (B) Distributions
(Help) Oracle Payables > Invoices > Taxes on Invoices > Entering Tax
Distributions in the Invoice Workbench
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Automatic Tax Calculation OverviewAutomatic Tax Calculation Overview

Calculation levels:
• Header
• Line
• Tax Code

Calculation levels:
• Header
• Line
• Tax Code

Automatic Tax Calculation automatically calculates
invoice tax and creates tax distributions.

(Help) Oracle Payables > Other Topics > Automatic Tax Calculation >
Automatic Tax Calculation Overview
(Help) Oracle Payables > Invoices > Taxes on Invoices > Automatic Tax
Calculation > Using the Automatic Tax Calculation Feature
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Using Automatic Tax Calculation - Header
Level

Using Automatic Tax Calculation - Header
Level

1.  Enter invoice header information in the Invoices
window.

2.  Enter Header in the Tax Calculation field if the
Allow Override check box is checked at the
supplier site.

3.  Accept or change the tax code default; Oracle
Payables calculates the tax amount.

4.  Automatically or manually enter distributions;
Oracle Payables creates a tax type distribution
based on the tax code and amount in the Invoices
window.

1.  Enter invoice header information in the Invoices
window.

2.  Enter Header in the Tax Calculation field if the
Allow Override check box is checked at the
supplier site.

3.  Accept or change the tax code default; Oracle
Payables calculates the tax amount.

4.  Automatically or manually enter distributions;
Oracle Payables creates a tax type distribution
based on the tax code and amount in the Invoices
window.

(N) Invoices > Entry > Invoices > (B) Distributions
(Help) Oracle Payables > Invoices > Taxes on Invoices > Automatic Tax
Calculation > Invoice Header Level Automatic Tax Calculation
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Level
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Using Automatic Tax Calculation - Line
and Tax Code Level

Using Automatic Tax Calculation - Line
and Tax Code Level

1.  Enter invoice header information in the Invoices
window.

2.  Enter Line or Tax Code in the Tax Calculation field
if the Allow Override check box is checked at the
supplier site.

4.  Enter non-tax distributions either manually, by
matching to a PO, or with a distribution set.

5.  Enter, accept, or override the tax code/tax group.
6.  Check the Includes Tax check box for each non-

tax distribution with inclusive tax.
7.  Press the Calculate Tax button to create tax

distributions.

1.  Enter invoice header information in the Invoices
window.

2.  Enter Line or Tax Code in the Tax Calculation field
if the Allow Override check box is checked at the
supplier site.

4.  Enter non-tax distributions either manually, by
matching to a PO, or with a distribution set.

5.  Enter, accept, or override the tax code/tax group.
6.  Check the Includes Tax check box for each non-

tax distribution with inclusive tax.
7.  Press the Calculate Tax button to create tax

distributions.

(N) Invoices > Entry > Invoices > (B) Distributions
(Help) Oracle Payables > Invoices > Taxes on Invoices > Automatic Tax
Calculation > Line and Tax Code Automatic Tax Calculation
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Previewing Tax CalculationPreviewing Tax Calculation

Use the Tax Summary window to preview the
projected tax calculation for an invoice before you
create tax distributions.
You can change the total tax amount and press the
OK button to create tax distributions.

(N) Invoices > Entry > Invoices > (B) Distributions > (M) Tools > View and
Update Tax Summary
(Help) Oracle Payables > Invoices > Taxes on Invoices > Tax Summary



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Processing Global Taxes
Chapter 29 - Page 26

Demonstration

Copyright  Oracle Corporation, 2000. All rights reserved.
®

DemonstrationDemonstration

This demonstration covers how to:
• Create tax distributions by entering an invoice

using Automatic Tax Calculation
• Enter an invoice using a tax group with multiple

recovery rates
• Preview projected tax calculation

(N) Invoices > Entry > (B) Distributions > (M) Tools >
View and Update Tax Summary

This demonstration covers how to:
• Create tax distributions by entering an invoice

using Automatic Tax Calculation
• Enter an invoice using a tax group with multiple

recovery rates
• Preview projected tax calculation

(N) Invoices > Entry > (B) Distributions > (M) Tools >
View and Update Tax Summary
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Offset Taxes OverviewOffset Taxes Overview

• Negative rate reduces tax liability
• Records VAT name and amount for reporting

purposes without paying VAT to supplier

• Negative rate reduces tax liability
• Records VAT name and amount for reporting

purposes without paying VAT to supplier

$85$85

ReportsReports

Invoice
Item     1000
VAT               50
Offset Tax  - 50
Total     1000

PaymentPayment

VAT  5%VAT  5%
5050

10001000

OffsetOffset
Tax 5%Tax 5%

-50-50

(Help) Oracle Payables > Invoices > Taxes on Invoices > Offset Taxes > EU
VAT Taxes
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Manually Entering Offset Taxes
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Manually Entering Offset TaxesManually Entering Offset Taxes

1.  Enter invoice header information in the Invoices
window. Make sure that Tax Calculation is set to
None at the invoice level.

2.  Enter a tax code for each taxable distribution.
3.  Enter a positive tax distribution with a VAT code.
4.  Enter a negative tax distribution with an Offset tax

code.

1.  Enter invoice header information in the Invoices
window. Make sure that Tax Calculation is set to
None at the invoice level.

2.  Enter a tax code for each taxable distribution.
3.  Enter a positive tax distribution with a VAT code.
4.  Enter a negative tax distribution with an Offset tax

code.

(N) Invoices > Entry > Invoices > (B) Distributions
(Help) Oracle Payables > Invoices > Taxes on Invoices > Offset Taxes > EU
VAT Taxes
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Automatically Entering Offset TaxesAutomatically Entering Offset Taxes

1.  Enter the invoice header information in the
Invoices window. Make sure that Tax Calculation
is at Line or Tax Code level.

2.  Enter non-tax distributions either manually, by
matching to a purchase order, or with a
distribution set.

3.  Enter a tax code for each taxable distribution.
4.  Press the Calculate Tax button to create both the

positive and negative (offsetting) tax distributions.

1.  Enter the invoice header information in the
Invoices window. Make sure that Tax Calculation
is at Line or Tax Code level.

2.  Enter non-tax distributions either manually, by
matching to a purchase order, or with a
distribution set.

3.  Enter a tax code for each taxable distribution.
4.  Press the Calculate Tax button to create both the

positive and negative (offsetting) tax distributions.

(N) Invoices > Entry > Invoices > (B) Distributions
(Help) Oracle Payables > Invoices > Taxes on Invoices > Offset Taxes > EU
VAT Taxes
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Recording Taxes on Expense ReportsRecording Taxes on Expense Reports

• Tax code/tax group for expense reports default
from Payables Options hierarchy

• Automatic Tax Calculation can process lines with
inclusive tax for expense items at the Line or Tax
Code level in the Expense Reports window
– Check the Includes Tax check box to create

item and tax invoice distributions
• Use the Merchant Information and Receipt

Information regions to enter information for
reclaiming tax paid on expense reports

• Tax code/tax group for expense reports default
from Payables Options hierarchy

• Automatic Tax Calculation can process lines with
inclusive tax for expense items at the Line or Tax
Code level in the Expense Reports window
– Check the Includes Tax check box to create

item and tax invoice distributions
• Use the Merchant Information and Receipt

Information regions to enter information for
reclaiming tax paid on expense reports

(N) Invoices > Entry > Expense Reports > (T) Accounting > (T) Merchant
Information
(Help) Oracle Payables > Invoices > Taxes on Invoices > Entering Taxes on
Expense Reports
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Review QuestionReview Question

1.  Inclusive and exclusive tax at the Header level
2.  Exclusive tax at the Line or Tax Code level
3.  Inclusive tax at the Line or Tax Code level
4.  Inclusive and exclusive tax at the Line or Tax Code

level
5.  Inclusive tax at all levels

1.  Inclusive and exclusive tax at the Header level
2.  Exclusive tax at the Line or Tax Code level
3.  Inclusive tax at the Line or Tax Code level
4.  Inclusive and exclusive tax at the Line or Tax Code

level
5.  Inclusive tax at all levels

For expense reports, Automatic Tax Calculation can
process tax for:



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Processing Global Taxes
Chapter 29 - Page 32

Answer to Review Question

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Answer to Review QuestionAnswer to Review Question

1.  Inclusive and exclusive tax at the Header level
2.  Exclusive tax at the Line or Tax Code level
3.  Inclusive tax at the Line or Tax Code level
4.  Inclusive and exclusive tax at the Line or Tax Code

level
5.  Inclusive tax at all levels

1.  Inclusive and exclusive tax at the Header level
2.  Exclusive tax at the Line or Tax Code level
3.  Inclusive tax at the Line or Tax Code level
4.  Inclusive and exclusive tax at the Line or Tax Code

level
5.  Inclusive tax at all levels

For expense reports, Automatic Tax Calculation can
process tax for:
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AgendaAgenda

• Describing global taxes
• Processing global taxes in Oracle Purchasing
• Processing global taxes in Oracle Payables
• Processing global taxes in Oracle Order

Management
• Processing global taxes in Oracle Receivables

• Describing global taxes
• Processing global taxes in Oracle Purchasing
• Processing global taxes in Oracle Payables
• Processing global taxes in Oracle Order

Management
• Processing global taxes in Oracle Receivables
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Oracle Order Management Global Taxes
Overview

Oracle Order Management Global Taxes
Overview

Sales Order with TaxSales Order with Tax
EstimateEstimate

Options, Controls,Options, Controls,
and Defaultsand Defaults

ItemsItems CustomersCustomers SitesSites
Tax Code

Tax Group

(Help) Oracle Order Management > Setting Up > Taxation
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Entering and Viewing Tax Information for
Sales Orders

Entering and Viewing Tax Information for
Sales Orders

1.  Enter sales order header information in the Sales
Orders window.

2.  Enter sales order line items information.
3.  Accept tax code/tax group default or enter a tax

code/tax group in the Tax Code field of the Main
region.

4.  View tax information in the Tax Details window and
the total tax estimate for the order in the Sales
Orders header region.

1.  Enter sales order header information in the Sales
Orders window.

2.  Enter sales order line items information.
3.  Accept tax code/tax group default or enter a tax

code/tax group in the Tax Code field of the Main
region.

4.  View tax information in the Tax Details window and
the total tax estimate for the order in the Sales
Orders header region.

The tax amounts calculated by the tax codes are
estimates only; the actual tax in Oracle Receivables
customer invoices may differ.

(N) Orders, Returns > Sales Orders > (T) Line Items > (B) Actions > View
Tax Details
(Help) Oracle Order Management > Orders > Sales Orders > Defining Sales
Order Main and Other Header Information
(Help) Oracle Order Management > Orders > Sales Orders > Defining Sales
Order Line Items Main Information
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DemonstrationDemonstration

This demonstration covers how to:
• Enter a sales order with tax information
• View tax estimates and details

(N) Orders, Returns > Sales Orders > (T) Line Items >
(B) Actions > View Tax Details

This demonstration covers how to:
• Enter a sales order with tax information
• View tax estimates and details

(N) Orders, Returns > Sales Orders > (T) Line Items >
(B) Actions > View Tax Details
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AgendaAgenda

• Describing global taxes
• Processing global taxes in Oracle Purchasing
• Processing global taxes in Oracle Payables
• Processing global taxes in Oracle Order Management
• Processing global taxes in Oracle Receivables

• Describing global taxes
• Processing global taxes in Oracle Purchasing
• Processing global taxes in Oracle Payables
• Processing global taxes in Oracle Order Management
• Processing global taxes in Oracle Receivables
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Oracle Receivables Global Taxes
Overview

Oracle Receivables Global Taxes
Overview

Options, Controls,Options, Controls,
and Defaultsand Defaults

ItemsItems CustomersCustomers SitesSites

Transaction withTransaction with
Tax DistributionsTax Distributions

RevenueRevenue
AccountAccount

Tax Code

Tax Group

(Help) Oracle Receivables > Tax >  Calculating Tax
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Entering and Viewing Tax Information for
Transactions

Entering and Viewing Tax Information for
Transactions

To enter and view tax information for transactions:
1.  Enter basic invoice information in the

Transactions window.
2.  Accept or change the tax code/tax group default

for the transaction or for line items in the Tax
window; Oracle Receivables calculates the tax rate
and amount.
– Use a deferred tax code for deferred tax

3.  If you enter an ad hoc tax code, you can enter or
change the tax rate.

4.  View the tax distribution lines in the Accounting
window.

To enter and view tax information for transactions:
1.  Enter basic invoice information in the

Transactions window.
2.  Accept or change the tax code/tax group default

for the transaction or for line items in the Tax
window; Oracle Receivables calculates the tax rate
and amount.
– Use a deferred tax code for deferred tax

3.  If you enter an ad hoc tax code, you can enter or
change the tax rate.

4.  View the tax distribution lines in the Accounting
window.

(N) Transactions > Transactions > (B) Tax > (B) Distributions
(N) Transactions > Transactions > (B) Line Items > (B) Tax > (B)
Distributions
(Help) Oracle Receivables > Transactions > Entering Transactions
(Help) Oracle Receivables > Transactions > Entering Tax Information
(Help) Oracle Receivables > Transactions > Reviewing Accounting
Information
(Help) Oracle Receivables > Tax > Tax Accounting > Deferred Tax
Accounting
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Calculating Multiple and Compound
Taxes

Calculating Multiple and Compound
Taxes

Use appropriate tax groups to enter transactions with
multiple or compound taxes.
In compound tax groups, the precedence numbers
control the compounding process.

(Help) Oracle Receivables > Tax > Setting Up > Tax Groups
(Help) Oracle Receivables > Tax > Calculating Tax > Compounding Tax
Codes in a Tax Group
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Example of Multiple Tax LinesExample of Multiple Tax Lines

Tax Line
Number

1

2

Tax Amount

7.00

10.00

17.00

Tax Rate

7%

10%

Total:

Precedence
Number

1

1

Tax Code

GST

PST

Invoice Line = 100Invoice Line = 100
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Example of Compound Tax LinesExample of Compound Tax Lines

Tax Line
Number

1

2

Tax Amount

7.00

10.70

17.70

Tax Rate

7%

10%

Total:

Precedence
Number

1

2

Tax Code

GST

PST

Line Amount = 100Line Amount = 100
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DemonstrationDemonstration

This demonstration covers how to:
• Enter a transaction using a tax group for

compounding tax
• View tax distribution lines

(N) Transactions > Transactions > (B) Line Items > (B)
Tax > (B) Distributions

This demonstration covers how to:
• Enter a transaction using a tax group for

compounding tax
• View tax distribution lines

(N) Transactions > Transactions > (B) Line Items > (B)
Tax > (B) Distributions
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Entering and Updating Tax in Credit Memos
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Entering and Updating Tax in Credit
Memos

Entering and Updating Tax in Credit
Memos

1.  Query or enter a credit memo in the Credit
Transactions window.

2.  Enter tax information:
– Credit Transactions window, Transaction

Amounts region - Amount or percentage of tax
to credit (restrictions exist if tax rounding is at
header level)

– Credit Lines window - A quantity for each line
3.  Accept or adjust the calculated tax amount for the

credit memo tax lines in the Tax window.

1.  Query or enter a credit memo in the Credit
Transactions window.

2.  Enter tax information:
– Credit Transactions window, Transaction

Amounts region - Amount or percentage of tax
to credit (restrictions exist if tax rounding is at
header level)

– Credit Lines window - A quantity for each line
3.  Accept or adjust the calculated tax amount for the

credit memo tax lines in the Tax window.

(N) Transactions > Credit Transactions > (B) Credit Lines > (B) Tax
(Help) Oracle Receivables > Transactions > Credit Memos > Reviewing Tax
Information
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Tax in Other Receivables DocumentsTax in Other Receivables Documents

• The Receivables Activity that you enter determines
the tax accounting for:
– Finance charges
– Adjustments
– Discounts
– Miscellaneous cash transactions

• The tax code/tax group defaults from the
Receivables Activity and can only be overriden for
miscellaneous cash transactions

• The Receivables Activity that you enter determines
the tax accounting for:
– Finance charges
– Adjustments
– Discounts
– Miscellaneous cash transactions

• The tax code/tax group defaults from the
Receivables Activity and can only be overriden for
miscellaneous cash transactions

(Help) Oracle Receivables > Setting Up > Receivables Activities
(Help) Oracle Receivables > Tax > Tax Accounting > Tax Accounting for
Adjustments and Finance Charges
(Help) Oracle Receivables > Tax > Tax Accounting > Tax Accounting for
Discounts
(Help) Oracle Receivables > Tax > Tax Accounting > Tax Accounting for
Miscellaneous Transactions
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Entering Tax Information for Miscellaneous
Transactions

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Entering Tax Information for
Miscellaneous Transactions
Entering Tax Information for
Miscellaneous Transactions

1.  Enter transaction information in the Receipts
window with Misc receipt type.

2.  Enter a Receivables Activity in the Activity field
with Miscellaneous Cash type. The Receivables
Activity determines the default tax code/tax group
and tax rate for the transaction.

3.  Accept or change the tax code/tax group in the Tax
Code field.

4.  View tax amounts and distributions in the
Distributions window.

5.  View tax accounting information in the View
Receipt Accounting window.

1.  Enter transaction information in the Receipts
window with Misc receipt type.

2.  Enter a Receivables Activity in the Activity field
with Miscellaneous Cash type. The Receivables
Activity determines the default tax code/tax group
and tax rate for the transaction.

3.  Accept or change the tax code/tax group in the Tax
Code field.

4.  View tax amounts and distributions in the
Distributions window.

5.  View tax accounting information in the View
Receipt Accounting window.

(N) Receipts > Receipts > (T) Misc Transaction > (B) Distributions
(N) Receipts > Receipts > (M) Tools > View Accounting
(Help) Oracle Receivables > Receipts > Entering Miscellaneous Transactions
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Review QuestionReview Question

1.  True
2.  False
1.  True
2.  False

The Receivables Activity determines the tax
accounting for all activity types.
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Answer to Review QuestionAnswer to Review Question

1.  True
2.  False
1.  True
2.  False

The Receivables Activity determines the tax
accounting for all activity types.
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SummarySummary

In this module, you should have learned how to:
• Describe global taxes
• Process global taxes in Oracle Purchasing
• Process global taxes in Oracle Payables
• Process global taxes in Oracle Order Management
• Process global taxes in Oracle Receivables

In this module, you should have learned how to:
• Describe global taxes
• Process global taxes in Oracle Purchasing
• Process global taxes in Oracle Payables
• Process global taxes in Oracle Order Management
• Process global taxes in Oracle Receivables
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Reporting Global Taxes
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Reporting Global TaxesReporting Global Taxes

Release 11iRelease 11i
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ObjectivesObjectives

After this module, you should be able to:
• Describe global taxes and the way Oracle

Applications support them
• Describe and submit reports for global taxes
• Use the Tax Reporting Ledger

After this module, you should be able to:
• Describe global taxes and the way Oracle

Applications support them
• Describe and submit reports for global taxes
• Use the Tax Reporting Ledger
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AgendaAgenda

• Describing global taxes and the way Oracle
Applications support them

• Describing and submitting reports for global taxes
• Using the Tax Reporting Ledger

• Describing global taxes and the way Oracle
Applications support them

• Describing and submitting reports for global taxes
• Using the Tax Reporting Ledger
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Global Taxes Overview

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Global Taxes OverviewGlobal Taxes Overview

• Value Added Tax (VAT) - Imposed on the value
added to goods or services at each stage of their
supply

• Goods and Services Tax (GST) - Sales tax levied
on many consumer products and professional
services

• Value Added Tax (VAT) - Imposed on the value
added to goods or services at each stage of their
supply

• Goods and Services Tax (GST) - Sales tax levied
on many consumer products and professional
services

Tax regimes around the world differ in their
requirements. For example:
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Tax/VAT Overview
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Tax/VAT OverviewTax/VAT Overview

Input TaxInput Tax Output TaxOutput Tax

Tax paid out onTax paid out on
supplier invoicessupplier invoices

Tax collected onTax collected on
customer invoicescustomer invoices

Amount Due to Tax Authority = Output Tax -
Recoverable Input Tax

(Help) Oracle Receivables > Tax > Implementing Value Added Tax
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Oracle Purchasing Global Taxes Overview
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Oracle Purchasing Global Taxes
Overview

Oracle Purchasing Global Taxes
Overview

Tax Code

Tax Rate Recovery Rate
PurchasePurchase

Order,Order,
BlanketBlanket
Release,Release,

RequisitionRequisition

Options, Controls,Options, Controls,
and Defaultsand Defaults

Tax Group

(Help) Oracle Purchasing > Purchase Orders > Tax Defaults in Purchasing
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Oracle Payables Global Taxes Overview

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Oracle Payables Global Taxes OverviewOracle Payables Global Taxes Overview

Tax Code

Tax Rate Recovery Rate
SupplierSupplier

SiteSite

Enter InvoiceEnter Invoice Invoice with TaxInvoice with Tax
DistributionsDistributions

AccountAccount
MethodMethod

ItemItem
MethodMethod

Tax Group

Match toMatch to
Purchase OrderPurchase Order

ReportReport

(Help) Oracle Payables > Invoices > Taxes on Invoices > Entering Taxes on
Invoices
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Oracle Order Management Global Taxes Overview
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Oracle Order Management Global Taxes
Overview

Oracle Order Management Global Taxes
Overview

Sales Order with TaxSales Order with Tax
EstimateEstimate

Options, Controls,Options, Controls,
and Defaultsand Defaults

ItemsItems CustomersCustomers SitesSites
Tax Code

Tax Group

(Help) Oracle Order Management > Setting Up > Taxation
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Oracle Receivables Global Taxes Overview
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Oracle Receivables Global Taxes
Overview

Oracle Receivables Global Taxes
Overview

ItemsItems CustomersCustomers SitesSitesRevenueRevenue
AccountAccount

Tax Code

Tax Group

Enter InvoiceEnter Invoice Invoice with TaxInvoice with Tax
DistributionsDistributions

ReportReportAutoInvoice SalesAutoInvoice Sales
Orders ImportOrders Import

(Help) Oracle Receivables > Tax > Calculating Tax
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Review QuestionReview Question

1.  True
2.  False
1.  True
2.  False

You need to report both input and output taxes to
your tax authorities.
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Answer to Review QuestionAnswer to Review Question

1.  True
2.  False
1.  True
2.  False

You need to report both input and output taxes to
your tax authorities.
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AgendaAgenda

• Describing global taxes and the way Oracle
Applications support them

• Describing and submitting reports for global taxes
• Using the Tax Reporting Ledger

• Describing global taxes and the way Oracle
Applications support them

• Describing and submitting reports for global taxes
• Using the Tax Reporting Ledger
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Overview of Reports for Global TaxesOverview of Reports for Global Taxes

• Oracle Applications reports for global taxes
provide tax information on:
– Suppliers
– Customers
– Invoices
– Tax codes and tax groups

• Some of these reports contain information that
you need to report to your tax authorities or for tax
reconciliation

• Oracle Applications reports for global taxes
provide tax information on:
– Suppliers
– Customers
– Invoices
– Tax codes and tax groups

• Some of these reports contain information that
you need to report to your tax authorities or for tax
reconciliation

(Help) Oracle Applications > Running Reports and Programs > Overview of
Reports and Programs
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Defining Report SetsDefining Report Sets

• Which reports to include
• Whether a report parameter is displayed
• What the parameter prompt text is
• What the defaults are for all parameters, displayed

or not
• Whether the parameter defaults can be changed or

not
• What order the reports run in

• Which reports to include
• Whether a report parameter is displayed
• What the parameter prompt text is
• What the defaults are for all parameters, displayed

or not
• Whether the parameter defaults can be changed or

not
• What order the reports run in

Use the Request Set, Stages, Stage Requests, and
Request Parameters windows to define report sets for
efficient and consistent reporting. You can control:

(N) System Administrator: Concurrent > Set > (B) Define Stages > (B)
Requests > (P) Parameters
(Help) Oracle Receivables > Tax > Implementing Value Added Tax > Setup
Steps for Value Added Tax
(Help) Oracle Applications > Running Reports and Programs > Submitting a
Request Set > Defining Request Sets
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Submitting Reports and Request Sets
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Submitting Reports and Request SetsSubmitting Reports and Request Sets

1.  Select the report or request set name.
2.  Enter parameter values if necessary.
3.  (Optional) Define a submission schedule.
4.  Define additional options such as:

– Default printer
– Number of copies printed
– Saving report output

1.  Select the report or request set name.
2.  Enter parameter values if necessary.
3.  (Optional) Define a submission schedule.
4.  Define additional options such as:

– Default printer
– Number of copies printed
– Saving report output

Use Standard Request Submission to submit reports
and request sets for global taxes.

(Help) Oracle Applications > Running Reports and Programs > Using
Standard Request Submission > Submitting a Request
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Review QuestionReview Question

1.  Whether a report parameter is displayed or not
2.  Whether the parameter defaults can be changed or

not
3.  The parameter prompt text
4.  The order in which the reports are run
5.  The items in a parameter’s list of values

1.  Whether a report parameter is displayed or not
2.  Whether the parameter defaults can be changed or

not
3.  The parameter prompt text
4.  The order in which the reports are run
5.  The items in a parameter’s list of values

When you define request sets, you cannot specify:
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Answer to Review QuestionAnswer to Review Question

1.  Whether a report parameter is displayed or not
2.  Whether the parameter defaults can be changed or not
3.  The parameter prompt text
4.  The order in which the reports are run
5.  The items in a parameter’s list of values

1.  Whether a report parameter is displayed or not
2.  Whether the parameter defaults can be changed or not
3.  The parameter prompt text
4.  The order in which the reports are run
5.  The items in a parameter’s list of values

When you define request sets, you cannot specify:
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Tax Audit Trail Report
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Tax Audit Trail ReportTax Audit Trail Report

• Tax amount
• Invoice amount
• Conversion rate
• Transaction amount

• Tax amount
• Invoice amount
• Conversion rate
• Transaction amount

Use the Tax Audit Trail Report in Oracle Payables to
review tax information for the invoices that you
select.
The report provides information for each tax code,
invoice currency, and functional currency, such as:

(Help) Oracle Payables > Reports and Programs > Invoice Tax Reports >
Tax Audit Trail Report
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Intra-EU VAT Audit Trail ReportIntra-EU VAT Audit Trail Report

The report includes:
• Supplier sites
• Invoice amounts
• VAT amounts
• Offset tax amounts

The report includes:
• Supplier sites
• Invoice amounts
• VAT amounts
• Offset tax amounts

Use the Intra-EU VAT Audit Trail Report in Oracle
Payables to review invoice and tax information for
your intra-EU invoices.
You do not pay VAT for these invoices but must
record and report the VAT amounts on the invoices.

(Help) Oracle Payables > Reports and Programs > Invoice Tax Reports >
Intra-EU VAT Audit Trail Report
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Customers with Invoices at 0 VAT and no VAT
Registration Number Report
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Customers with Invoices at 0 VAT and no
VAT Registration Number Report

Customers with Invoices at 0 VAT and no
VAT Registration Number Report

• Have not paid VAT
• Have not provided you a VAT registration number

to exempt them from VAT
Before you complete your VAT reconciliation:
• You may need to collect VAT on each transaction

in this report
• You must manually calculate the impact to your

VAT return

• Have not paid VAT
• Have not provided you a VAT registration number

to exempt them from VAT
Before you complete your VAT reconciliation:
• You may need to collect VAT on each transaction

in this report
• You must manually calculate the impact to your

VAT return

Use the Customers with Invoices at 0 VAT and no
VAT Registration Number Report in Oracle
Receivables to print a list of all customers within the
European Community that:

(Help) Oracle Receivables > Tax > Implementing Value Added Tax >
Customers with Invoices at 0 VAT and no VAT Registration Number
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VAT Exception ReportVAT Exception Report

Use the VAT Exception Report in Oracle Receivables
to review Receivables transactions with errors such
as having item lines with no accompanying tax lines.
Correct every transaction on this error report or
manually calculate the impact to your tax return
before completing your VAT reconciliation.

(Help) Oracle Receivables > Tax > Implementing Value Added Tax > VAT
Exception Report
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Tax Reconciliation ReportTax Reconciliation Report

• Taxable and tax amounts
• Posted and unposted taxes
• Total taxes
• General Ledger activities

• Taxable and tax amounts
• Posted and unposted taxes
• Total taxes
• General Ledger activities
You can also choose to include adjustments,
discounts, miscellaneous cash, and receipts.

Use the Tax Reconciliation Report in Oracle
Receivables to prepare the output tax portion of your
periodic tax returns and reconcile that portion to the
General Ledger.

This report includes:

(Help) Oracle Receivables > Tax > Overview of Receivables Tax Reports >
Tax Reconciliation Report
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Tax Register ReportTax Register Report

This report:
• Groups total tax amounts by tax type, tax class,

and company
• Can include tax accounting information for:

– Deferred taxes
– Adjustments
– Discounts
– Finance charges
– Miscellaneous receipts

This report:
• Groups total tax amounts by tax type, tax class,

and company
• Can include tax accounting information for:

– Deferred taxes
– Adjustments
– Discounts
– Finance charges
– Miscellaneous receipts

Use the Tax Register Report in Oracle Receivables to
review your tax liability.

(Help) Oracle Receivables > Tax > Overview of Receivables Tax Reports >
Tax Register Report
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PracticePractice

In this practice, fill in the corresponding reports.
1.  The                 Report prints the tax information that

you need to prepare the Output Tax portion of
your periodic tax returns.

2.  The                 Report provides general tax
information for the invoices that you select.

3.  The                 Report lists transactions with errors.
4.  The                 Report lets you review your tax

liability.
5.  The                 Report provides tax information for

your intra-EU invoices.

In this practice, fill in the corresponding reports.
1.  The                 Report prints the tax information that

you need to prepare the Output Tax portion of
your periodic tax returns.

2.  The                 Report provides general tax
information for the invoices that you select.

3.  The                 Report lists transactions with errors.
4.  The                 Report lets you review your tax

liability.
5.  The                 Report provides tax information for

your intra-EU invoices.
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Practice SolutionPractice Solution

In this practice, fill in the corresponding reports.
1.  The Tax Reconciliation Report prints the tax

information that you need to prepare the Output
Tax portion of your periodic tax returns.

2.  The Tax Audit Trail Report provides general tax
information for the invoices that you select.

3.  The VAT Exception Report lists transactions with
errors.

4.  The Tax Register Report lets you review your tax
liability.

5.  The Intra-EU VAT Audit Trail Report provides tax
information for your intra-EU invoices.

In this practice, fill in the corresponding reports.
1.  The Tax Reconciliation Report prints the tax

information that you need to prepare the Output
Tax portion of your periodic tax returns.

2.  The Tax Audit Trail Report provides general tax
information for the invoices that you select.

3.  The VAT Exception Report lists transactions with
errors.

4.  The Tax Register Report lets you review your tax
liability.

5.  The Intra-EU VAT Audit Trail Report provides tax
information for your intra-EU invoices.



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Reporting Global Taxes
Chapter 30 - Page 27

Demonstration

Copyright  Oracle Corporation, 2000. All rights reserved.
®

DemonstrationDemonstration

This demonstration covers how to:
• Submit a request set
• Submit a report
• View report output

This demonstration covers how to:
• Submit a request set
• Submit a report
• View report output
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Country-Specific Reports
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Country-Specific ReportsCountry-Specific Reports

Oracle Applications provides country-specific reports
to meet tax needs of individual countries in:

The AmericasThe Americas AsiaAsia EuropeEurope

(Help) Oracle Receivables > Tax > Implementing Value Added Tax >
Country Specific VAT Reporting
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AgendaAgenda

• Describing global taxes and the way Oracle
Applications support them

• Describing and submitting reports for global taxes
• Using the Tax Reporting Ledger

• Describing global taxes and the way Oracle
Applications support them

• Describing and submitting reports for global taxes
• Using the Tax Reporting Ledger
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Tax Reporting Ledger OverviewTax Reporting Ledger Overview

The Tax Reporting Ledger:
• Provides a single reporting solution for complex

global tax requirements
• Lets you summarize tax information from Oracle

Payables, Oracle Receivables, and Oracle General
Ledger

• Contains the Tax Extract which copies information
from each application and stores it in an interface
table that can be accessed for reporting

The Tax Reporting Ledger:
• Provides a single reporting solution for complex

global tax requirements
• Lets you summarize tax information from Oracle

Payables, Oracle Receivables, and Oracle General
Ledger

• Contains the Tax Extract which copies information
from each application and stores it in an interface
table that can be accessed for reporting

(Help) Oracle Receivables > Tax > Tax Reporting Ledger
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Tax Extract Overview
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Tax Extract OverviewTax Extract Overview

Oracle
ReportsRXi RX

Global Descriptive
Flexfields

General Ledger 
Tax Journals 

Receivables
Documents

Payables
Documents

Interface Table

RXi Attribute
Sets

Tax 
Extract

TaxTax
ReportReport

CallsCalls

PopulatesPopulates

FormatsFormats

(Help) Oracle Receivables > Tax > Tax Reporting Ledger
(Help) RXi Reports Administration Tool > Using Attribute Sets > RXi
Reports Administration Tool Overview
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Sources of DataSources of Data

Payables

• Standard
invoices

• Prepayments
• Credit and

debit memos
• Expense

report
invoices

Other

• General Ledger
manual journal
entries

• Global
descriptive
flexfields

Receivables

• Invoices, credit and
debit memos

• Line, tax, and invoice
adjustments

• Payment applications
for deferred tax

• Earned and unearned
discounts

• Finance charges
• Miscellaneous

receipts and
payments

• Bills receivable

(Help) Oracle Receivables > Tax > Tax Reporting Ledger
(Help) Oracle Receivables > Tax > Tax Reporting Ledger > Global
Descriptive Flexfields
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Reports, Concurrent Programs, and Register Types
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Reports, Concurrent Programs, and
Register Types

Reports, Concurrent Programs, and
Register Types

The Tax Extract can be called from several sources,
including Oracle reports and RX and RXi-enabled
concurrent programs:
• Financial Tax Register
• RX-Only: Financial Tax Register
• Publish RX Reports
Register types for the tax register reports are:
• Interim Tax Register
• Tax Register
• Non-Recoverable Tax Register

• Financial Tax Register
• RX-Only: Financial Tax Register
• Publish RX Reports
Register types for the tax register reports are:
• Interim Tax Register
• Tax Register
• Non-Recoverable Tax Register

(Help) Oracle Receivables > Tax > Tax Reporting Ledger
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Financial Tax Register
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Financial Tax RegisterFinancial Tax Register

Available attribute sets:
• DEFAULT (Tax Register) - Reporting on

Receivables and General Ledger transactions
• ATTRSET2 (Tax Register with Tax Recovery) -

Reporting on Payables transactions
• User-defined

Available attribute sets:
• DEFAULT (Tax Register) - Reporting on

Receivables and General Ledger transactions
• ATTRSET2 (Tax Register with Tax Recovery) -

Reporting on Payables transactions
• User-defined

Use the Financial Tax Register to view output from
the Tax Reporting Ledger. The Financial Tax Register
uses the RXi reporting tool to generate tax register
reports with the Tax Extract data.

Run the Financial Tax Register from Oracle Payables
or Receivables using Standard Request Submission.

(Help) Oracle Receivables > Tax > Overview of Receivables Tax Reports >
Financial Tax Register
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Multiple Organization ReportingMultiple Organization Reporting

To create reports across multiple organizations, use
the Reporting Level and Reporting Context
parameters to determine the report content.

Reporting Level

Set of Books

Legal Entity

Operating Unit

Report Content

All operating units
in the set of books

All operating units
in your legal entity

Only the operating
unit you selected

Reporting Context

Set of books defaults

Select legal entity

Select operating unit

(Help)  Oracle Receivables > Tax > Tax Reporting Ledger > Multiple
Organization Reporting
(Help) Oracle Receivables > Tax > Overview of Receivables Tax Reports >
Financial Tax Register
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Cross-Product ReportingCross-Product Reporting

• To create cross-product reports with information
from Oracle Payables, Oracle Receivables, and
Oracle General Ledger, enter ALL in the Product
parameter

• Use the Product parameter along with the
Reporting Level and Reporting Context
parameters and the MO: Top Reporting Level
profile option to control content for reports across
operating units and products

• To create cross-product reports with information
from Oracle Payables, Oracle Receivables, and
Oracle General Ledger, enter ALL in the Product
parameter

• Use the Product parameter along with the
Reporting Level and Reporting Context
parameters and the MO: Top Reporting Level
profile option to control content for reports across
operating units and products

(Help)  Oracle Receivables > Tax > Tax Reporting Ledger > Multiple
Organization Reporting
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• Use Matrix Reporting to show a single line in the
Tax Reporting Ledger for two or more tax amounts
– Supports countries with multiple taxes
– Groups up to four output taxes on a single line
– Shows both recoverable and nonrecoverable

input tax amounts on the same report line for
up to two input taxes

•  Use the Matrix Report Flag parameter

• Use Matrix Reporting to show a single line in the
Tax Reporting Ledger for two or more tax amounts
– Supports countries with multiple taxes
– Groups up to four output taxes on a single line
– Shows both recoverable and nonrecoverable

input tax amounts on the same report line for
up to two input taxes

•  Use the Matrix Report Flag parameter

(Help)  Oracle Receivables > Tax > Tax Reporting Ledger > Multiple
Organization Reporting
(Help) Oracle Receivables > Tax > Overview of Receivables Tax Reports >
Financial Tax Register
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Review QuestionReview Question

1.  DEFAULT
2.  ATTRSET1
3.  ATTRSET2
4.  ATTRBST1
5.  ATTRBST2

1.  DEFAULT
2.  ATTRSET1
3.  ATTRSET2
4.  ATTRBST1
5.  ATTRBST2

It is recommended to use the                      attribute set
for the Financial Tax Register to report on
transactions from Oracle Payables.
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Answer to Review QuestionAnswer to Review Question

1.  DEFAULT
2.  ATTRSET1
3.  ATTRSET2
4.  ATTRBST1
5.  ATTRBST2

1.  DEFAULT
2.  ATTRSET1
3.  ATTRSET2
4.  ATTRBST1
5.  ATTRBST2

It is recommended to use the ATTRSET2 attribute set
for the Financial Tax Register to report on
transactions from Oracle Payables.
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RX-Only: Financial Tax RegisterRX-Only: Financial Tax Register

• Use the RX-Only: Financial Tax Register to extract
data into the AR_TAX_EXTRACT_ITF_V interface
table

• The RX-Only: Financial Tax Register does not
generate report output; use Publish RX Reports to
print the extracted information

• Run the RX-Only: Financial Tax Register using
Standard Request Submission

• Parameters are the same as Financial Tax Register
except:
– With - Debug Flag and SQL Trace Flag
– Without - Attribute Set and Output Format

• Use the RX-Only: Financial Tax Register to extract
data into the AR_TAX_EXTRACT_ITF_V interface
table

• The RX-Only: Financial Tax Register does not
generate report output; use Publish RX Reports to
print the extracted information

• Run the RX-Only: Financial Tax Register using
Standard Request Submission

• Parameters are the same as Financial Tax Register
except:
– With - Debug Flag and SQL Trace Flag
– Without - Attribute Set and Output Format
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• Use the Publish RX Reports concurrent program to
generate a report with the data that the RX-Only:
Financial Tax Register extracted

• Run the Publish RX Reports concurrent program
using Standard Request Submission

• Parameters
– Request ID
– Attribute Set
– Output Format

• Use the Publish RX Reports concurrent program to
generate a report with the data that the RX-Only:
Financial Tax Register extracted

• Run the Publish RX Reports concurrent program
using Standard Request Submission

• Parameters
– Request ID
– Attribute Set
– Output Format

(Help) RXi Reports Administration Tool > Printing RXi Reports > Using the
RXi Reports Concurrent Program
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Building a ReportBuilding a Report

To build your own report, define an attribute set:
1.  Copy the default attribute set for the RX-Only:

Financial Tax Register.
2.  View and select all columns that you want to

include in the attribute set.
3.  Move columns from the Available section to the

Display section; define ordering and grouping.
4.  Edit page setup.
5.  Edit default format.
6.  Edit column details.

To build your own report, define an attribute set:
1.  Copy the default attribute set for the RX-Only:

Financial Tax Register.
2.  View and select all columns that you want to

include in the attribute set.
3.  Move columns from the Available section to the

Display section; define ordering and grouping.
4.  Edit page setup.
5.  Edit default format.
6.  Edit column details.

(N) Report eXchange Designer: Setup RXi  > (B) Copy Attribute Set > (M)
Tools > Columns > (T) Page Setup > (T) Default Format > (B) Column
Details
(N) Oracle Payables/Oracle Receivables: Setup > Tax > Tax Reporting
Ledger > (B) Copy Attribute Set > (M) Tools > Columns > (T) Page Setup >
(T) Default Format > (B) Column Details
(Help) RXi Reports Administration Tool > Using Attribute Sets > Working
with Attribute Sets
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Tax Reporting Ledger ColumnsTax Reporting Ledger Columns

• The Tax Reporting Ledger lets you select reporting
columns from a single reporting view,
AR_TAX_EXTRACT_ITF_V

• This view unites data from many sources and
provides a single, consistent reference to the
taxed transactions in your subledgers

• There are more than 600 available columns

• The Tax Reporting Ledger lets you select reporting
columns from a single reporting view,
AR_TAX_EXTRACT_ITF_V

• This view unites data from many sources and
provides a single, consistent reference to the
taxed transactions in your subledgers

• There are more than 600 available columns

(Help) Oracle Receivables > Tax > Tax Reporting Ledger > Tax Reporting
Ledger Column Descriptions
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Available Column GroupsAvailable Column Groups

• Extract
• Reporting Entity
• Reporting Context
• Legal Entity
• Transaction Header

Level
• Billing
• Shipping
• Banking
• Receivables

Transactions
• Taxable Amounts

• Extract
• Reporting Entity
• Reporting Context
• Legal Entity
• Transaction Header

Level
• Billing
• Shipping
• Banking
• Receivables

Transactions
• Taxable Amounts

• Taxable Line fields
• Tax Amounts
• Tax Line fields,

including Tax Code and
Tax Rate

• Total Amounts
• Payables Tax Line
• Receivables Tax Line
• Transaction Line User

Descriptive Flexfield
• Accounting
• Miscellaneous

• Taxable Line fields
• Tax Amounts
• Tax Line fields,

including Tax Code and
Tax Rate

• Total Amounts
• Payables Tax Line
• Receivables Tax Line
• Transaction Line User

Descriptive Flexfield
• Accounting
• Miscellaneous

(Help) Oracle Receivables > Tax > Tax Reporting Ledger > Tax Reporting
Ledger Column Descriptions
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DemonstrationDemonstration

This demonstration covers how to:
• Define an attribute set
• Run a Tax Reporting Ledger report

(N) Report eXchange Designer: Setup RXi > (B) Copy
Attribute Set > (M) Tools > Columns > (T) Page
Setup > (T) Default Format> (B) Column Details

(N) Oracle Payables/Oracle Receivables: Setup > Tax
> Tax Reporting Ledger > (B) Copy Attribute Set >
(M) Tools > Columns > (T) Page Setup > (T) Default
Format> (B) Column Details

This demonstration covers how to:
• Define an attribute set
• Run a Tax Reporting Ledger report

(N) Report eXchange Designer: Setup RXi > (B) Copy
Attribute Set > (M) Tools > Columns > (T) Page
Setup > (T) Default Format> (B) Column Details

(N) Oracle Payables/Oracle Receivables: Setup > Tax
> Tax Reporting Ledger > (B) Copy Attribute Set >
(M) Tools > Columns > (T) Page Setup > (T) Default
Format> (B) Column Details
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SummarySummary

In this module, you should have learned how to:
• Describe global taxes and the way Oracle

Applications support them
• Describe and submit reports for global taxes
• Use the Tax Reporting Ledger

In this module, you should have learned how to:
• Describe global taxes and the way Oracle

Applications support them
• Describe and submit reports for global taxes
• Use the Tax Reporting Ledger
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